## Contents

**Chapter 1. Introduction**
- Using the Carlson Software Manual ............................................. 2
- Obtaining Technical Support .................................................... 2
- License Agreement ........................................................................ 2

**Chapter 2. File Menu**
- Open ......................................................................................... 5
- Close ......................................................................................... 5
- Save .......................................................................................... 5
- Save As ...................................................................................... 5
- Carlson Community ................................................................. 5
- Plot ............................................................................................ 8
- Import Google Earth File .......................................................... 11
- Export Google Earth File ........................................................... 12
- Import All .................................................................................. 15
- Import Centerline ....................................................................... 15
- Import Surface .......................................................................... 15
- Import Label ............................................................................. 16
- Remove Civil 3D Custom Objects ............................................. 16
- Export Civil 3D Drawing ............................................................. 16
- Xref Manager ............................................................................ 17
- Audit ........................................................................................ 19
- Recover .................................................................................... 19
- Remove XData .......................................................................... 19
- Remove Groups ........................................................................ 19
- Purge ....................................................................................... 20

**Chapter 3. Edit Menu**
- Undo ........................................................................................ 22
- Redo ......................................................................................... 22
- Clipboard .................................................................................. 22
- Copy ........................................................................................ 23
- Erase, Select ............................................................................ 23
- Erase by Layer .......................................................................... 23
- Move ......................................................................................... 24
- Offset ....................................................................................... 24
- Explode .................................................................................... 24
- Trim ........................................................................................... 25
- Extend To Edge ......................................................................... 25
- Extend to Intersection ............................................................... 26
Chapter 4. View Menu

- Zoom - Center
- Zoom OUT
- Zoom IN
- Pan
- 3D Viewer Window
- Viewpoint 3D
- Redraw
- Regen
- Set UCS to World
- Restore Due North
- Display Order, Bring to Front
- Twist Screen Line
Chapter 5. Draw Menu

Line ................................................................. 59
2D Polyline ..................................................... 59
3D Polyline ...................................................... 63
Circle ............................................................... 68
3 Point ............................................................... 68
PC, PT, Center ................................................ 68
PC, Radius, Arc Length ....................................... 69
2 Tangents, Radius .............................................. 69
2 Tangents, Arc Length ....................................... 69
2 Tangents, Chord Length ................................... 69
Tangent, PC, Radius, Arc Length .......................... 70
Tang, PC, Radius, Chord Length .......................... 70
Tang, PC, Radius, Delta Angle .............................. 70
Curve Calc .......................................................... 71
Text Wizard ....................................................... 72
Text Import ....................................................... 72
Text Export ....................................................... 73
Symbols ............................................................ 73
Hatch Wizard ..................................................... 75
Raster Image ..................................................... 76
Arrowhead ......................................................... 78
Curve - Arrow ..................................................... 78
Leader With Text ................................................ 79
Special Leader .................................................... 80
Callout Leader .................................................... 80
Bold Curve Leader ............................................... 81
Sequential Numbers ........................................... 82
Insert ............................................................... 83
Introduction
Using the Carlson Software Manual

This manual is designed as a reference guide. It contains a complete description of all commands in the Carlson Software product. The chapters are organized by program menus, and are arranged in the order that the menus appear in Carlson Software.

This manual covers only the Carlson Software commands. There is a separate IntelliCAD manual available under the Help pull-down menu that covers the IntelliCAD commands.

Obtaining Technical Support

via Discussion Groups

• Carlson Software operates user discussion groups located at news://news.carlsonsw.com. You can participate in user-to-user discussions on tips, tricks and problems. Our staff monitors these groups to ensure that all the issues are addressed. Visit our website at http://www.carlsonsw.com for information on how to access these groups.
• You may also access the Carlson Software Knowledge Base. Visit it directly at http://update.carlsonsw.com/kbase_main.php.

via Electronic Mail

• The Technical Support e-mail address is support@carlsonsw.com.

via Phone/Fax

• Phone: (606) 564-5028
• Fax: (606) 564-6422

via Web Site

Check the Carlson Software web site at http://www.carlsonsw.com for:
• Knowledge Base, discussion groups, technical support documents and newsletters
• Carlson Software manuals (PDF) and training movies
• Training and seminar schedules
• Step by step procedures on popular called-in topics
• Carlson Software and Autodesk downloads and updates (Feel free to register for automatic update notification of updates when you come to that area.)

via Training

• Basic, advanced and update training is available from Carlson College. Enroll on our webpage or call 606-564-5028 and ask for Carlson College.

License Agreement

Copyright 1992-2016 Carlson Software All Rights Reserved

CAUTION! READ THIS NOTICE BEFORE USING SOFTWARE

Please read the following Software License Agreement before using this software package. Using this software indicates that you have accepted its terms and conditions.

Carlson iCAD 2017

END-USER LICENSE AGREEMENT FOR CARLSON SOFTWARE

IMPORTANT-READ CAREFULLY: This Carlson Software End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a single entity) and Carlson Software, Inc for the Carlson Survey 2009 software
accompanying this EULA, which includes computer software and may include associated media, printed materials, and "online" or electronic documentation ("SOFTWARE PRODUCT" or "SOFTWARE"). By exercising your rights to make and use copies of the SOFTWARE PRODUCT, you agree to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, you may not use the SOFTWARE PRODUCT.

SOFTWARE PRODUCT LICENSE

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1 GRANT OF LICENSE This EULA grants you the following rights: Applications Software. You may install and use one copy of the SOFTWARE PRODUCT, or any prior version for the same operating system, on a single computer. The primary user of the computer on which the SOFTWARE PRODUCT is installed may make a second copy for his or her exclusive use on a portable computer. Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on a storage device, such as a network server, used only to install or run the SOFTWARE PRODUCT on your other computers over an internal network; however, you must acquire and dedicate a license for each separate computer on which the SOFTWARE PRODUCT is installed or run from the storage device. A license for the SOFTWARE PRODUCT may not be shared or used concurrently on different computers.

2 DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation. Separation of Components. The SOFTWARE PRODUCT is licensed as a single product. Its component parts may not be separated for use on more than one computer. Software Transfer. You may permanently transfer all of your rights under this EULA, provided the recipient agrees to the terms of this EULA. Termination. Without prejudice to any other rights, Carlson Software may terminate this EULA and disable the software if you fail to comply with the terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE PRODUCT and all of its component parts. In cases of installation of software obtained by illegal means Carlson Software may collect end-user information.

3 COPYRIGHT All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images, photographs, animations, video, audio, music, text, and "applets" incorporated into the SOFTWARE PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE PRODUCT are owned by Carlson Software or its suppliers. The SOFTWARE PRODUCT is protected by copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any other copyrighted material.

4 U.S. GOVERNMENT RESTRICTED RIGHTS The SOFTWARE PRODUCT and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer is Carlson Software, 102 West Second Street, Maysville, KY 41056

LIMITED WARRANTY NO WARRANTIES. Carlson Software expressly disclaims any warranty for the SOFTWARE PRODUCT. The SOFTWARE PRODUCT and any related documentation is provided "as is" without warranty of any kind, either express or implied, including, without limitation, the implied warranties or merchantability, fitness for a particular purpose, or noninfringement. The entire risk arising out of use or performance of the SOFTWARE PRODUCT remains with you. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall Carlson Software or its suppliers be liable for any damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability to use this Carlson Software product, even if Carlson Software has been advised of the possibility of such damages. Because some states/jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply to you.

MISCELLANEOUS If you acquired this product in the United States, this EULA is governed by the laws of the State of Kentucky. If this product was acquired outside the United States, then local laws may apply.
File Menu
Open
This command allows you to open an existing drawing file. Carlson TakeOff displays the Select File dialog box (a standard file selection dialog box). Select a file and click Open.

Prerequisite: None
Keyboard Command: OPEN

Close
This command allows you to close the current drawing. Carlson TakeOff closes the current drawing if there have been no changes since the drawing was last saved. If you have modified the drawing, the program prompts you to save or discard the changes. You can close a file that has been opened in Read-only mode if you have made no changes or if you are willing to discard changes. To save changes to a read-only file, you must use the SAVEAS command.

Prerequisite: None
Keyboard Command: CLOSE

Save
If the drawing is named, Carlson TakeOff saves the drawing without requesting a file name. If the drawing is unnamed, the program displays the Save Drawing As dialog box (see SAVEAS) and saves the drawing with the file name you specify. If the drawing is read-only, use the SAVEAS command to save the changed file under a different name. This command allows you to save the drawing under the current file name or a specified name.

Prerequisite: None
Keyboard Command: SAVE or QSAVE

Save As
This command allows you to save the current drawing and assign the file name which allows you to give an unnamed drawing a file name or rename the current drawing. You can also use this command to save the current drawing to a different file format. You can save a drawing to an earlier version of the drawing format (DWG) or drawing interchange format (DXF), or save a drawing as a template file. Choose the format from Files of Type in the Save Drawing As dialog box.

If you save the file as a drawing template, the program displays the Template Description dialog box, where you can provide a description for the template and set the units of measurement.

Prerequisite: None
Keyboard Command: SAVEAS

Carlson Community
This command displays files from Carlson Community where Carlson Software customers can post files to share. This file warehouse is hosted on a Carlson Software server. Types of files on Carlson Community include 3D models for visualization (mdl), point symbol files (dwg), Field-to-Finish code tables for standards in different regions (fld), and road design templates (tpl). To view and download files, you don't need an account log in.

To find a file, first choose the File Type to search for. The files are organized by category and you can browse by category using the category tree on the left. The Include Sub-Categories option shows the files in the current category as well as any sub-categories. The results can be filtered by User, Tag and Text.

There are two views for displaying the file results. The List view shows a spreadsheet. Under the Settings button, you can control the columns to show for the List view. The Icons view shows a series of buttons with images for each file.
To see details about a file, highlight the file and pick the View button, or double-click on the file. The View file dialog shows the file name, title, image, description, tags, category, number of downloads, average rating by users, file size, user name who uploaded the file, date/time of the upload and user comments.

To download the file to your computer, pick the Download button on the View dialog or highlight the file on the main dialog and pick the main dialog Download button. The download routine will then prompt where to save the file on your computer.

To do more on Carlson Community, you need to have an account and log in. To log in, pick the Log In button and then enter either your User Name for Carlson Community or your email and then your password.
To create a new account, pick the Log In button and then the Account Sign Up button. You need to create a unique User Name for Carlson Community and a password. Your email is also required and needs to be in the Carlson Software records to create a Carlson Community account. If your email is not in the records, then you will receive an email that needs to be confirmed before your Carlson Community account is activated.

Also on the sign up, you must agree to the Terms of Use to create an account. The rest of the information is optional. The Company Key is a way to group users by company which is used by the Carlson Cloud routine for data exchange with SurvCE.

After logging in, you can upload files by picking the Upload button. On the Upload dialog, pick the Select File button and choose the file to upload. Currently the file size limit is 10mb. To upload several files at once, turn on the Enable Multiple Upload toggle before picking Select File. The Select Preview File allows you to pick an image file to use as the preview for your file. Without selecting a preview file, the program will automatically make a preview. The Title, Description and Tags are all optional but helpful ways for users to search for your file. Select a Category for the file from the list or create a new category by entering the category name in the edit box.
Under Account Options, you can update your email, image and other account settings. The List Users shows users by the Company/Group Key name. The Delete Account removes your account from Carlson Community.

The Members routine shows a list of Carlson Community accounts along with activity on uploading.

**Pulldown Menu Location:** File  
**Keyboard Command:** community  
**Prerequisite:** None

## Plot

This command allows you to plot a drawing to a plotting device or file.

Carlson TakeOff displays the Plot dialog box. Choose OK to begin plotting with the current settings and display the Plot Progress dialog box.

1. The Plot dialog box includes the tabs, Plot Device and Plot Settings, and several options to customize the plot.
   - **Layout Name:** This option displays the current layout name or displays "Selected layouts" if multiple tabs are selected. If the Model tab is current when you choose Plot, the Layout Name shows "Model."
   - **Save Changes to Layout:** This option saves the changes you make in the Plot dialog box in the layout. This option is unavailable if multiple layouts are selected.
   - **Page Setup Name:** This option displays a list of any named and saved page setups. You can choose to base the current page setup on a named page setup, or you can add a new named page setup by choosing Add.
   - **Add:** This option displays the User Defined Page Setups dialog box. You can create, delete, or rename named page setups.

2. Under the Plot Device Tab you can specify the plotter to use, a plot style table, the layout or layouts to plot, and information about plotting to a file.

   - **Plotter Configuration:** This field displays the currently configured plotting device, the port to which it's connected or its network location, and any additional user-defined comments about the plotter. A list of the available system printers and PC3 file names is displayed in the Name list. An icon is displayed in front of the plotting device name to identify it as a PC3 file name or a system printer.
• Properties: The option displays the Plotter Configuration Editor (PC3 Editor), where you can modify or view the current plotter configuration, ports, device, and media settings.

• Hints: This option displays information about the specific plotting device.

• Plot Style Table (Pen Assignments): This option sets the plot style table, edits the plot style table, or creates a new plot style table.

• Name: This option displays the plot style table assigned to the current Model tab or layout tab and a list of the currently available plot style tables. If more than one layout tab is selected and the selected layout tabs have different plot style tables assigned, the list displays "Varies."

• Edit: This option displays the Plot Style Table Editor, where you can edit the selected plot style table.

• New: This option displays the Add-a-Plot-Style-Table wizard, which you can use to create a new plot style table.

• Plot Stamp: This option places a plot stamp on a specified corner of each drawing and/or logs it to a file.

• On: This options turns on plot stamping.

• Settings: This option displays the Plot Stamp dialog box, where you can specify the information you want applied to the plot stamp, such as drawing name, date and time, and plot scale.

• What to Plot: This field defines the tabs to be plotted.

• Current Tab: This option plots the current Model or layout tab. If multiple tabs are selected, the tab that shows its viewing area is plotted.

• Selected Tabs: This option plots multiple preselected Model or layout tabs. To select multiple tabs, hold down CTRL while selecting the tabs. If only one tab is selected, this option is unavailable.

• All Layout Tabs: This option plots all layout tabs, regardless of which tab is selected.

• Number of Copies: This option denotes the number of copies that are plotted. If multiple layouts and copies are selected, any layouts that are set to plot to a file or AutoSpool produce a single plot.

• Plot to File: This option plots output to a file rather than to the plotter.

• File Name: This option specifies the plot file name. The default plot file name is the drawing name and the tab name, separated by a hyphen, with a .plt file extension.

• Location: This option displays the directory location where the plot file is stored. The default location is the directory where the drawing file resides.

• [...] This option displays a standard Browse for Folder dialog box, where you can choose the directory location to store a plot file.

3 Under the Plot Settings Tab you specify paper size, orientation, plot area and scale, offset, and other options.
- Paper Size and Paper Units: This field displays standard paper sizes available for the selected plotting device. Actual paper sizes are indicated by the width (X axis direction) and height (Y axis direction). If no plotter is selected, the full standard paper size list is displayed and available for selection. A default paper size is set for the plotting device when you create a PC3 file with the Add-a-Plotter wizard. The paper size you select is saved with a layout and overrides the PC3 file settings. If you are plotting a raster image, such as a BMP or TIFF file, the size of the plot is specified in pixels, not in inches or millimeters.

- Plot Device: This field displays the name of the currently selected plot device.

- Paper Size: This field displays a list of the available paper sizes.

- Printable Area: This field displays the actual area on the paper that is used for the plot based on the current paper size.

- Inches: This option allows you to specify inches for the plotting units.

- MM: This option allows you to specify millimeters for the plotting units.

- Drawing Orientation: This option specifies the orientation of the drawing on the paper for plotters that support landscape or portrait orientation. You can change the drawing orientation to achieve a 0-, 90-, 180-, or 270-degree plot rotation by selecting Portrait, Landscape, or Plot Upside-Down. The paper icon represents the media orientation of the selected paper. The letter icon represents the orientation of the drawing on the page.

- Portrait: This option orients and plots the drawing so that the short edge of the paper represents the top of the page.

- Landscape: This option orients and plots the drawing so that the long edge of the paper represents the top of the page.

- Plot Upside-Down: This option orients and plots the drawing upside down.

- Plot Area: This option specifies the portion of the drawing to be plotted.

- Layout: This option plots everything within the margins of the specified paper size, with the origin calculated from 0,0 in the layout. Available only when a layout is selected. If you choose to turn off the paper image and layout background on the Display tab of the Options dialog box, the Layouts selection becomes Limits.

- Limits: This option plots the entire drawing area defined by the drawing limits. If the current viewport does not display a plan view, this option has the same effect as the Extents option. Available only when the Model tab is selected.

- Extents: This option plots the portion of the current space of the drawing that contains objects. All geometry in the current space is plotted. TakeOff may regenerate the drawing to recalculate the extents before plotting.

- Display: This option plots the view in the current viewport in the selected Model tab or the current paper space view in the layout.

- View: This option plots a previously saved view. You can select a named view from the list provided. If there are no saved views in the drawing, this option is unavailable.
• Window: This option plots any portion of the drawing you specify. If you select Window, the Window button becomes available. Choose the Window button to use the pointing device to specify the two corners of the area to be plotted or enter coordinate values.

• Plot Scale: This option controls the plot area. The default scale setting is 1:1 when plotting a layout. The default setting is Scaled to Fit when plotting a Model tab. When you select a standard scale, the scale is displayed in Custom.

• Scale: This option defines the exact scale for the plot. The four most recently used standard scales are displayed at the top of the list.

• Custom: This option creates a custom scale. You can create a custom scale by entering the number of inches or millimeters equal to the number of drawing units.

• Scale Lineweights: This option scales lineweights in proportion to the plot scale. Lineweights normally specify the linewidth of printed objects and are plotted with the linewidth size regardless of the plot scale.

• Plot Offset: This field specifies an offset of the plotting area from the lower-left corner of the paper. In a layout, the lower-left corner of a specified plot area is positioned at the lower-left margin of the paper. You can offset the origin by entering a positive or negative value. The plotter unit values are in inches or millimeters on the paper.

• Center the Plot: This option automatically calculates the X and Y offset values to center the plot on the paper.

• X: This field specifies the plot origin in the X direction.

• Y: This field specifies the plot origin in the Y direction.

• Plot Options: This field specifies options for lineweights, plot styles, and the current plot style table. You can select whether lineweights are plotted. By selecting Plot with Plot Styles, you plot using the object plot styles that are assigned to the geometry, as defined by the plot style table.

• Plot object lineweights: This option plots lineweights.

• Plot with Plot Styles: This option plots using the plot styles applied to objects and defined in the plot style table. All style definitions with different property characteristics are stored in the plot style tables and can be easily attached to the geometry. This setting can replace pen mapping in earlier versions of AutoCAD.

• Plot Paperspace Last: This option plots model space geometry first. Paper space geometry is usually plotted before model space geometry.

• Hide Objects: This option plots layouts with hidden lines removed for objects in the layout environment (paper space). Hidden line removal for model space objects in viewports is controlled by the Viewports Hide property in the Object Property Manager. This is displayed in the plot preview, but not in the layout.

• Full Preview: This option displays the drawing as it will appear when plotted on paper. To exit the print preview, right-click and choose Exit.

• Partial Preview: This option quickly shows an accurate representation of the effective plot area relative to the paper size and printable area. Partial preview also gives advance notice of any warnings that you might encounter when plotting. The final location of the plot depends on the plotter. Changes that modify the effective plot area include those made to the plot origin, which you define under Plot Offset on the Plot Settings tab. If you offset the origin so much that the effective area extends outside the preview area, the program displays a warning.

**Prerequisite:** None

**Keyboard Command:** PLOT

---

**Import Google Earth File**

The Import Google Earth File command allows you to insert a KML (Keyhole Markup Language or alternatively a KMZ) file of points (KML Placemark), polylines (KML Path) and closed polylines (KML Polygon) into your drawing. Throughout this discussion, KML will be used to also describe KMZ files unless explicitly noted.
Import Lines and Polygons: When this option is selected, KML Path and Polygon entries will be placed into the drawing as open or closed polylines, respectively.

Import Points: When this option is selected, KML Placemark entries will be placed into the drawing and active coordinate file.

Point Protect: When enabled, existing points in the active coordinate file will not be over-written.

Use Name as Number: When enabled, the names of KML Placemark entries will be utilized as Carlson point numbers.

Attach Image To Points: This option applies to KML files created by Carlson SurvCE©; when the points are stored together with an image. Use this option to attach the image to the point symbol. The images can be viewed using the Image/Document Inspector command. The image files are extracted from the KML and stored in the **Image Storage Path** folder.

Import Overlay Images: When enabled, any Overlay Image placemarks in the KML file will be inserted into the CAD drawing.

Use Folders as Layers: When enabled, KML Folder entries will be used to create layer names in CAD and the supported KML options described above will be placed onto the layer that conforms the the Folder to which they belong.

Default Layer: The supported KML options described above that are not contained in a KML folder will be placed into the specified layer.

Import GIS Data: When enabled, this routine will populate GIS data into the drawing such as that written from the drawing with the Export Google Earth File command.

**Note:**

- Placemarks, paths or polygon entries that have an altitude value specified will be imported at the proper "Z" elevation in the CAD drawing.
- KML or KMZ files can be specified for the import process.

**Prompts**

**Google Earth File to Read:** *Select a previously saved KML or KMZ file.*

- To import a Google Earth image into your drawing, use the Place Google Earth Image command.
- To import a Google Earth terrain data into a Carlson TIN (surface model), use the Place Google Earth Image command.
- To export content from your drawing to a KML file, use the Export Google Earth File command.

**Pulldown Menu Location:** File > LandXML/RoadXML/Google Earth

**Keyboard Command:** kmlread

**Prerequisite:** A KML or KMZ file with Placemark, Path and/or Polygon information, an active coordinate file with an established projection zone through Drawing Setup.

**Export Google Earth File**

The Export Google Earth File allows you to produce a KML (Keyhole Markup Language or alternatively a KMZ) file of points, polylines, text, solids, images, lines and arcs for rendering in other mapping and GIS applications such as Google Earth and Google Maps. Throughout this discussion, **KML** will be used to also describe KMZ files unless explicitly noted.
Drape on Google Terrain (2D): When this option is selected, entities written to the KML file will have an Altitude setting of "Clamped to ground."

Use Elevation from the Drawing (3D): When this option is selected, entities written to the KML file will have an Altitude setting of "Absolute."

Line Width (pixels): Indicate how wide selected linework should be when viewed in Google Earth. The higher the value, the thicker the line.

Include Selected Points: When enabled, this option exports selected Carlson point information to the KML `<Placemark>` `<Point>`...`</Point>` `<Placemark>` tag structure. For the Google placemark, you can choose between using the point number, elevation or description.

Include Selected Text: When enabled, this option exports selected Text and MText entities to the KML `<Placemark>` `<Point>`...`</Point>` `<Placemark>` tag structure.

Include Layer Information: When enabled, this option organizes exported information based on the layer of each entity, with each CAD layer becoming a KML `<Folder>`...`</Folder>` entry with the color of the group taking the general color of the CAD layer.

Shade Closed Regions: When enabled, all closed polyline regions (e.g. building pads, ponds, etc) will be fill-shaded.

Include Solids and Images: When enabled, Solid entities and Images are included in the KML as `<Placemark>` `<Polygon>`...`</Polygon>` `<Placemark>` and/or `<GroundOverlay>`...`</GroundOverlay>` tags, respectively.

Export to KMZ Format: When enabled, the KML file is written to the more compact (zipped) KMZ version of the standard KML file format.

Display Results in Google Earth: When enabled, the results of the KML are passed to and automatically opened with Google Earth. To setup for running Google Earth Pro, go to Windows Start > Default Programs > Associate File Type With Program and assign KML and KMZ file types to Google Earth Pro.

Share Results through Dropbox: When enabled, the results of the KML are passed to a personal DropBox account.

Include GIS Data: When enabled, GIS attribute data associated with selected entities will be populated into the KML file. GIS attribute data can be imported via the Import SHP File command (see the Sample Esri Data note below) or manually assigned with the Input-Edit GIS Data command or the Set Google Tags command. Upon specifying the KML file to output, the Quick View Settings dialog box of the GIS Inspector command may display:

---

Chapter 2. File Menu
1. Select a desired GIS Feature from the upper-left of the dialog box.
2. Add the desired Attributes to the display list using a double-click action or clicking the Add Attribute button.
3. Indicate a desired Attribute to serve as the Placemark Name and use the Use as Placemark Name button to set it.

Upon exiting from the dialog box, available GIS Data on a per-entity basis will be populated into the KML file:

**Linework Opacity:** Use the horizontal slider control to indicate the desired level of opaqueness that should be applied to linework entities. A lower opacity results in increased entity transparency and is helpful for viewing underlying map data found in applications such as Google Earth.

**Solids and Images Opacity:** Use the horizontal slider control to indicate the desired level of opaqueness that should be applied to Solids and Image entities. A lower opacity results in increased entity transparency and is helpful for viewing underlying map data found in applications such as Google Earth.
Note:

• When the Use Elevations from the Drawing (3D) option is selected, be aware that elevation values lower than the Google Earth terrain may be obstructed in the Google Earth display.
• Attribute information (e.g. Number, Elevation, Description) of selected Carlson points are also written to the KML and will display in the "balloon" when a point is picked in the Google Earth display or data hierarchy.
• The formatting of any selected MText entities is not propagated into the KML/KMZ file.
• When the Shade Closed Regions toggle is enabled, note that all closed polyline regions will become fill shaded and may lead to undesired results for items such as closed contours.
• When Image entities are included, the size of the image itself is incorporated into the KMZ file and my significantly swell the size of the KMZ file which may result in lengthy load times into other applications.
• To have results posted to Dropbox, the Dropbox Application for Windows must be first installed to your PC using its default folder specification for the location of shared/synchronized folders/files.
• When prompted for the name of the KML/KMZ file to write, the appropriate KML or KMZ file extension based on the Export to KMZ Format toggle will be added to the file if the file extension is not specified.
• Arcs and polylines with arcs are converted into chord segments that closely approximate the arc(s).
• Other entities not supported for direct export to a KML file (e.g. circles, ellipses, splines, multilines, etc), can be first turned into polylines with the Entities to Polylines command.
• Sample Esri data of the United States in Shape File form can be freely downloaded and explored.
• The graphical symbology of any/all items sent to the KML file can be manually modified via the Google Earth interface.

Prompts

Select points, polylines, text, solids, images, lines and arcs to write.
FILTER/<Select entities>: Select the desired entities and press Enter when complete.

- To import a Google Earth image into your drawing, use the Place Google Earth Image command.
- To import a Google Earth terrain data into a Carlson TIN (surface model), use the Place Google Earth Image command.
- To import KML content into your drawing, use the Import Google Earth File command.

Pulldown Menu Location(s): File > Export
Keyboard Command: kmlwrite
Prerequisite: Points, lines or polylines in the drawing with an established projection zone through Drawing Setup.

Import All

This command converts custom AEC objects from Civil 3D into standard CAD entities. The supported objects include points, surfaces, centerlines, pipe networks, feature lines and labels.

Pulldown Menu Location: File > Import
Keyboard Command: c3d_all
Prerequisite: AEC objects

Import Centerline

This command converts Terramodel, Geodimeter, GeoPak, Sokkia/Leitz, Softdesk, and Leica road files into Carlson TakeOff centerline (.CL) files.

Prerequisite: a Terramodel, Geodimeter, GeoPak, Sokkia/Leitz, Softdesk, or Leica road file

Import Surface

This command allows you to convert Autodesk Civil3D or Land Desktop custom surface objects into standard AutoCAD entities. For example, this command will convert AECC_CONTOUR objects into polylines with elevation. The conversion is done on the currently opened drawing. Besides converting the drawing entities, the routine checks for triangulation surface definitions within the drawing and prompts whether to save these surfaces to Carlson .TIN files. The conversion routine was developed in cooperation with the Open Design Alliance (ODA) and does not use object enablers from Autodesk.

If you have Civil 3D, another way to make a drawing with standard AutoCAD entities is to use the aectoacad command in Civil 3D which converts the custom objects into standard entities.

Pulldown Menu Location: Surface >> Import/Export
Keyboard Command: c3d_tin
Prerequisite: AEC surface objects to convert

Import Label
This command converts custom AEC label objects from Civil 3D into standard CAD text entities.

Pulldown Menu Location: File > Import
Keyboard Command: c3d_text
Prerequisite: AEC label objects

Remove Civil 3D Custom Objects
This command removes all Civil 3D custom objects (AEC objects) from the current drawing so that the next time the drawing is opened, AutoCAD will not load the AEC functions. The AEC objects can be either erased or exploded into standard AutoCAD entities. The cleaned drawing is saved to a new dwg file.

Prompts
Erase or Explode AEC entities during conversion [Erase]/[Explode]? press Enter
Save dwg selection dialog

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: aecleaner
Prerequisite: Drawing with AEC data

Export Civil 3D Drawing
This command saves the current drawing to a dwg file and converts the optional Carlson points, Carlson centerlines and selected Carlson TIN files into Civil 3D objects.

Convert Points: When enabled, the Carlson points in the drawing will be converted into Civil 3D point objects.
Convert Centerlines: When enabled, the Carlson centerlines in the drawing will be converted into Civil 3D alignment objects.
Clicking the Add button yields the Choose Surface File to Read dialog box.
Clicking the **Remove** button removes the selected surface file from the list of Surface Files to convert.

**Output Drawing** *select a .DWG file to create Civil 3D objects within.*

**Pulldown Menu Location:** File > Export  
**Keyboard Command:** convert_c3d  
**Prerequisite:** None

## Xref Manager

Attaches, overlays, lists, binds, detaches, reloads, unloads, renames, and modifies paths to external references (Xrefs) in the current (or host) drawing. Displays the Xrefs in the drawing in a tree view or a list view. You can use the F3 and F4 keys to switch between list view and tree view.

**List View:** Displays a flat listing of the attached Xrefs and their associated data. You can sort the list of references by name, status, type, file date, file size, or the saved path and file name.

**Reference Name:** Lists the names of the Xrefs as stored in the definition table for the drawing. Status: Shows whether the Xref is loaded, unloaded, unreferenced, not found, unresolved, orphaned, or marked for unloading or reloading.
Size: Shows the file size of the corresponding reference drawing. The size is not displayed if the Xref is unloaded, not found, or unresolved.

Type: Indicates whether the Xref is an attachment or an overlay.

Date: Displays the last date the associated drawing was modified. This date is not displayed if the Xref is unloaded, not found, or unresolved.

Saved Path: Shows the saved path of the associated Xref (this is not necessarily where the Xref is found).

Tree View: Displays a hierarchical representation of the Xrefs, displaying the relationships between Xref definitions. Tree view shows the level of nesting relationship of the attached Xrefs, whether they are attached or overlayed, and whether they are loaded, unloaded, marked for reload or unload, or not found, unresolved, or unreferenced.

Attach: Displays the External Reference dialog box if an external reference is selected or displays the Select Reference File dialog box if no external reference is selected.

Detach: Detaches one or more Xrefs from your drawing, erasing all instances of a specified Xref and marking the Xref definition for deletion from the symbol table. Only the Xrefs attached or overlayed directly to the current drawing can be detached; nested Xrefs cannot be detached. Carlson TakeOff cannot detach an Xref referenced by another Xref or block.

Reload: Marks one or more Xrefs for reloading. This option rereads and displays the most recently saved version of the drawing.

Unload: Unloads one or more Xrefs. Unloaded Xrefs can be easily reloaded. Unlike detaching, unloading does not remove the Xref permanently. It merely suppresses the display and regeneration of the Xref definition to improve performance.

Bind: Displays the Bind Xrefs dialog box. The Bind option makes the selected Xref and its dependent symbols (such as blocks, text styles, dimension styles, layers, and linetypes) a part of the current drawing.

Found At: Displays the full path of the currently selected Xref. This is where the Xref is actually found and is not necessarily the same as the saved path.

Browse: Displays the Select New Path dialog box (a standard file selection dialog box), in which you can select a different path or file name.

Save Path: Saves the path, as it appears in Xref Found At, to the currently selected Xref.

Prompts

Command: _Xref
Overlay Xref "example1": ..\..\..\..\..\Program Files\Carlson TakeOff 2004\WORK\example1.dwg
"example1" loaded: G:\oem4\src2\work\example1.dwg

Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:
Command: Specify opposite corner:
Select objects: Enter

Prerequisite: multiple files

Keyboard Command: Xref
Audit
This command scans your current drawing and looks for any corruption and has the option to fix any errors.

Prerequisite: none

Keyboard Command: audit

Recover
This command opens a drawing file and scans it for errors. Use this command if Carlson TakeOff crashes while using the regular Open command.

Prerequisite: none

Keyboard Command: recover

Remove XData
This command removes the xdata (Extended Entity Data) from the selected entities. Many Carlson routines add xdata to entities in order to add extra program specific information to them. Carlson programs use the xdata to make entities more intelligent. For example, when you draw a centerline (.cl) as a polyline, xdata is attached to the polyline that stores the reference of the .cl file name. Then if you double-click the polyline, then the program can read the xdata to know the polyline is a centerline and launch the centerline editor. By removing the xdata, the entities revert to regular CAD entities which is useful if you want to detach these entities from the program links.

Prompts

Select entities to remove extended entity data from.
Select objects: pick the entities
Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: xxdata
Prerequisite: Entities with xdata

Remove Groups
This command is used to "ungroup" selected entities that, prior to using this command, were part of a group. For our purposes, we might more specifically be referring to Carlson's Point Entity Grouping feature. A group is a named selection set of objects. This routine removes selected entities from groups. It is especially useful when dealing with our Carlson points.

More on Point Entity Grouping: As mentioned in the Points chapter, remember that for each point, the point attribute block, node, and symbol can be bound together. This means that if you choose to use the Move command (or other CAD tools) the entire collection moves together. This is done using the grouping functionality in AutoCAD or IntelliCAD. To disable this system altogether, go to Configure, choose General Settings, and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A. Holding down the Ctrl key, and pressing the letter A on the keyboard, activates this two-way toggle, with the current status echoed to the command prompt area.

Prompts

Select entities to remove from groups.
Select objects: select entities
Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: rmgroup
Purge

Displays a tree view summary of all named objects that can and can't be purged in the current drawing. The View Items You Can Purge and View Items You Cannot Purge options toggle the dialog box display, showing different options and tree view summaries.

**Items Not Used in Drawing:** Displays a tree view of all named object categories (blocks, layers, and so on) in the current drawing. A plus sign appears next to the object category names that you can purge. Clicking the plus sign or double-clicking an object category expands the tree view, displaying all unused named objects that exist for the category. To purge all unused named objects, select All Items in the tree view, and choose Purge All. To purge a specific named object category, select the category in the tree view, and choose Purge.

**Confirm Each Item to Be Purged:** Displays the Verify Purge dialog box when you purge an item.

**Purge Nested Items:** Removes all unused named objects from the drawing even if they are contained within or referenced by other unused named objects. The Verify Purge dialog box is displayed, and you can cancel or confirm the items to be purged.

**Prerequisite:** None

**Keyboard Command:** purge
Edit Menu
Undo
This command allows you to reverse the effect of previously issued commands.

**Prerequisite:** None  
**Keyboard Command:** U

Redo
This command allows you to reverse the effects of the previous UNDO command.

**Prerequisite:** None  
**Keyboard Command:** REDO

Clipboard
This command allows for different cut, copy, and paste options.

**Cut**
To cut objects to the Clipboard.
- Select the objects you want to cut.
- From the Clipboard command, choose Cut.

The objects are available to be pasted into other Windows applications.

**Copy**
To copy objects to the Clipboard.
- Select the objects you want to copy.
- From the Clipboard command, choose Copy.

**Copy with Base Point**
To copy objects to the Clipboard. When the objects are pasted into a drawing, the program places them relative to the specified base point.
- Select the objects you want to copy.
- From the Clipboard command, choose Copy with Base Point.
- Specify the base point.

**Paste**
The objects currently on the Clipboard are pasted into the drawing at the specified insertion point.
- From Clipboard command, choose Paste.

**Paste as Block**
The objects currently on the Clipboard are pasted into the drawing as a block at the specified insertion point.
- From Clipboard command, choose Paste as Block.

**Paste to Original Coordinates**
The objects currently on the Clipboard are pasted into the drawing using the coordinates from the original drawing.
- From Clipboard command, choose Paste to Original Coordinates.
**Copy**

This command copies all objects you select to the Clipboard. You can paste the contents of the Clipboard into a document or drawing as an OLE object.

You can also use CTRL+C to run this command. If the cursor is in the drawing area, Carlson TakeOff copies the selected objects to the Clipboard. If the cursor is on the command line or in the text window, the program copies the selected text to the Clipboard.

**Prerequisite:** None

**Keyboard Command:** COPY

---

**Erase, Select**

This command allows you to remove objects from a drawing.

**Prerequisite:** None

**Keyboard Command:** ERASE, E

---

**Erase by Layer**

This command will ERASE all the entities on the specified layers but will not delete these layers from the drawing. The command prompts for the layer name to erase and then erases all entities on that layer. In addition to typing in the layer name, you can also specify a layer to delete by picking an entity on that layer. To select layers by picking, first click the Select Layers from Screen button and then select the entities on the layers to be deleted. The Select Layers by Name button allows you to choose a layer name from a list of layers in the drawing. You can also specify which types of entities to erase. For instance, if you have both linework and points on the same layer and you want to erase only the linework, you can click off All and check Line and Polyline. The Save and Load buttons save and recall the layer names.
Pulldown Menu Location: Edit > Erase  
Keyboard Command: ldel  
Prerequisite: Something to erase

Move
This command allows you to displace objects a specified distance in a specified direction.
Prerequisite: None  
Keyboard Command: MOVE, M

Offset
This command creates a new object at a specified distance from an existing object or through a specified point. Offset does not support 3D polylines. Use Offset 3D Polyline to offset these entities.
Prompts
1 Specify offset distance or [Through] <Through>: Press Enter  
The Through option allows you to screen pick the location of the offset. You can also enter a value for the interval of the offset.  
2 Select object to offset or <exit>: select entity  
3 Specify through point: pick point  
Menu Location: Edit  
Prerequisite: None  
Keyboard Command: OFFSET

Explode
This command allows you to break a compound object into its component objects.
Results differ depending on the type of compound object you're exploding. The following is a list of objects that can be exploded and the results for each.
• All Explodable Objects: Produces object geometry that may look the same, but the color, linetype, and linewidth of the object may change.
• Block: Removes one grouping level at a time. If a block contains a polyline or a nested block, exploding the block exposes the polyline or nested block object, which must then be exploded to expose its individual objects.
Blocks with equal X, Y, and Z scales explode into their component objects. Blocks with unequal X, Y, and Z scales (nonuniformly scaled blocks) might explode into unexpected objects.
When nonuniformly scaled blocks contain objects that cannot be exploded, they are collected into an anonymous block (named with a “*E” prefix) and referenced with the nonuniform scaling. If all the objects in such a block cannot be exploded, the
selected block reference will not be exploded. Body, 3D Solid, and Region entities in a nonuniformly scaled block cannot be exploded.

Exploding a block that contains attributes deletes the attribute values and redisplay the attribute definitions.

- **2D and Lightweight Polyline**: Discards any associated width or tangent information.
- **Wide Polyline**: Places the resulting lines and arcs along the center of the polyline. TakeOff discards any associated width or tangent information.
- **3D Polyline**: Explodes into line segments. Any linetype assigned to the 3D polyline is applied to each resulting line segment.
- **Text Explode to Polylines**: Explodes polylines depending on the font used for various annotations, this can make the resulting polylines more efficient in terms of vertex count.

- **Leaders**: Explodes into lines, splines, solids (arrow heads), block inserts (arrow heads, annotation blocks), Mtext, or tolerance objects, depending on the leader.
- **Mtext**: Explodes into text entities
- **Multiline**: Explodes into lines and arcs.
- **3D Solid**: Explodes planar surfaces into regions. Nonplanar surfaces explode into bodies.
- **Region**: Explodes into lines, arcs, or splines.
- **Body**: Explodes into a single-surface body (nonplanar surfaces), regions, or curves.
- **Polyface Mesh**: Explodes one-vertex meshes into a point object. Two-vertex meshes explode into a line. Three-vertex meshes explode into 3D faces.
- **Circle Within a Nonuniformly Scaled Block**: Explodes a circle within a nonuniformly scaled block into ellipses.
- **Arc Within a Nonuniformly Scaled Block**: Explodes an arc within a nonuniformly scaled block into elliptical arcs.

**Prerequisite**: None

**Keyboard Command**: EXPLODE, X

**Trim**

This command allows you to trim objects at a cutting edge defined by other objects.

**Prompts**

1 Select cutting edges ...
   Select objects: **pick entity**

2 Select object to trim or shift-select to extend or [Project/Edge/Undo]: **select entity to be trimmed**
   - **Project**: You can project the object to be trimmed in order to trim objects that do not intersect.
   - **Edge**: You can project the trimming edge in order to trim objects that do not intersect.
   - **Undo**: This option allows you to undo the above projections.

**Prerequisite**: None

**Keyboard Command**: TRIM, TR

**Extend To Edge**

This command allows you to extend an object to meet another object.

**Prompts**

1 Select boundary edges ...
   Select objects: **pick entity**

2 Select object to extend or shift-select to trim or [Project/Edge/Undo]: **pick entity**

You have the option of trimming or projecting objects and edges.
**Extend to Intersection**

This command extends the end points of two lines and/or polylines, at the same time, to their intersection point.

**Prompts**

Select first line or polyline to extend: pick a line or polyline
Select second line or polyline to extend: pick another line or polyline

Before Extend to Intersection

![Diagram of before Extend to Intersection](before.png)

After Extend to Intersection

![Diagram of after Extend to Intersection](after.png)

**Pull down Menu Location:** Edit > Extend

**Keyboard Command:** extint

**Prerequisite:** Two lines or polylines

---

**Extend by Distance**

This command extends a line or polyline, or creates new lines or polylines off of an existing one. By specifying a distance, a new segment of the line or polyline can be drawn from the current position. The current position and direction along the line or polyline is indicated by an arrowhead. Extend by Distance starts by selecting an existing line or polyline. Initially, the current position will be the closest vertex to where the line or polyline was selected. Extending from the endpoint of a polyline will add a new point to that polyline, while extending from any other point will create a new polyline.

There are two modes of operation: draw mode (D) and move mode (M). When in draw mode, extending will draw line or polyline segments. In move mode, the current position arrowhead can be moved without drawing segments. The orientation of the current position arrowhead can be changed with the Right, Left, and Angle commands.
The second prompt for this command offers numerous options in the form of key letters. These key letters are listed below along with their full names and actions. The list of the Extend by Distance commands are:

# - Number: Distance to draw or extend
A# - Angle change: Rotates pointer by specified number of degrees
A - Align: Rotates pointer to align with segment
B - Bearing: Sets pointer direction by bearing in format: Qdd.mmss with Q- quadrant, d-degrees, m-minutes, s-seconds (e.g. 130.1005 is NE 30 degrees, 10 minutes, and 5 seconds)
C - Close: Closes the polyline
D - Draw Mode: Actions draw or extend the line or polyline
E - Extend to Edge: Extends to intersection with a selected line or polyline
I - Input mode: Toggles distance input between decimal feet and feet-inches
L - Left rotate: Rotates counterclockwise 90 degrees
M - Move Mode: Actions only move the pointer
N - Next: Moves pointer forward to next point
O - Open: Opens the polyline
P - Previous: Moves pointer backward to previous point
R - Right rotate: Rotates clockwise 90 degrees
S - Switch: Reverses pointer direction
T# - Total distance: Sets current segment to specified distance
U - Undo: Undo the last Extend by Distance command
Z - Zoom mode: Toggles auto-zoom between on/off
? - Info: Displays lengths of current polyline
H - Help: The Help option also displays this Extend by Distance Commands list.

Press <Enter>: Ends the routine

The result of using the Info (?) feature

Prompts

Select line or polyline to extend: select line or polyline near the place to extend
Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): 50 The line is extended by 50 units. Use the Pick option to pick a distance.

Pick/Horizontal Distance to extend ([Enter] for new line): R Rotate right 90 degrees.

Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): 50 The line is extended by 50 units. Use the Pick option to pick a distance.

Select line or polyline to extend: select line or polyline near the place to extend

Extend another (<Yes>/No)? No

Note: R50 and L10 can be used to go right 50, left 10, etc.
The result of using the Help (H) option

Pulldown Menu Location: Edit > Extend
Keyboard Command: extender
Prerequisite: An existing line or polyline with at least one segment from which to start.

**Break at Intersection**

This command will break a line, arc or polyline at the intersection of another line, arc or polyline. In many cases this command is used in conjunction with the *Area by Lines & Arcs* command. In order to get the correct area of a figure, it is often necessary to break it from adjoining lines.

**Prompts**

Select Line, Arc, or Polyline to Break
Select object: select object to break
[int on] Pick Intersection to break at: pick intersection point

Pulldown Menu Location: Edit > Break
Keyboard Command: breakat

**Break, Select Object, 2nd Point**

This command allows you to break an object by selecting the object, then the second break point. The first break point is the point where you select the object.

**Prompts**

1 Select object: selectentity to break
2 Specify second break point or[First point]: select second break point
Break, Select Object, Two Points
This command allows you to break an object by selecting the object, then two points. First select the object, then the program will prompt you to select two points that define where the object will be broken.

Prompts
1 Select object: select entity to break
2 Specify second break point or [First point]: First
3 Specify first break point: pick first point
4 Specify second break point: pick second point

Break, At Selected Point
This command allows you to break an object by selecting the object. Only one pick is necessary since TakeOff both selects the object and treats the selection point as the break point.

Prompts
1 Select object: select entity to break
Select an object to break
Prerequisite: None
Keyboard Command: BREAK

Scale
This command allows you to enlarge or reduce selected objects equally in the X, Y, and Z directions.

Prompts
1 Select objects: pick entities
2 Specify base point: pick point on screen as reference
3 Specify scale factor or [Reference]: scale to desired size
Prerequisite: None
Keyboard Command: SC

Text Enlarge/Reduce
This command will scale text entities up or down in size. The routine prompts for a scale multiplier and a selection set of text objects. If you want to enlarge the text enter a value greater than one. If you want to reduce text enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. The Change Text Size command can alternatively be used to set the text size to a specific value.

Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: txtenl

Edit Text
This command allows you to edit text and attribute labels.
1 Select Text to Edit: select the text
You can modify text in provided text field.

Prerequisite: Text
Keyboard Command: EDITXT

Find and Replace Text

With this command, you can find, replace, select, or zoom to text contained in the current drawing.

Keyboard Command: find
Prerequisite: Text

Rotate Text

This command sets the rotation of the selected text to the current twist screen, an entered azimuth, or to align with a line or polyline. The text keeps the same insertion point and justification. The Twist Screen option sets the text rotation to align horizontal with the current twist screen. With the Azimuth option you can enter the angle or pick two points to define the text rotation. The Entity segment aligns the text with a selected line or polyline segment. The Follow option aligns the text with the closest polyline segment.

Prompts

Rotate by (<Twist Screen>/Azimuth/Entity segment/Follow/Pick)? press Enter
Enter angle relative to current twist screen <0.0>: 23
Select Text to rotate.
Select objects: select the text

Pulldown Menu Location: Edit > Text
Keyboard Command: twisttxt
Prerequisite: Text

Move Text

This command moves existing text entities by sliding at the text angle or perpendicular. This sliding method is equivalent to setting the crosshairs to the text angle and then moving with ORTHO on.

Prompts

Select Text to slide:
Select objects: pick text entities
Pick starting point for slide: pick a point to begin sliding and then pick a second point for the new location

Pulldown Menu Location: Edit > Text
Keyboard Command: annslide
Prerequisite: Text entity to move

Move Text with Leader

This command moves an existing text entity and creates a leader from a picked point to the new text location. The routine keeps track of the original text location and has an option to restore the text to the original without the leader. To use the Restore function, type R at the Command prompt. Also, to access the options for this command, type O for Options at the Command prompt.

Prompts

Select Label to Move (O for Options,R for Restore): pick any text entity
Pick start point for leader: pick the point where to draw the leader arrowhead
Pick end point for move: pick the end of the leader where to move the text
When Options is chosen the "Move Text With Leader Options" dialog allows the user to customize the leader and label drawing settings:

**Use MLeader:** This option uses an MLeader for a combined label and leader. Otherwise a standard Leader entity is drawn with separate label.

**Minimum Leader Length Scaler:** If the distance of the move is less than this value, a leader will not be drawn.

**Draw Horizontal Leader Tick:** When checked, a horizontal leader tick will be drawn from the end of the leader towards the annotation.

**Draw Arrowhead:** Controls whether to draw an arrowhead at the end of the leader.

**Curved Leader:** Chooses between making a straight line or curved leader.

**Draw Box Around Text:** Creates a box around the text.

**Minimum Length for Arrow Scaler:** When the leader length is more than this amount, the arrowhead is drawn.

**Arrow Size Scaler:** Sets the size for the arrowhead.

**Leader Offset Scaler:** This is used to set the distance from the end of the leader and the annotation.

**Leader Layer:** The Use Separate Layer method places the leader on the specified layer from the dialog. The Use Current Layer method places the leader on the current drawing layer. The Use Text Layer method uses the label layer for the leader layer.

**Keep Label Alignment:** This option keeps the original text angle. Otherwise the leadered text is orientated horizontally to the current twist screen.

**Move Multiple Labels:** Use this option to select multiple text entities as a group for moving.

NOTE: The leader scaler units (Arrow Size Scaler, Minimum Length for Arrow Scaler, Minimum Leader Length Scaler and Leader Offset Scaler) are multiplied by the current horizontal scale value which is set under Drawings Setup.

Select Label to Move (O for Options, R for Restore): R
Select Label to Restore: pick a text that had been moved with the "Move with Leader" command previously.
The selected label will be restored to its previous state.

Pulldown Menu Location: Edit > Text
Keyboard Command: movetext
Prerequisite: Text entity to move.

**Flip Text**

This command will change the alignment of text entities by 180 degrees.

Pulldown Menu Location: Edit > Text
Keyboard Command: fliptext
Prerequisite: Text entities to be changed
**Align**

Aligns objects with other objects in 2D and 3D

You use ALIGN to move, rotate, or scale objects into alignment with other objects. Add source points to the objects you want to align, and add destination points to the objects to which you want the source objects to align. You can add up to three pairs of source and destination points to align an object.

The first set of source and destination points defines the base point for the alignment. The second set of points defines the angle of rotation.

When you select three point pairs, you can move and rotate the selected objects in 3D to align with other objects.

If you use two source and destination points to perform a 3D alignment on nonperpendicular working planes, you get unpredictable results.

After you enter the points, Takeoff prompts you to scale the object. The program uses the distance between the first and second destination points as the reference length to which the object is scaled. Scaling is available only when you are aligning objects using two point pairs.

**Prompts**

1. Specify first source point: **pick point**
2. Specify first destination point: **pick point**
3. Specify second source point: **pick point**
4. Specify second destination point: **pick point**
5. Specify third source point or <continue>: **Press Enter**
6. Scale objects based on alignment points? [Yes/No] <N>: **Press Enter**

**Prerequisite**: None

**Keyboard Command**: ALIGN

**Mirror**

This command allows you to create a mirror image copy of objects. The two specified points become the endpoints of a line about which the selected objects are reflected. In 3D, this line orients a mirroring plane perpendicular to the XY plane of the user coordinate system (UCS) containing the mirror line.

**Prompts**

1. Select Objects: select objects to be mirrored
2. Specify first point of mirror line: **pick point**
3. Specify second point of mirror line: **pick point**
4. Delete source objects? [Yes/No] <No>: **Press Enter**

**Menu Location**: Edit

**Prerequisite**: None

**Keyboard Command**: MIRROR

**Fillet**

This command allows you to round and fillet the edges of objects. You can enter a radius for rounding (default radius is 0). You can also trim an object that extends beyond the intersection.

![Before and after FILLET](image)
FILLET rounds or fillets the edges of two arcs, circles, elliptical arcs, lines, polylines, rays, splines, or xlines with an arc of a specified radius. FILLET trims the intersecting lines to the endpoints of the fillet arc. If the selected lines do not intersect, Carlson Survey extends or trims them so that they do. FILLET also rounds or fillets the edges of 3D solids.

If both objects you want to fillet are on the same layer, the program creates the fillet line on that layer. Otherwise, the program creates the fillet line on the current layer. The same is true for the fillet color, linewidth, and linetype.

You can fillet line segments of a polyline that are adjacent, nonadjacent, intersecting, or separated by one segment. If they are nonadjacent, the polyline segments are extended to accommodate the fillet. If they are intersecting, the polyline segments are trimmed to accommodate the fillet. To create a fillet, the polyline segments must converge within the drawing limits when limits checking is on.

The result is a single polyline that includes the fillet as an arc segment. All the properties of this new polyline, such as its layer, color, and linetype, are inherited from the first polyline selected.

Filleting an associative hatch whose boundary is defined by lines removes hatch associativity. Carlson Survey maintains associativity when the boundary is a polyline.

**Prompts**

1 Select first object or [Polyline/Radius/Trim]: **select entity**
2 Select second object: **select entity**

**Menu Location:** Edit  
**Prerequisite:** None  
**Keyboard Command:** FILLET

### Entities to Polylines

This command converts selected lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids into individual polylines. Use **Join Nearest** to convert adjoining lines and arcs into continuous polylines.

**Prompts**

1. Select lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids to convert:  
1. Select objects: **select entities**

**Pulldown Menu Location:** Edit > Polyline Utilities  
**Keyboard Command:** topline  
**Prerequisite:** lines, arcs or other entities to convert

### Reverse Polyline

This command reverses the order of the line and/or arc segments of a POLYLINEx. This can be useful in conjunction with the commands **Station Polyline, MXS by Polyline, Profile from Surface Model** or **CL File from Polyline**, since the polyline must be plotted in the direction of increasing stations. If it is more convenient to draft a polyline in one direction do so and then use the **Reverse Polyline** command to change its order. Temporary arrows along the polyline are drawn to graphically show the new polyline direction.

**Prompts**

Select the Polyline to Reverse: **pick a point on polyline**

**Pulldown Menu Location:** Edit > Polyline Utilities  
**Keyboard Command:** revpline  
**Prerequisite:** A polyline
Reduce Polyline Vertices

This command removes points from a polyline, without significantly changing the polyline. The offset cutoff is the maximum amount that the polyline can move horizontally and vertically when removing a point. For example, in a polyline with three points in a straight line, the middle point can be removed without changing the polyline.

Prompts

Enter the offset cutoff <0.1>: .5
Select polylines to reduce.
Select objects: pick polylines
Processed polylines: 1
Total number of vertices: 10
Number of vertices removed: 1

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: reduce
Prerequisite: A polyline

Smooth Polyline

This command smooths the selected polylines using a modified Bezier method that makes the smooth polyline pass through all the original points and only smooths between the original points. Either the entire polyline can be smoothed or only a section of the polyline. When using Polyline Section, the program will prompt for points along the polyline to start and end the smoothing. The Looping Level controls smoothing amount. A higher factor gives more looping. The Offset Cutoff (After Smooth) is used to reduce the number of vertices in the final polylines. To not reduce vertices, set this Offset Cutoff to zero. The Offset Cutoff is the maximum amount that the polyline can move horizontally when removing a point. The Reduce Polylines Before Smoothing option removes extra vertices from the contours before smoothing. Removing points before smoothing gives the Bezier smoothing more freedom to make the polylines curvy.

Prompts

Smooth Polylines dialog
Select polylines to smooth.
Select objects: pick polylines
Smoothed 1 PolyLines
Total original vertices: 9 Total final vertices: 50

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: smoothpl
Prerequisite: A polyline
Add Polyline Vertex

This command adds points into a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you can pick or enter the coordinates for the new point(s). A new point is inserted into the polyline at the nearest polyline segment. On a 3D polyline, the elevation of the new vertex will be calculated for you. You can continue to pick points to add. Press Enter when you are done.

Prompt

Select polyline to add to: pick a polyline
Pick or enter point to add: pick a point
Select polyline to add to: press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: addpl
Prerequisite: A polyline

Edit Polyline Vertex

This tool allows you to make changes in the coordinates of vertices on all polyline types. Upon execution, you will be asked to select a polyline to edit. Upon selection, a temporary marker will be placed at all of the vertices of the polyline, making them easy to distinguish. You must then pick near the vertex you wish to edit. The following dialog appears.

At the top of the dialog it identifies the type of polyline as being 2D or 3D. In the case of 2D polylines, it allows you convert the polyline. You have the ability to type in new northing, easting or elevation values. You can also determine the 3D coordinate position by using distances and slope to/from adjacent points. As you change the values in the dialog, new values for derivatives are being calculated. For example, if you change the horizontal distances, the coordinates will change.

Prompt

Select polyline to edit: pick a polyline
Pick point on polyline to edit: pick a point to be modified
Edit Polyline Vertex dialog click "Pick Position"
Pick vertex position: pick a new location for the vertex
Edit Polyline Vertex dialog: click OK
Make changes as needed. You will see the polyline vertices relocated based upon the new picked positions and coordinate changes. Use Previous and Next to move along the polyline. Note the dialog values changing.
Select polyline to edit (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: editpl
Prerequisite: A polyline

Change Polyline Width
This command sets the width of the selected polylines. In later versions of AutoCAD, the command PEDIT can also modify the width of multiple polylines.

Prompts
New width <1.0>: 2
Select Polylines/Contours to change width of:
Select objects: pick polylines
Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: cwidth
Prerequisite: A polyline

Open Polylines
This command allows you to open a selection set of closed polylines.
Prerequisite: Closed polyline(s).
Keyboard Command: OPENPL

Close Polylines
This command allows you to close a selection set of open polylines.
Prerequisite: Open polyline(s).
Keyboard Command: CLOSEPL

Remove Polyline Arcs
This command replaces arc segments in polylines with a series of chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as Break by Closed Polyline and Make 3D Grid File. This process can add many vertices to the polyline. There are three methods to control the size of the chords and how many vertices are created. The Offset cutoff sets the maximum distance any point on the arc will be allowed to shift from the true arc to the chord position. The Length method sets the chord length. With the Length method, you can choose to create the chords entirely on the left or right side. Without setting the side, the program puts the chords on the inside of the arcs. The Count method sets how many chords to replace each arc with.

Chapter 3. Edit Menu
Original polyline with reverse curve and polyline with arcs removed using Length method with chords put on top side

**Prompts**

Select polylines to remove arcs from.
Select objects: pick polylines
Use max offset or chord length method [<Offset>/Length]? press Enter for Offset method
Offset cutoff <0.5>: press Enter

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmarc
Prerequisite: polyline with arcs

**Remove Polyline Vertex**

This command removes vertices from a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you pick near the vertex you wish to delete. You can continue to pick vertices to delete, press Enter when you are done.

**Prompts**

Select polyline to remove from: pick point on polyline
Pick point to remove: pick point
Pick point to remove (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmvertex
Prerequisite: A polyline

**Join Nearest**

This command joins lines, arcs and/or polylines together. While the PEDIT-Join command requires the endpoints to match, Join Nearest will allow you to join entities whose endpoints do not exactly meet. You specify the maximum separation distance to join, along with other options, in the dialog box shown below. Also you can join many entities at once.
Max Separation to Join: Entities whose endpoints are spaced apart greater than this value will not be joined. You may use the pick button to specify this value by picking two points on the screen.

Max Deflection Angle (degrees): This option will not join any lines if the angle between them is greater than this angle in degrees.

Connection Method: Determines how to connect the endpoints. See the illustration below.

1. Average Endpoints Together: New vertex will be located at midpoint between two original endpoints (see illustration below on left).
2. Directly Connect Endpoints: Original endpoints are connected with new segment (see the middle illustration below).
3. Fillet with Radius Zero: Same as the FILLET command using zero radius (see the illustration on right).

Convert Lines and Arcs Into Polylines: When checked, automatically converts lines and arcs into polylines. If not checked, lines and arcs are joined but remain separate entities.

Join Across Intersections: This option applies to cases where more than two linework endpoints come together such as a Y intersection. In these cases, there are multiple possible connections. When this option is on, the program will automatically choose one of the possible connections. Otherwise, the program will not connect any of them.

Join Only Identical Widths: When checked, only polylines with the same width will be joined.
Join Only Identical Layers: When checked, only entities on the same layer will be joined.
Join Only Identical Colors: When checked, only entities with the same color will be joined.
Join Only Identical Linetypes: When checked, only polylines with the same linetype will be joined.

Join Only Common Elevations: When checked, only endpoints located on the same elevation will be joined.
Different Layer Prompt: When Join Only Identical Layers is off, then this option will prompt for which layer to use when it finds a connection between two different layer names.
Different Elevation Prompt: When Join Only Common Elevations is off, then this option will prompt for which elevation to use when it finds a connection between two different elevations.

Elevate Zero Elevations When Joined To Elevated: This option applies when joining a combination of linework at elevation and linework at zero elevation. When checked, zero elevation vertices will get assigned the elevations from connected neighboring vertices.
Pulldown Menu Location: Edit
Keyboard Command: nearjoin
Prerequisite: Lines or polylines to be joined

**Image Clip**

This command allows you to create new clipping boundaries for an image object.

**Prompts**

1. Select image to clip: select the edge of an image
2. Enter image clipping option [ON/OFF/Delete/New boundary] <New>: enter an option or Press Enter
   - **On**: Turns on clipping and displays the image clipped to the previously defined boundary.
   - **Off**: Turns off clipping and displays the entire image and frame. If you reclip the image while clipping is turned off, the program automatically turns clipping back on. The program prompts you to delete the old boundary even when clipping is turned off and the clipping boundary is not visible.
   - **Delete**: Removes a predefined clipping boundary and redisplays the full original image.
   - **New Boundary**: Specifies a new clipping boundary. The boundary can be rectangular or polygonal, and consists only of straight line segments. When defining a clipping boundary, specify vertices within the image boundary. Self-intersecting vertices are valid. Rectangular is the default option. If you use the pointing device to specify a point at the Enter Clipping Type prompt, the program interprets the point as the first corner of a rectangle.
3. Enter clipping type [Polygonal/Rectangular] <Rectangular>: enter P or Press Enter
   - **Polygonal**: Uses specified points to define a polygonal boundary.
     - Specify first point: Specify a point
     - Specify next point or [Undo]: specify a point or enter u
     - Specify next point or [Undo]: specify a point or enter u
     - Specify next point or [Close/Undo]: specify a point, or enter c or u
     You must specify at least three points to define a polygon.
     If the image already has a clipping boundary defined, TakeOff displays the following prompt:
     Delete old boundary? [No/Yes] <Yes>: enter N or Press Enter
     If you choose Yes, the program redraws the entire image and the command continues; if you choose No, the command ends.
   - **Rectangular**: Specifies a rectangular boundary by its opposite corners. TakeOff always draws the rectangle parallel to the edges of the image.
     - Specify first corner point: specify a point
     - Specify opposite corner point: specify a point

Prerequisite: None
Keyboard Command: IMAGECLIP
**Image Frame**

This command controls whether TakeOff displays the image frame or hides it from view. Because you select an image by clicking its frame, setting the image frame to off prevents you from selecting an image.

### Prompts

1. Enter image frame setting [ON/OFF] <current>: **enter an option or Press Enter**
   - **On**: Displays image frames so you can select images.
   - **Off**: Hides image frames so you cannot select images.

**Prerequisite**: None

**Keyboard Command**: IMAGEFRAME
View Menu
Zoom - Center
This command zooms to display a window you define by picking a center point and a magnification value or height. A smaller value for the height increases the magnification. A larger value decreases the magnification.

Prompts
1 Specify center point: pick a point
2 Enter magnification or height <226.66>: enter a value
Prerequisite: None
Keyboard Command: ZOOM, C

Zoom OUT
This command decreases the zoom factor of the current viewport by a factor of 0.5.
Prerequisite: None
Keyboard Command: ZOOM, 0.5x

Zoom IN
This command increases the zoom factor of the current viewport by a factor of 2.0.
Prerequisite: None
Keyboard Command: ZOOM, 2.0x

Pan
This command moves the drawing display in the current viewport. The cursor changes to a hand cursor. By holding down the pick button on the pointing device, you lock the cursor to its current location relative to the viewport coordinate system. The drawing display is moved in the same direction as the cursor.

When you reach a logical extent (the edge of the drawing space), a bar is displayed on the hand cursor on the side where the extent has been reached. Depending on whether the logical extent is at the top, bottom, or side of the drawing, the bar is either horizontal (top or bottom) or vertical (left or right side).

When you release the pick button, panning stops. You can release the pick button, move the cursor to another location in the drawing, and then press the pick button again to pan the display from that location.
To stop panning at any time, press Enter or ESC.
Prerequisite: None
Keyboard Command: P

3D Viewer Window
This command loads the selected 3D faces, blocks, polylines, lines and points into a separate 3D Viewer window. Some of the features of this viewer include the ability to zoom in and out, pan, rotate around the X-Y-Z axes, and shade entities with user-positioned lighting.
The 3D Viewer Window has several mouse and keyboard controls that can assist with navigating the scene. These are listed below:

- Hold left-mouse button: Rotates/pans/zooms the scene based on the current mode. You can change the mode by clicking one of the control icons.
- Hold right-mouse button: Zooms in/out.
- Hold middle-mouse button: Pans around the scene.
- W key: Zooms in.
- S key: Zooms out.
- A key: Pans left.
- D key: Pans right.
- Q key: Pans up.
- Z key: Pans down.

**Ignore Zero Elevations:** When enabled, the 3D viewer will not display entities at zero elevation.

**Color By Elevation:** This will color the entities by elevation.

The *None* option will not modify the color of entities in the viewer.

The *All* option will color all entities by elevation. The elevation color legend will be displayed on the left of the window and can be adjusted via the Color By Elevation Scale controls.

The *Surface Only* option will only color surface files by elevation. Other entities such as polylines and 3D faces will not be colored by elevation.

**Sky:** This option controls the background image for the 3D viewer. By default, no background image will be displayed. When a background image is displayed, you can toggle the *Background Color Below Horizon* checkbox to hide the bottom half of the background image.
**Vertical Scale:** This option sets the vertical scale factor for the 3D viewer.

**Lighting by Location/Time:** This button will display the below dialog, which allows you to set the lighting as it would appear at a specific location at a specific time.

![Set Date/Time dialog](image)

**Date/Time:** These values set the date and time for the lighting. The **Select** button will allow you to pick the date from a calendar. The horizontal slider below the time will allow you to set the time of day.

**Latitude/Longitude:** These values set the location of the viewpoint.

**Time Zone:** This value adjusts for the various time zones. Values should be integers representing GMT adjustments. For example, the Eastern Standard Time (EST) in the USA will use a value of -5.

<table>
<thead>
<tr>
<th>Control</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Control" /></td>
<td>This control represents the position of the sun in plan view. If the yellow square is in the center of the blue circle, the sun is in a zenith. If the yellow square is near the edge of the circle, the sun is near the horizon. To move the yellow square, simply drag it to a new location, or click on the new location. The slider bars on the sides control the intensity and brightness of the display.</td>
</tr>
<tr>
<td><img src="image" alt="Action" /></td>
<td>Switch to Pan mode. Click and drag to pan.</td>
</tr>
<tr>
<td><img src="image" alt="Action" /></td>
<td>Switch to Rotation mode. When the cursor is placed near the outer edge of the view, a &quot;Z&quot; cursor is presented that permits rotation around the Z-axis. When the cursor is placed further into the interior of the view, an &quot;X,Y&quot; cursor is presented that permits the tilt angle of the view to be adjusted.</td>
</tr>
<tr>
<td><img src="image" alt="Action" /></td>
<td>Switch to Dynamic Zoom mode. Click and drag to zoom in and out.</td>
</tr>
<tr>
<td><img src="image" alt="Action" /></td>
<td>Zoom Previous.</td>
</tr>
</tbody>
</table>

**Chapter 4. View Menu**
Switch to Pick mode. In this mode, hovering over an entity will display data such as the layer, entity type, elevation, and length. Double-clicking an entity permits additional actions to be performed on the entity including the ability to change the layer of the entity and/or setting the entity to an elevation of zero (0). When hovering over a surface, the coordinates and slope of the surface at the cursor location will be displayed. Resets the 3D view to plan.

**Rotation Axis:** Permits the use of "slider" controls to orient the view in the X, Y and/or Z axis direction(s). Axes may be locked to prevent rotation about that axis.

**Fixed Views:** Permits the view to be displayed from one of six different directions:

1. **Custom** - This option will be displayed after manually rotating the view. Selecting this option will not return to a predefined view.
2. **Plan View** - Sets the view directly over the site, looking straight down. This is the same as the Reset to Plan button.
3. **NE** - Sets the view as shown from the Northeast looking to the Southwest in a downward direction.
4. **SE** - Sets the view as shown from the Southeast looking to the Northwest in a downward direction.
5. **SW** - Sets the view as shown from the Southwest looking to the Northeast in a downward direction.
6. **NW** - Sets the view as shown from the Northwest looking to the Southeast in a downward direction.

![Diagram of View Menu Options]

**Display Axis Icon:** This option toggles the display of the X-Y-Z axes icon in the lower left corner of the window.

**Display Bounding Box:** This option toggles the display of a 3D box around the limits of the data.

**Display Orbit:** This option toggles the display of a graphic guide for controlling the view angle and position using the mouse movements similar to the AutoCAD Orbit routine.

**Apply Surface Smoothing:** This option shades 3D faces in a way that appears to remove sharp transitions from one entity to another. This option affects both surfaces and solids.
Display Triangle Edges: This option toggles the edge lines of triangles that make up surfaces. The triangle edge color can be set with the Set Colors button.

Display Surface Names: This option toggles the display of the file names for the surfaces currently being viewed.

Display Vertical Scale: This option toggles the display of the vertical scale.

Display Non-Surface Entities: This option toggles the display of entities that have been tagged as “non-surface” by the Tag Non-Surface Entities/Points commands.

Use Dynamic Text: This option automatically resizes and rotates text entities so that they are always readable. When the option is first enabled, you will need to restart the viewer for the changes to take effect.

Hide Backs of Triangles: This option toggles the display of the backs of 3D Faces. When enabled, even the edges of the triangles will be hidden.

Linework Pixel Thickness: This value sets the thickness for polylines.

Set Colors: This button opens the dialog shown below.

![Set Colors Dialog]

- **Color By Elevation Scale:** These three colors are used for the Color By Elevation option. The program will interpolate between these colors for the color scale.

- **Contour/Edge color:** These colors control the coloring for contours and triangle edges. Note that this does not affect the coloring of contour polylines that are loaded into the viewer, but only contours that are generated within the viewer.

- **Use CAD Background Color:** When enabled, the background color of the 3D viewer will match the CAD background color. If this option is disabled, you can set a different background color.

Control

<table>
<thead>
<tr>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sets the drawing view to match the view shown in the 3D viewer window.</td>
</tr>
<tr>
<td>Sets the view position and target position by coordinates according to the below dialog.</td>
</tr>
</tbody>
</table>
The positions can be entered in the edit boxes or you can use the respective Pick > button to pick a point in the drawing. The program will pick up the elevation of the surface for picked points and then the Height above the position can be entered. For example, to check sight distance the view position could be a point on a road at the driver's eye height and the target position could be the distance to check.

Saved Views: This option allows for naming and saving a 3D view for easy recall later. Named views can be selected from the pull-down and the active view can be deleted from the list.

Block Model Objects: This option has three choices when loading block model entities:

1. Leave as Points - this option will display blocks as points. In this mode, vertical stacks of blocks will be composited by color. For example, if 5 blocks of the same color are on top of one another, only one point will be displayed for those 5 blocks. This greatly reduces the number of points to be displayed in the viewer, but this viewing mode can be difficult to interpret for relatively homogenous block models.

2. Render - this option will display each block as a solid.

3. Prompt Each Time - this option will prompt you to select the viewing mode each time a block model is loaded into the viewer.

Shading Mode: When the Shading control is enabled, the rendering of the shaded 3DFACE entities (usually used to represent a surface model) will vary based on:

1. Shade Front - Shades only the "positive" normal direction.
2. Shade Back - Shades only the "negative" normal direction.
3. Shade Both - Shades both the "positive" and "negative" normal directions.
Control Action

Adds a single surface file to the 3D Viewer. You may also add one or multiple surfaces to the viewer by right clicking on "Surfaces" in the tree view.

Allows you to edit properties of the currently selected entity.

Loads a 3DX file into the viewer. This file contains all entities within a saved 3D View.

Save the entities in the 3D Viewer to a 3DX file.

Model Controls

Within the "model" tab is a "tree-view" of the various entities that comprise the view along with the listing of layers upon which the entities are found. Each "branch" in the tree view may be expanded by clicking the "+" symbol to the left of the branch. Entities may be displayed (thawed), hidden (frozen), or edited by right clicking the entity name and selecting the appropriate option. The below dialog shows the properties of a surface that may be edited.

Chapter 4. View Menu
Visibility: This option toggles the visibility of the entity.

Color By Normal (Surfaces/Solids): When enabled, this option will color the surface/solid by the direction perpendicular to each face. This view can be useful for identifying particularly steep areas of the surface. The Color By Elevation option must be disabled to show the designated color.

Override color from file: When enabled, this option will override any color assignments and display the entity as a single color. The Set Color button below this option sets the color for the entity. The Color By Elevation option must be disabled to show the designated color.

Opacity (Surfaces/Solids): This option controls the opacity of the entity. A lower opacity results in increased surface transparency and is helpful for viewing sub-surface utilities such as Storm Sewer pipes and manholes.

Texture (Surfaces/Solids): When enabled, the option colors the surface with a texture such as grass or asphalt. The Scale of the texture may be modified to enlarge or shrink the image resolution.

Shading Mode (Solids): This option controls which side of the 3D faces of the solid should be shaded.

These controls are always displayed at the bottom of the window.

Control Action

The Clip Plane slider bar hides a portion of the view. Sliding the bar to the right will clip more of the view. This is helpful for producing quick "section" views of the data.

This button takes a screenshot of the 3D Viewer. Several different image file formats are supported including bmp, png, jpg, xpm and gif. The image resolution and color depth may be set with this option.

This button exports the 3D Viewer to a PDF report with project information. The default project information is set under Carlson Configure \acirc\dagger’ General Settings. The dialog that appears for this command is shown below.
This button exports the 3D Viewer to a 3D PDF. This function is further described in the 3D Viewer to 3D PDF help article. Note that you must have access to the CADNET module in order to use this command.

This button opens the help documentation you are currently reading.

Exit the 3D viewer window.

Common Controls

![Export Image To PDF Options dialog box](image)

**Scale Type:** This option controls how the image and the paper will be scaled to match one another. When the *Fit Paper to Image* option is selected, you will be able to manually set the *Image Size*.

**Paper Size:** This option sets the size of the PDF.

**Draw Border:** This option toggles the addition of a border around the PDF.

**Draw Title Block:** This option toggles the addition of a title block in the PDF. Information such as the *Company Name*, *Project*, *Date*, and *Logo* will be included in the title block. The logo may be selected by clicking the *Select* button and the dimensions may be specified in pixel dimensions.

**Top/Side/Bottom Margin:** These values set the margins around the PDF in inches.

- To quickly view just a surface file, use the Surface 3D Viewer command.
- To visualize a site with animated vehicle controls, use the Surface 3D Fly-Over command.
Viewpoint 3D

This command allows you to define 3D view settings.

1 Under Set Viewing Angles, you must set the direction of the view relative to either the world coordinate system (WCS) or a user coordinate system (UCS).
   - **Absolute to WCS**: This option sets the view direction relative to the WCS.
   - **Relative to UCS**: This option sets the view direction relative to the current UCS.

2 You must specify the viewing angles.
   - **X Axis**: This field specifies the angle from the X axis.
   - **XY Plane**: This field specifies the angle from the XY plane. You can also use the sample image to specify viewing angles. The black arm indicates the new angle. The red arm indicates the current angle. Specify an angle by selecting the inner region of the circle or half-circle. Selecting the bounded outer regions rounds off the angle to the value displayed in that region.
   - **Set to Plan View**: This option sets the viewing angles to display the plan view relative to the selected coordinate system.

**Prerequisite**: None.

**Keyboard Command**: DDVPOINT

Redraw

This command refreshes the display in the current viewport.

**Prerequisite**: None

**Keyboard Command**: R

Regen

This command regenerates the drawing and refreshes the current viewport.

**Prerequisite**: None

**Keyboard Command**: REGEN
Set UCS to World

This command sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson command work exclusively in the world coordinate system. In AutoCAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, use this command to restore the UCS.

**Prerequisite:** None

**Keyboard Command:** ucs_world

---

**Restore Due North**

This command twists the screen to make due north vertical. When the grid projection is specified under the Drawing Setup command, this command will prompt for whether to use grid north or geodetic north. When the grid projection is not set, this routine automatically twists to grid north.

**Prompts**

**Twist to Grid North or True Geodetic North [ <Grid>/True]?** press Enter

**Pulldown Menu Location:** View > Twist Screen

**Keyboard Command:** twist4

**Prerequisite:** None

---

**Display Order, Bring to Front**

This command allows you to change the display order of objects by repositioning an entity from either the background to the forefront of the drawing view or from the forefront to the background of the drawing view.

**Prerequisite:** None

**Keyboard Command:** draworder

---

**Twist Screen Line**

This command is a variation of Twist Screen Standard. The command aligns a selected line, polyline or text to be parallel to the east-west direction of your graphics screen.

Think of what you select as a pointer or arrow that will be moved to point in the east direction of the screen. Select the line, polyline or text closest to the endpoint that you want it to point in the horizontal or east direction of the screen.

**Prerequisite:** None

**Keyboard Command:** TWIST2

---

**Twist Screen Surveyor**

This command is another variation of Twist Screen Standard. You enter the angle/azimuth that you want to be aligned parallel to the east-west direction of the graphics screen.

**Prerequisite:** None

**Keyboard Command:** TWIST3

---

**Twist Screen Standard**

This command allows you to "twist" the screen's orientation so that a direction other than North is toward the top of the screen and the drawing. It does not do a coordinate rotation, and it leaves the database unchanged. The ROTATE and MOVE commands in the Edit menu can be used to do a coordinate rotation and translation.

This command prompts you for the twist angle, then adjusts the screen and crosshairs to that angle. The twist angle is always measured counterclockwise, with 0 degrees at the east/right.

**Prerequisite:** None
Layer Control

This command allows you to manage layers and layer properties.

This Layer Properties Manager dialog box makes a layer current, adds new layers to the layer name list, and renames an existing layer. You can assign properties to layers, turn layers on and off, freeze and thaw layers globally or by viewport, lock and unlock layers, set plot styles for layers, and turn plotting on and off for layers. You can filter the layer names displayed in the Layer Properties Manager, and you can save and restore layer states and properties settings.

1 Under Named Layer Filters, you determine which layers to display in the list of layers. You can filter layers based on whether they're xref-dependent, or whether they contain objects. You can also filter layers based on name, visibility, color, linetype, linewidth, plot style name, whether they are plotted, or whether they are frozen in the current viewport or in new viewports.

• [...] This button displays the Named Layer Filters dialog box.

• Invert Filter: This option displays layers based on the opposites of the criteria you select when you are using a named layer filter. Layers that fit the inverse criteria are displayed in the layer name list.

• Apply to Object Properties Toolbar: This option displays in the Object Properties toolbar only layers that match the current filter. The layer list tooltip on the Object Properties toolbar displays the filter status of layers in the drawing. (To display the layer list tooltip, position the pointing device over the layer list on the Object Properties toolbar.)

• New: This option creates a new layer. After you choose New, the list displays a layer named LAYER1. You can edit this layer immediately. To create multiple layers quickly, you can select a layer name for editing and enter multiple layer names separated by commas. If you create a new layer, the new layer inherits the properties of the currently selected layer in the layer list (such as Color, and On/Off state). To create layers with default settings, make sure that there are no selected layers in the list or that you select a layer with default settings before beginning layer creation.

• Current: This option sets the selected layer as the current layer. The CLAYER system variable stores the layer name.

• Delete: This option deletes selected layers from the drawing file definition. You can delete only unreferenced layers. Referenced layers include layers 0 and DEFPOINTS, layers containing objects (including objects in block definitions), the current layer, and xref-dependent layers. Layers that don't contain objects (including objects in block definitions), are not current, and are not xref-dependent can be deleted by using the PURGE command. Be careful about deleting layers if you are working on a drawing in a shared project or one based on a set of layering standards.

• Show/Hide Details: This option controls whether the Details section is displayed in the Layer Properties Manager.
• **Save State**: This option displays the Save Layer States dialog box, in which you save layer state and layer properties settings of all layers in a drawing. You can choose which layer states and properties you want to preserve. You save a layer state by assigning it a name.

• **Restore State**: This option displays the Layer States Manager, in which you can manage named layer states.

2 The Layer Properties Manager dialog box displays all layers and their properties. To modify a property, click its icon. To quickly select all layers, right-click your pointing device and use the shortcut menu. The following are the layer properties you can modify:

• **Name**: This field displays the names of the layers. You can select a name, and then click and enter a new name.

• **On/Off**: This field turns layers on and off. When a layer is on, it is visible and available for plotting. When a layer is off, it is invisible and not plotted, even if Plot is on.

• **Freeze/Thaw in All Viewports**: This field freezes and thaws layers in all floating viewports. A frozen layer is invisible and excluded from regeneration, hiding objects, rendering, and plotting. A thawed layer is visible and available for regeneration, hiding objects, rendering, and plotting.

You can freeze layers to speed up ZOOM, PAN, and many other operations, improve object selection performance, and reduce regeneration time for complex drawings. TakeOff does not display, plot, or regenerate objects on frozen layers. Objects on frozen layers do not hide objects and are not rendered.

You can freeze layers in all viewports, in the current viewport, or in new viewports.

Freeze layers that you want to be invisible for long periods. When you thaw a frozen layer, the program regenerates and displays the objects on that layer. If you switch between visible and invisible states frequently, use the On/Off setting.

• **Lock/Unlock**: This field locks and unlocks the layers. You cannot select or edit objects on a locked layer. Locking a layer is useful if you want to view information on a layer for reference but do not want to edit objects on that layer.

• **Color**: This field changes the color associated with the selected layers. Clicking the color name displays the Select Color dialog box.

• **Linetype**: This field changes the linetype associated with the selected layers. Clicking any linetype name displays the Select Linetype dialog box.

• **Lineweight**: This field changes the lineweight associated with the selected layers. Clicking any lineweight name displays the Lineweight dialog box.

• **Plot Style**: This field changes the plot style associated with the selected layers. If you are working with color-dependent plot styles (the PSTYLEPOLICY system variable is set to 1), you cannot change the plot style associated with a layer. Clicking any plot style displays the Select Plot Style dialog box.

• **Plot/Don’t Plot**: This field controls whether the selected layers are plotted. If you turn off plotting for a layer, the objects on that layer are still displayed. Turning off plotting for a layer affects only visible layers in the drawing (layers that are on and thawed). If a layer is set to plot, but is currently frozen or off in the drawing, TakeOff does not plot the layer. Turning off plotting for layers containing reference information such as construction lines can be useful.

**Prerequisite**: None

**Keyboard Command**: LAYER

**Set Layer**

This command allows the user to change the current layer to a different layer by picking an entity on that layer.

**Pulldown Menu Location**: View

**Keyboard Command**: lset

**Prerequisite**: None

**Change Layer**

This command allows you to change the layer of a group of entities by selecting the group of entities. The layer name to assign can be either typed in or read from an existing entity by picking an entity that is on the layer that you want to change the group to.
Prompts

Select entities to be changed.
Select objects: pick entities
The Select Layer dialog appears select a layer from the list, or select Screen Pick
If Screen Pick is chosen,
Pick entity with layer to change to: pick another entity This assigns the selected entities to the layer of this entity.
or
Enter new layer name or pick entity with layer (Enter/ < Pick>)? E
Enter new layer name: FINAL This assigns the selected entities to the FINAL layer.

Pulldown Menu Location: View
Keyboard Command: lchg
Prerequisite: None

Freeze Layer By Pick

This command will freeze layers by picking entities on that layer. The entity selection is done one at a time. As entities are selected, the layers are frozen.

Prompts

Pick entity on layer to be frozen: pick an entity
Freezing layer
Pick entity on layer to be frozen (U-Undo, Enter to end): press Enter

Pulldown Menu Location: View
Keyboard Command: pickoff
Prerequisite: None

Freeze Layer by Selection

This command will freeze layers by picking entities on that layer. The entity selection is done by selection set for selecting one or more entities.

Prompts

Select entities on layers to be frozen.
Select objects: pick entities
Thaw Layer

This command thaws the layers frozen by the Freeze Layer command.

Pulldown Menu Location: View
Keyboard Command: loff
Prerequisite: None

Isolate Layer

This command freezes all the layers except the ones you select an entity on. The program prompts to see if you would like to retain the POINT layers which keeps the Carlson point layers from freezing. By default, these layers include PNTNO, PNTMARK, PNTDESC, and PNTELEV.

Prompts

Select objects on layers to isolate.
Select objects: pick entities
Retain POINT layers [Yes/<No>]? Press Enter

Isolate the wall layer by picking one wall line

Pulldown Menu Location: View
Keyboard Command: isolate
Prerequisite: None

Restore Layer

This command thaws the layers that were frozen by the Isolate Layer command.

Pulldown Menu Location: View
Keyboard Command: restore
Prerequisite: None

Thaw/On All Layers

This command turns on and thaws all layers in the drawing.

Pulldown Menu Location: View
Keyboard Command: loa
Draw Menu
Line

This command allows you to draw a line entity by picking points on the screen or by supplying the coordinate values using the point number and associated coordinates stored in the current coordinate file. The Line command links the line with the points when the line is drawn using point numbers if the Link Linework with Points option is turned on. This option is set under General Settings in the Configure command in the Settings menu. With links active, changing a point with a command like Move Points automatically updates the line. This command always draws 2D lines with a zero elevation.

Prompts

1 Pick point or point numbers: 1-3
   You may enter a single point number or a range of point numbers
2 Undo/Distance/<Pick point or point numbers>: 16
3 Undo/+/-/Close/Distance/<Pick point or point numbers>: 35
4 Undo/+/-/Close/Distance/<Pick point or point numbers>: +
The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.
5 Perpendicular Distance Right: 80
6 Undo/+/-/Close/Distance/<Pick point or point numbers>: -
The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.
7 Perpendicular Distance Left: 105.12
8 Undo/+/-/Close/Distance/<Pick point or point numbers>: D
The distance option allows you to input a distance for the next line segment. The position of the cursor determines the angle.
9 Enter distance: 174.32
10 Undo/+/-/Close/Distance/<Pick point or point numbers>: C
The close option draws a line segment back to the original starting point

Prerequisite: None

Keyboard Command: 2DLINE

2D Polyline

This command creates a 2D polyline. A Polyline is a complex CAD entity comprised of one or more line or arc segments. While a 2D polyline elevation isn't necessarily zero, a 2D polyline is flat with all vertices at the same elevation.

This command is available from the Draw pulldown menu, from the Draw toolbar or at the Command: line (2DP) and provides many more options than the standard CAD version of the command. Unless disabled, the Polyline 2D Options dialog box will appear after starting Carlson's 2D Polyline command.
**Show Options on Startup**: When this option is enabled, the **Polyline 2D Options** dialog box will display automatically upon starting the **2D Polyline** command. If disabled, you can still get to this dialog by typing O for Options at the command prompt.

**Elevation**: Set the elevation of the polyline to be drawn. The **Set Elevation By 1st Point** option will use the elevation from the first specified point for the whole polyline.

**Offset from Centerline**: If this option is enabled, an additional option, Offset, is available from the Command: line. Issuing the "Offset" option allows you to draw a new polyline using Station and Offset entry from an existing polyline or existing Centerline (.CL) file.

**Skip Inline Vertices for Extend**: This setting applies to the "Extend" option with the Total Distance SubMenu option. If enabled, an existing vertex will dissolve when lengthening a 2D Polyline segment.

**Prompt To Draw Another**: This option stays in the command after completing the polyline and prompts whether you want to draw another polyline.

**Auto-Zoom Mode**: This setting provides 3 options for Auto-Zoom: Never, Proximity or Always. The "Never" setting requires you to manually Zoom or Pan to keep the current polyline vertex centered in the drawing screen. The "Proximity" setting will activate the "Proximity Level" setting and will automatically re-center the view only if the current polyline vertex is within a certain distance of the limits of the drawing area. The "Always" option will automatically re-center the view after each new polyline vertex is added.

**Annotate Closed Pads**: Enabling this option will activate the "Settings" button. The "Settings" button displays the **Label Pad Elevations** dialog box where you can specify label settings for the pad and other vertical offset elevations. For instance, you can label both the Finished Floor Elevation and the SubGrade elevation of a building pad at the same time using this command. See additional information on the **Label Pad Elevation** command.
In the "Polyline Properties" section of the dialog box you have several alternatives for specifying the layer, color and linetype of the newly created polyline.

**Auto-Correct For 90 Degree Corners:** This option will adjust two line segments to make an exact 90 degree corner when the original lines are nearly 90 degrees.

**Smooth Polyline:** This option applies for drawing smooth polylines such as a path for a stream. The Bezier smoothing method is used which passes through all the points and smooths only between the points.

**Use Current Drawing Properties:** Select this option if you want the layer, color and linetype of the newly created polyline to match those currently set in the drawing.

**Layer:** Use this setting to manually assign the layer for the newly created polyline. You can type in the new layer name, use the "Select" button to choose an existing layer from the drawing's layer list or use the "Pick" button to select an entity in the drawing and match its layer.

**Set Color:** Use this button to manually specify a color for the newly created polyline.

**Width:** Specify the width of the newly created polyline.

**Linetype:** Use the "Select" button to manually specify a linetype for the newly created polyline.

**Select Code:** This option allows you to set the layer, color and linetype of a new polyline by using the properties assigned to a Field to Finish field code. The field code is selected from an existing Field Code table (.FLD) file that has been previously specified in the **Point Defaults** dialog box.

**Prompts**

**Command:** 2dp

[Continue/Extend/Follow/Offset/OPTions/<Pick point or point numbers>]: screen pick a point

[Arc/Close/Distance/Follow/Offset/Undo/<Pick point or point numbers>]: screen pick a point

Segment length: 202.55, Total length: 202.55

[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: screen pick a point

Segment length: 179.73, Total length: 382.28

[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: screen pick a point

Segment length: 127.45, Total length: 509.73

[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: press Enter
Options and SubMenu Options

Once all settings have been specified and the "OK" button is picked, the options shown below are available from the Command line. To issue any of these options, simply type in the capitalized portion of the Option at the Command line and press Enter. The default option is always shown between angle brackets < Default >.

**Continue**: This option allows you to select an existing polyline to which you'd like to add more line or arc segments. When prompted to "Select a polyline to continue or extend:", you may pick anywhere on the existing polyline and the new segment will begin at the ending vertex nearest your cursor. New line or arc segments can be added by screen-picking or using the options at the Command line. Once finished adding segments, they are automatically joined to the original polyline.

**Extend**: This option gives you many ways to lengthen or shorten an existing polyline using the abbreviated SubMenu options shown below. Some of these options create additional segments at the end of the existing polyline and some allow you to change the length of the ending segment of the polyline. When prompted to "Select a polyline to continue or extend:", you may pick anywhere on the existing polyline and the "Extend" will occur at the ending vertex nearest your cursor. Once finished Extending, the new segments are automatically joined to the original polyline.

[I / R / L / S / T / A / B / E / U / X / Help / <Enter or Pick Distance>]

**I - Input mode** - This option toggles the distance input between feet & inches (will prompt first for feet, then prompt again for inches) and decimal feet.

**R - Right rotate** - From the ending vertex, turns the pointer 90-degrees to the right and then prompts for a distance.

**L - Left rotate** - From the ending vertex, turns the pointer 90-degrees to the left and then prompts for a distance.

**S - Switch direction** - From the ending vertex, turns the pointer 180-degrees and then prompts for a distance.

**T - Total distance** - Prompts you to "Enter total distance (100.00)" and displays the current length of the segment in parentheses. If a number smaller than the current distance is entered, this option will shorten the existing segment. If a number larger than the current distance is entered, this option will lengthen the existing segment. This option is also affected by the Skip Inline Vertices for Extend setting in the Polyline 2D Options dialog box. If "Skip Inline Vertices for Extend" is enabled, then the existing vertex will be dissolved when lengthening a segment. If the setting is not enabled, then the existing vertex will be left intact and an additional segment will be created inline.

**A - Angle change** - From the ending vertex, prompts you to "Enter Angle (ddd.mmss):" to turn the pointer by a specified angle and then prompts for a distance.

**B - Bearing/Azimuth/Turned/Deflection** - From the ending vertex, this option allows you to set the pointer direction by specifying an Angle. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**E - Extend to edge** - Extends current segment to another line or entity

**U - Undo** - Undo last action

**X - Quit extend mode** - Returns to normal 2D Polyline Draw mode

**Help** - Displays the descriptions of the Extend options

**Enter or Pick Distance** - Distance to extend the current segment

**Follow**: This option allows you to trace all or a portion of an existing polyline. After issuing the "Follow" option, you are prompted to "Select the polyline to Follow:" and then to "Specify the first follow point:". After snapping to a starting point on the polyline, you are asked whether you want to "Interpolate follow vertices elevations?". With this being a 2D Polyline, the answer to this is most likely "NO". You will then be prompted to specify the "Last follow point or follow distance:" where you can snap to another point on the polyline or type in a distance to trace the existing polyline.

**Offset**: With the "Offset" option, you will first be prompted to select an existing polyline or select an existing Centerline (.CL) file. Next, you will be asked to "Specify starting station:" where you will enter the station number of the first polyline vertex. Then, you will be prompted to "Enter Station" and "Enter Offset" for each vertex of the new polyline. Note: To have this option available, you must place a check next to Offset From Centerline in the Polyline 2D Options dialog box.

**Pick Point or Point Numbers**: This is the default prompt for the command. From here you can set a new polyline vertex by screen picking, entering coordinates in X,Y format or entering a point number from the associated Coordinate (.CRD) file.

**Arc/Line**: New polyline segments can be either an Arc or a Line segment. If the last polyline segment drawn was a LINE, then the "Arc" option will be shown as an available option; however, if the last polyline segment drawn was an ARC, then the "Line" option will be available.

When in the "Arc" mode, there are many additional SubMenu options available to you for creating an arc segment.
within the new polyline. The options are generated directly from the standard CAD version of the PLINE command and include Radius Point, Radius Length, Arc Length, Chord and Second Point (Point on Curve).

Close: This option will create a new Line or Arc segment back to the starting vertex of the polyline and results in a closed polyline.

Distance: This option allows you to first enter a distance for the new Line segment and then to specify the direction using one of three methods: Cursor, Line or Angle.

Cursor - This method will draw the polyline segment in the direction of your cursor position.

Line - This method prompts you to select a line or polyline segment to which it will draw a parallel segment.

Angle - This method prompts you for an Angle to determine the direction of your new polyline segment. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

Undo: Undo the last drawn polyline segment.

Angle Entry Methods
The Angle format is Qdd.mmss where: Q=quadrant/angle, d=degrees, m=minutes and s=seconds. The Quadrant/Angle can be specified as:
1=NE (NorthEast)
2=SE (SouthEast)
3=SW (SouthWest)
4=NW (NorthWest)
5=AZ (AZimuth)
6=AL (turned Angle-Left)
7=AR (turned Angle-Right)
8=DL (Deflection angle-Left)
9=DR (Deflection angle-Right)

Pulldown Menu Location: Draw
Keyboard Command: 2DP
Prerequisite: None

3D Polyline
This command creates a 3D Polyline. A 3D Polyline is a version of a polyline that can have different elevation at every vertex. 3D Polylines can not have arcs and the program will instead draw a series of short chords to closely follow an arc.

The 3D Polyline command is available from the Draw pulldown menu, from the Draw toolbar or at the Command: line (3DP). Unless disabled, the Polyline 3D Options dialog box will appear after starting Carlson's 3D Polyline command.
Show Options on Startup: When this option is enabled, the Polyline 3D Options dialog box will display automatically upon starting the 3D Polyline command. If disabled, you can still get to this dialog by typing O for Options at the command prompt.

Prompt for Elevation/Slope: When this option is enabled, the elevation for each new vertex will be displayed as a prompt, giving you an opportunity to override that value by typing in a new elevation. When disabled, the elevation to be assigned to each new vertex is displayed but you are not given a chance to assign a different elevation.

Prompt for Coordinate Point Elevations: This option only applies if you specify a point number from an associated Coordinate (.CRD) file to establish the X,Y,Z values for a new 3D Polyline vertex. When this option is enabled, the elevation for each new vertex will be displayed as a prompt, giving you an opportunity to override that value by typing in a new elevation. When disabled, the elevation to be assigned to each new vertex is displayed but you are not given a chance to assign a different elevation.

Elevation Adder: Use this setting to add a constant elevation value to all default elevation values.

Check Elevation Range: Enabling this option allows you to monitor elevations assigned to 3D Polyline vertices and issue a warning (with options to correct) if the elevation falls outside the specified range. If the proposed elevation of a 3D Polyline vertex falls outside the range specified, the Warning: Elevation Range dialog box is displayed. The Warning: Elevation Range dialog box allows you to assign a new elevation to the vertex, adjust the acceptable range of elevations or turn OFF monitoring of elevations.

Use Surface Model From File: Selecting this option allows you to use a Surface Model (.TIN, .GRD, .FLT) file to determine the elevation for each new 3D Polyline vertex.

Skip Inline Vertices for Extend: This setting applies to the "Extend" option with the Total Distance SubMenu option. If enabled, an existing vertex will dissolve when lengthening a 3D Polyline segment.
Prompt To Draw Another: This option stays in the command after completing the polyline and prompts whether you want to draw another polyline.

Auto-Zoom Mode: This setting provides 3 options for Auto-Zoom: Never, Proximity or Always. The "Never" setting requires you to manually Zoom or Pan to keep the current polyline vertex centered in the drawing screen. The "Proximity" setting will activate the "Proximity Level" setting and will automatically re-center the view only if the current polyline vertex is within a certain distance of the limits of the drawing area. The "Always" option will automatically re-center the view after each new polyline vertex is added.

In the "Polyline Properties" section of the dialog box you have several alternatives for specifying the layer, color and linetype of the newly created polyline.

Auto-Correct For 90 Degree Corners: This option will adjust two line segments to make an exact 90 degree corner when the original lines are nearly 90 degrees.

Smooth Polyline: This option applies for drawing smooth polylines such as a path for a stream. The Bezier smoothing method is used which passes through all the points and smooths only between the points.

Use Current Drawing Properties: Select this option if you want the layer, color and linetype of the newly created polyline to match those currently set in the drawing.

Layer: Use this setting to manually assign the layer for the newly created polyline. You can type in the new layer name, use the "Select" button to choose an existing layer from the drawing's layer list or use the "Pick" button to select an entity in the drawing and match its layer.

Set Color: Use this button to manually specify a color for the newly created polyline.

Width: Specify the width of the newly created polyline.

Linetype: Use the "Select" button to manually specify a linetype for the newly created polyline.

Select Code: This option allows you to set the layer, color and linetype of a new polyline by using the properties assigned to a Field to Finish field code. The field code is selected from an existing Field Code table (.FLD) file that has been previously specified in the Point Defaults dialog box.

Prompts

For A 3D Polyline With A Specified Elevation At Each Vertex:

Command: 3dp

[Continue/Extend/Follow/Options/\(<\text{Pick point or point numbers}>\)\]: screen pick a point
Interpolate/Object/\(<\text{Elevation}>\) <0.00>: 150.50
Z: 150.50

[Arc/Close/Distance/Follow/Undo/\(<\text{Pick point or point numbers}>\)\]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/Osnap[\,]/\(<\text{Interpolate}>\): 155.25
Z: 155.25, Hz dist: 324.63, Slope dist: 324.66, Slope: 1.5% Ratio: 68.3:1

[Arc/Close/Distance/Extend/Follow/Line/Undo/\(<\text{Pick point or point numbers}>\)\]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/Osnap[\,]/\(<\text{Interpolate}>\): 148.12
Z: 148.12, Hz dist: 272.88, Slope dist: 272.98, Slope: -2.6% Ratio: -38.3:1

[Arc/Close/Distance/Extend/Follow/Line/Undo/\(<\text{Pick point or point numbers}>\)\]: press Enter

Command:

For A 3D Polyline With Interpolated Elevations At One or More Vertices:

Command: 3dp

[Continue/Extend/Follow/Options/\(<\text{Pick point or point numbers}>\)\]: screen pick a point
Interpolate/Object/\(<\text{Elevation}>\) <0.00>: 91.73
Z: 91.73

[Arc/Close/Distance/Follow/Undo/\(<\text{Pick point or point numbers}>\)\]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/Osnap[\,]/\(<\text{Interpolate}>\): screen pick a point
This point elevation will be interpolated upon completion.
Percent/Ratio/Elevation/Degree/Object/Osnap[\,]/\(<\text{Interpolate}>\): screen pick a point

Chapter 5. Draw Menu
This point elevation will be interpolated upon completion.
Percent/Ratio/Elevation/Degree/Object/Osnaps/<Next point or elevation> <Interpolate>: screen pick a point
This point elevation will be interpolated upon completion.
Percent/Ratio/Elevation/Degree/Object/Osnaps/<Next point or elevation> <Interpolate>: 94.44
Z: 94.44, Hz dist: 79.39, Slope dist: 122.88, Slope: 0.8% Ratio: 122.4:1
[<Arc/Closed/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]>: press Enter
Command:

Note that the difference between this and the previous example is that, instead of entering an elevation for each vertex, we are screen picking another new vertex. Each time we neglect to enter an elevation we are notified that, "This point elevation will be interpolated upon completion." After we specify "94.44" as the elevation of the last vertex, the slope of the interpolated segments is calculated using the total elevation change and the total length of all interpolated segments. Now, the elevations of all vertices can be determined and set based on the resulting slope.

Options and SubMenu Options

Once all settings have been specified and the "OK" button is picked, the options shown below are available from the Command: line. To issue any of these options, simply type in the capitalized portion of the Option at the Command: line and press Enter. The default option is always shown between angle brackets < Default >.

When starting a new 3D Polyline, the initial set of options assist you in setting the X,Y location of the first vertex:

Continue: This option allows you to select an existing polyline to which you'd like to add more line or arc segments. When prompted to "Select a polyline to continue or extend:“, you may pick anywhere on the existing polyline and the new segment will begin at the ending vertex nearest your cursor. New line or arc segments can be added by screen-picking or using the options at the Command: line. Once finished adding segments, they are automatically joined to the original polyline.

Extend: This option gives you many ways to lengthen or shorten an existing polyline using the abbreviated SubMenu options shown below. Some of these options create additional segments at the end of the existing polyline and some allow you to change the length of the ending segment of the polyline. When prompted to "Select a polyline to continue or extend:“, you may pick anywhere on the existing polyline and the "Extend“ will occur at the ending vertex nearest your cursor. Once finished Extending, the new segments are automatically joined to the original polyline.

[I / R / L / S / T / A / B / E / U / X / Help / <Enter or Pick Distance>] 

I - Input mode - This option toggles the distance input between feet & inches (will prompt first for feet, then prompt again for inches) and decimal feet.
R - Right rotate - From the ending vertex, turns the pointer 90-degrees to the right and then prompts for a distance.
L - Left rotate - From the ending vertex, turns the pointer 90-degrees to the left and then prompts for a distance.
S - Switch direction - From the ending vertex, turns the pointer 180-degrees and then prompts for a distance.
T - Total distance - Prompts you to "Enter total distance (100.00)" and displays the current length of the segment in parentheses. If a number smaller than the current distance is entered, this option will shorten the existing segment. If a number larger than the current distance is entered, this option will lengthen the existing segment. This option is also affected by the Skip Inline Vertices for Extend setting in the Polyline 3D Options dialog box. If "Skip Inline Vertices for Extend" is enabled, then the existing vertex will be dissolved when lengthening a segment. If the setting is not enabled, then the existing vertex will be left intact and an additional segment will be created inline.
A - Angle change - From the ending vertex, prompts you to "Enter Angle (ddd.mmss):“ to turn the pointer by a specified angle and then prompts for a distance.
B - Bearing/Azimuth/Turned/Deflection - From the ending vertex, this option allows you to set the pointer direction by specifying an Angle. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.
E - Extend to edge - Extends current segment to another line or entity
U - Undo - Undo last action
X - Quit extend mode - Returns to normal 3D Polyline Draw mode
Help - Displays the descriptions of the Extend options
Enter or Pick Distance - Distance to extend the current segment

Follow: This option allows you to trace all or a portion of an existing polyline. After issuing the "Follow" option, you are prompted to "Select the polyline to Follow:" and then to "Specify the first follow point:". After snapping to a starting point on the polyline, you are asked whether you want to "Interpolate follow vertices elevations?“. After answering Yes or No,
you will then be prompted to specify the "Last follow point or follow distance:" where you can snap to another point on the polyline or type in a distance to trace the existing polyline.

**Options:** This will display the **Polyline 3D Options** dialog box.

**Pick Point or Point Numbers:** This is the default prompt for the command. From here you can set a new polyline vertex by screen picking, entering coordinates in X,Y format or entering a point number from the associated Coordinate (.CRD) file.

After setting its location, the next set of options help you calculate the elevation of the initial vertex:

**Interpolate:** This option will set the elevation of the vertex by calculating the slope between other vertices of known elevation.

**Object:** This option allows you to "Select an elevation label or a point on a polyline:" to set the elevation of the vertex. Elevation labels such as "FFE: 124.85" or "Z: 124.85" can be selected.

**Elevation:** This is the default option and prompts you to type in the elevation for the vertex.

For subsequent 3D Polyline vertices, several options are added to assist you in setting the X,Y location of each new vertex:

**Arc/Line:** New polyline segments can be either an Arc or a Line segment. If the last polyline segment drawn was a LINE, then the "Arc" option will be shown as an available option; however, if the last polyline segment drawn was an ARC, then the "Line" option will be available.

When in the "Arc" mode, there are many additional SubMenu options available to you for creating an arc segment within the new polyline. The options are generated directly from the standard CAD version of the PLINE command and include Radius Point, Radius Length, Arc Length, Chord and Second Point (Point on Curve).

**Close:** This option will create a new Line or Arc segment back to the starting vertex of the polyline and results in a closed polyline.

**Distance:** This option allows you to first enter a distance for the new Line segment and then to specify the direction using one of three methods: Cursor, Line or Angle.

- **Cursor** - This method will draw the polyline segment in the direction of your cursor position.
- **Line** - This method prompts you to select a line or polyline segment to which it will draw a parallel segment.
- **Angle** - This method prompts you for an Angle to determine the direction of your new polyline segment. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**Undo:** Undo the last drawn polyline segment.

After setting subsequent vertices, several more options are added to help you calculate the elevation of each new vertex:

**Percent:** This option allows you to specify the slope in Percent format (3%) from the previous vertex.

**Ratio:** This option allows you to specify the slope in Ratio format (for 3:1, enter 3) from the previous vertex.

**Degree:** This option allows you to specify the slope angle in decimal degree format (dd.dddd) from the previous vertex.

**Osnap:** Using the [.] will toggle Running OSNAP settings ON or OFF.

**Angle Entry Methods**
The Angle format is Qdd.mmss where: Q=quadrant/angle, d=degrees, m=minutes and s=seconds.
The Quadrant/Angle can be specified as:

1=NE (NorthEast)
2=SE (SouthEast)
3=SW (SouthWest)
4=NW (NorthWest)
5=AZ (AZimuth)
6=AL (turned Angle-Left)
7=AR (turned Angle-Right)
8=DL (Deflection angle-Left)
9=DR (Deflection angle-Right)
Circle

This command allows you to draw a circle.

Prompts

1 Pick center point or point number or [3P/2P/TTR]: pick point or specify option
   • 3P: This option draws a circle based on three points on the circumference.
   • 2P: This option draws a circle based on two endpoints of the diameter.
   • TTR-Tangent, Tangent, Radius: This option draws a circle with a specified radius tangent to two objects.
2 Specify radius of circle or [Diameter]: enter a value

Sometimes more than one circle matches the criteria specified in the command. The circle whose tangent points are closest to
the selected points is drawn.

Prerequisite: None
Keyboard Command: SCIRCLE

3 Point

This command draws an arc between three points. The first point is the PC, the second is a point on the arc and the third is the
PT. The points can either by picked on-screen or specified by point number.

Prompts

Pick PC point or point numbers: 101 (For point number 101.)
Pick Second point or point number: 102
Pick PT point or point number: 103

PC, PT, Center

This command draws an arc between the PC point, radius point and PT point. The points can either by picked on-screen or
specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one
direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC point or point number: 101
Pick Radius point or point number: 102
Pick PT point or point number: 103
Is the direction of this arc correct? No/<Yes>: N
PC, Radius, Arc Length
This command draws an arc given the PC point, radius length, and arc length. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC Point or point number: pick a point
Pick Radius point or point number: pick a point
Arc length <5.00>: 150
Is this arc in the correct direction ( <Yes>/No)? press Enter
Pulldown Menu Location: Draw > Arc
Keyboard Command: pra
Prerequisite: None

2 Tangents, Radius
This command fits a curve between two tangent lines by entering a known radius. It prompts for the radius and then prompts to pick points on the two tangent lines.

Prompts

Radius of Arc <300.00>: press Enter
[nea] Pick Point on 1st Tangent Line: pick a point
[nea] Pick Point on 2nd Tangent Line: pick a point
Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlin
Prerequisite: Tangent lines should be drawn before execution

2 Tangents, Arc Length
This command fits a curve between two tangent lines and a known arc length. It prompts for the arc length then pick the P.I. (intersection of tangent lines) and points on the two tangent lines.

Prompts

Arc Length <100.00>: press Enter or enter distance
[nt on] Pick P.I. of curve: pick intersection of tangent lines
[nea on] Pick pnt on 1st Tangent Line: pick a point
[nea on] Pick pnt on 2nd Tangent Line: pick a point
Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlal
Prerequisite: Tangent lines should be drawn before execution

2 Tangents, Chord Length
This command fits a curve between two tangent lines and a known chord length. It prompts for the chord length, the P.I. and points on the two tangent lines.

Prompts

Chord Length <100.00>: press Enter
[nt on] Pick P.I. of curve: pick a point
Tangent, PC, Radius, Arc Length

This command draws a curve from a perpendicular tangent line with a known radius and arc length. It prompts for the radius, the arc length and then to pick the P.C. start point of the curve (endpoint of previously drawn tangent line) and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the left.
Radius of Arc <15.00>: 55
Arc Length <25.00>: 30
PC Start Point ?
Pick point/<point Number>: 14
PtNo. North(y) East(x) Elev(z) Desc
14 4869.06 4390.3 10.00
[nea on] Pick point along perpendicular tangent line: pick a point on tangent line
Radius Point Coordinates: (4355.2 4911.4 0.0)

Tang, PC, Radius, Chord Length

This command draws a curve from a perpendicular tangent line with a known radius and chord length. It prompts for the radius, the chord length and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the left.
Radius of Arc <300.000>: press Enter
Chord Length <25.000>: press Enter
PC Start Point ?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5142.38 4911.57 0.0)
Radius Point Coordinates: (5221.51 5209.63 0.0)

Tang, PC, Radius, Delta Angle

This command draws a curve from a perpendicular tangent line with a known radius and delta angle. It prompts for the radius, the delta angle and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts
Precede radius with - sign for curve to the left.
Radius of Arc <300.00>: press Enter
Enter Delta Angle <90.00>: press Enter
PC Start Point ?
Number/<Pick point>: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: srda
Prerequisite: Tangent lines should be drawn before execution

Curve Calc

This Curve Calculator command displays a dialog box with a series of edit boxes that are filled in with the values of a curve. You can input two known values and the program calculates the other values. One of the known values must be the radius or the delta angle. The 3 Points option allows you to simply select three on-screen point locations. All of the fields will immediately be filled in after the picking of the third point. Optionally, you can also input point numbers from a coordinate file.

Roadway or Railroad: Allows you to choose which type of curve you would like information on. Toggling between the two, after data is entered, will reveal different values.
Select: Allows you to select an arc from the drawing. The information for the selected arc is displayed in the dialog box.
3 Points: Allows you to specify three points on the screen to define an arc. The information for this defined arc is displayed in the dialog box.
Plot: Allows you to plot the currently defined arc in the drawing.
Clear: Clears all edit boxes in the dialog.

Prompts

Curve Calculator dialog Enter at least two values, as described above
The dialog box first pops up without any data in the fields. The above dialog graphic is a result of entering in the radius and the arc length values of a known curve, then the Enter or Tab key.

Pulldown Menu Location: Draw > Arc
Keyboard Command: curvecalc
Prerequisite: None
**Text Wizard**

This command creates text using a dialog to set the text properties. In the dialog, you set the text string to create, height, justification, layer, style and color. Text Rotation chooses between having the label horizontal to the current view, prompting for the label angle or at a fixed angle specified in the dialog. The Use MText setting controls whether to create the text as a regular Text entity type or as MText. The Use Current Drawing Properties option will use the current layer, style and color from the drawing instead of the dialog.

![Text Wizard Dialog](image)

**Prompts**

**Draw Text dialog**

**Text location:** pick a point

**Pulldown Menu Location:** Draw > Text

**Keyboard Command:** drawtext

**Prerequisite:** None

**Text Import**

This command reads a text file and draws the contents as text entities. The file to import and the options are set in the dialog show here.

When using a Microsoft Word .doc or .docx file, the document is drawn as MText using the formatting from the document. There is an option to link the MText to the document so that the MText is updated when the document in changed. This update is done when the drawing is opened or running a REGEN.
Text Export

This command writes a text file from the selected Text and MText entities. The text is sorted to output in top to bottom order based on the entity locations.

Symbols

This command inserts symbols from the symbol library into the drawing. The symbol library may be edited using the Edit Symbol Library command. The locations for the symbols can be specified by picking points, specifying point numbers in the current coordinate (.CRD) file or by entering the northing and easting. If you specify a point number, and that point number already has a symbol on it, you will be prompted whether or not to replace the existing symbol. Selecting the Enter coords option allows you to insert the symbol by entering a northing, easting and elevation. Using the Select entities option, symbols can also be placed on arcs, faces, points, text, lines and polylines. Under the Options command, you can turn prompting for rotation on or off. With rotation off, the symbol will be inserted horizontal to the current twist screen. Choose a symbol from the Select Symbol dialog by clicking on it. The Symbol Category choices are Points, Trees and Map Symbols. You may select a category by choosing the Symbol Category dropdown list. Within each category, use the scroll bar to view all of the symbols.
Appears at start of command

Appears when Select (symbol) is chosen

Select entities dialog box

Prompts
Insert Symbols dialog: choose variables and click OK
Options/Select entities/Enter coords/ <Pick point or point numbers>: pick a point
Options/Select entities/Enter coords/ <Pick point or point numbers>: 5-10 Inserts symbols at points 5-10 from the current coordinate file.
Options/Select entities/Enter coords/ <Pick point or point numbers>: S
Insert Symbols dialog
Select arcs, faces, points, text, lines and polylines. select objects
Options/Select entities/Enter coords/ <Pick point or point numbers>: press Enter to end

**Hatch Wizard**

This command draws a hatch. The dialog has settings for the Color, Layer, Transparency and Scale for the hatch. The Use Layer/Color of Perimeter Polyline option sets these properties for the hatch from the polyline used for the hatch perimeter instead of from the dialog. The Pick Interior Point to Make Perimeter method defines the hatch area by picking a point in the drawing and having the program find the bounding linework. Otherwise the program prompts to select the inclusion and exclusion perimeter polylines. The Prompt For Exclusions controls whether the program prompts to select closed polylines for areas to exclude from the hatch.

After dialog and selecting the hatch area, the program prompts for the hatch pattern. Then the hatch is created.

![Hatch Wizard dialog box](image)

**Prompts**

Pick interior point method:
**Pick interior point:** pick a point
**Pick interior point (Enter to end):** press Enter

Pick polylines method:
**Select the Inclusion perimeter polylines.**
**Select objects:** pick closed polylines to hatch
**Select the Exclusion perimeter polylines or ENTER for none.**
**Select objects:** press Enter
**Select Text to Exclude from fill or ENTER for none.**
**Select objects:** press Enter
For selected text, the program automatically creates an exclusion box around the text to keep the hatch pattern from covering the text.

**Pulldown Menu Location:** Draw
**Keyboard Command:** hatchwiz
**Prerequisite:** Perimeter linework
Raster Image

This command allows you to manage raster images.

The Image Manager dialog box lists all the image files attached to the current drawing. You can view the parameters and details for selected images. You can attach new image files and detach, locate, reload, and unload existing images.

- **List View**: This button lists the image definitions attached to the drawing. Each image name appears only once regardless of how many times you attach (insert) the image. You can sort the list of images by name, status (loaded, unloaded, or not found), size, type (TIFF, for example), date, or the saved path and file name. By default, TakeOff displays the list alphabetically by image name.

To select multiple images, hold down SHIFT or CTRL while selecting items.

To sort the list alphabetically or numerically by a specific column, click that column's heading.

To change the width of the column, drag the line between the column headings to the right or left. The program saves and restores the settings when you reopen the dialog box.

To change an image name, select it and then click it again, or select it and then press F2. You cannot edit names of images that reside in external references (xrefs). Image names can include up to 255 characters and can contain letters, digits, spaces, and any special characters not used by Microsoft® Windows® or TakeOff. The image name can be identical to the file name, but changing the image name does not change the file name.

- **Tree View**: This button displays all the image definitions and the levels of nesting of images within xrefs. The top level of the tree view shows images that you attached directly to the drawing, images nested in block references, and the names of externally referenced drawings containing images. The names of the images attached to the externally referenced drawings appear nested within the drawing at the next tree level. To insert a copy of an already attached image, select it, and then choose Attach.

Tree view lists the image names only (not file names) and lists the image name just once, regardless of how many times you attach (insert) the image.

You can edit an image name by selecting it and then clicking it again, or by selecting it and then pressing F2. However, you cannot select more than one image at a time.

- **Attach**: This option displays the Select Image File dialog box. When you unload and then reload an image, the program draws that image on top. Images remain loaded or unloaded from one drawing session to the next.

- **Detach**: This option removes the selected image definitions from the drawing database and erases all the associated image objects from the drawing and from the display.

- **Reload**: This option loads the most recent version of an image or reloads an image that was previously unloaded. Reloading does not control whether the image is displayed, but it ensures display of the most current image.

- **Unload**: This option unloads image data from working memory without erasing the image objects from the drawing. It is recommended that you unload images no longer needed for editing to improve performance. An unloaded image cannot be displayed or plotted. You can selectively load and unload individual images from a working list of images associated with the drawing file.
Details: This option opens the Image File Details dialog box, which displays the image name, saved path, active path, file creation date and time, file size and type, color system, color depth, width and height in pixels, resolution, default size in units, and a preview image.

Image Found At: This field shows the path of the selected image. If you select multiple images, this field remains blank. The path shown is the actual path where the image resides.

Browse: This option opens the Select Image File dialog box (a standard file selection dialog box). The path you select appears under Image Found At.

Save Path: This option stores the new path information. Press ESC while editing the path to restore the old path. If the program cannot find the referenced image in the new path, the image's status changes to Not Found. If you do not choose Save Path after editing the path, the program uses the original image path the next time you load the drawing.

2 Under the Image dialog box, you can attach an image.

3 In the Image dialog box, you must first identify the image and the path.

Name: This field identifies the image you have selected to attach, either from the Select Image File dialog box (an unattached image) or from the list of previously attached images. To add another instance of an image file that is already attached, select the image name from the list and choose OK.

Browse: This option opens the Select Image File dialog box (a standard file selection dialog box). If Show Preview is selected, the program displays a preview of the selected file.

Retain Path: This option saves the path of the image file with the image definition. If Retain Path is not selected, only the image name is saved and TakeOff searches the Support File Search Path.

4 Under Insertion Point, you must specify the insertion point for the selected image. Specify On-Screen is the default. The default insertion point is 0,0.

Specify On-Screen: This option directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter the insertion point in X, Y, and Z.

X: This field sets the X coordinate value.

Y: This field sets the Y coordinate value.

Z: This field sets the Z coordinate value.

5 Under Scale, you must specify the scale factor of the selected image. Specify On-Screen directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter a value for the scale factor. The default scale factor is 1.

6 Under Rotation, you must specify the rotation angle of the selected image. If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or enter a rotation angle value on the command line. If Specify On-Screen is cleared, enter the rotation angle value in the dialog box. The default rotation angle is 0.

Prerequisite: Raster image

Keyboard Command: IMAGE
Arrowhead
This command draws an arrowhead at the end of the selected line or polyline.

Prompts

Enter the arrow size <5.00>: press Enter
Pick a line or pline to add arrow: pick a line or polyline
Pick a line or pline to add arrow (Enter to End): press Enter

Pull down Menu Location: Draw
Keyboard Command: arrowhd
Prerequisite: None

Curve - Arrow
Curve - Arrow can be used to draw a section of contour line or create leader pointer lines. Curve - Arrow draws a Bezier curve through user specified points. After choosing endpoints, each time an intermediate points is picked the curve will be redrawn through all the points. There is an option to draw an arrowhead at the starting point. This routine also has a Zorro option which creates a Z leader curve. The Draw Text option will make the program prompt after the leader points for a text label to place at the end of the leader.

Prompts

Pick a starting point: pick a point
Pick an ending point: pick a point
Pick an intermediate point (U to Undo): pick a point
Pick an intermediate point (U to Undo): press Enter

Examples of Curve - Arrow

Pull down Menu Location: Draw
Keyboard Command: carrow
Prerequisite: None
Leader With Text

This command will draw a straight or curved leader between two points, with an arrow at one end and optional text at the other. The options dialog is displayed at the start. To skip this dialog, turn off the Show Options On Startup toggle. Then on the command line, entering \textit{O} for Options will show the options dialog. To quickly change the label size, enter \textit{S} for Size at the command line.

In the options dialog, Text Position chooses between automatically placing the label next to the leader end point or picking the label position. For Text Justification, you can set a specific justification or use the Automatic option which uses either Left or Right justification depending on whether the leader end is left or right of the leader start. Text Rotation chooses between having the label horizontal to the current view, prompting for the label angle or at a fixed angle specified in the dialog. The Hide Drawing Under Labels option uses a wipeout to hide drawing entities behind the leader labels. The Curved Leader option curves the leader between the start and end points. Otherwise a straight leader line is created. The Use MText option chooses between creating MText or regular Text entities. The Landing Style of Horizontal Tick draws a short horizontal line segment at the end of the leader. The Landing Style of Underline draws the leader line under the text like an underscore. The Text Size Scaler and Arrow Size Scaler are multiplied by the Horizontal Scale from Drawing Setup to set the drawing size for the label and arrowhead. There are settings for the layer and style for the label. When the User Current Drawing Properties is on, then the current layer and current style from the drawing will be used.

The Text Input can either be entered with prompts after the leader points at the command line or selected from a prepared list. The prepared list is a way to quickly create leaders for common labels. To prepare the label list, use the Add, Edit and Remove buttons. Use the Save and Load buttons to save the preset labels to a .CALL file.

Prompts

![Options/Size/Pick Arrow Location dialog](image)

**Options/Size/Pick Arrow Location:** \textit{pick a point}

**Text location:** \textit{pick a point}

**Text:** Leader With Text

**Text:** press Enter
**Pulldown Menu Location:** Draw > Leader  
**Keyboard Command:** LDR  
**Prerequisite:** None

### Special Leader

This command draws a curved leader line like the one shown. With this routine you can also choose to enter in multiple lines of text, not just a single line. The arrow size is determined by the Symbol Plot Size setting, found in the *Drawing Setup* command. On the command line, selecting *O* for Options will provide you with more customizing choices to make.

### Prompts

**Options/Pick Arrow Location:** *pick a point* Pick point where leader arrow will start.  
**Text location:** *pick a point*  
**Text:** *Monument*  
**Text:** *press Enter*

![Monument](image)

### Callout Leader

This command draws a triangle shaped leader and a label inside a box. There is a dialog to enter the label string, style, size and colors. The leader is drawn in the current layer.
Prompts

Callout Leader Settings dialog
Pick callout point: pick a point for point of leader
Pick textbox corner: pick a point for position of label

Pulldown Menu Location: Draw > Leader
Keyboard Command: callout_lrd
Prerequisite: None

Bold Curve Leader

This command draws a thick curved leader with an arrowhead. This leader is created by picking three points.

Prompts

Starting point: pick a point
End of arrowhead: pick a point
Pick end point of leader: pick a point

Pulldown Menu Location: Draw > Leader
Keyboard Command: site_leader
Prerequisite: None
Sequential Numbers

This command draws a text label and then increments to the next value for additional labels. The label can optionally be placed inside a circle, square or other symbol. The size of the symbol adjusts to fit the label size.

In the dialog, specify the **Text** label. The text **Prefix** and **Suffix** are optional. The **Text Size Scaler** is the text size in paper units that gets multiplied by the horizontal scale from Drawing Setup to set the text drawing size or **Text Size Dwg Units**. The **Justification** setting controls the text justification mode. The **Size By Symbol** method uses a fixed symbol size and sizes the label to fit within the symbol. When **Auto Increment Labels** is checked, the value entered in the Text field will be incremented by the value in the **Increment** field. The **Group Label With Symbol** option will make a group of the label text and symbol. When **Prompt for Alignment Every Time** is checked, you will be prompted for the alignment angle for each label, otherwise the alignment from the first label is automatically used for the other labels. The **Draw Leader** option creates a leader from the label to a picked point.

The label is drawn by combining the Prefix, Text and then Suffix into one text label. When placing multiple labels, the text portion of the label will increment by the value in the Increment field. For example, this command could be used to quickly label a series of boundaries by setting the Prefix to "Perimeter" and the Text field to the starting number. Then pick points inside the boundaries to label as "Perimeter 1", "Perimeter 2", etc.
Prompts

Select Symbol for Numbers dialog select your symbol
Sequential Numbering Options dialog make your choices
Pick point at beginning of label: pick a point
Pick point for label alignment: pick a point to the right of the first point
Pick point at beginning of label: press Enter to end the routine

Pulldown Menu Location: Draw
Keyboard Command: numbers
Prerequisite: None

Insert

This command allows you to place a named block or drawing into the current drawing.
1 In the Insert dialog box, you specify the block to insert and define the position for the inserted block. The last block you insert during the current editing session becomes the default block for subsequent uses of this command.

- **Name:** This field specifies the name of a block to insert or the name of a file to insert as a block.
- **Browse:** This button opens the Select Drawing File dialog box (a standard file selection dialog box) where you can select a block or a file to insert.

2 Under Insertion Point, you specify the insertion point for the block.

- **Specify On-Screen:** This option specifies the insertion point of the block using the pointing device.
- **X:** This field sets the X coordinate value.
- **Y:** This field sets the Y coordinate value.
- **Z:** This field sets the Z coordinate value.

3 Under Scale, you specify the scale for the inserted block. Specifying negative values for the X, Y, and Z scale factors inserts a mirror image of a block.

- **Specify On-Screen:** This option specifies the insertion point of the block using the pointing device.
- **X:** This field sets the X coordinate value.
- **Y:** This field sets the Y coordinate value.
- **Z:** This field sets the Z coordinate value.
- **Uniform Scale:** This option specifies a single scale value for X, Y, and Z coordinates. A value specified for X is also reflected in the Y and Z values.

4 Under Rotation, you specify the rotation angle for the inserted block.

- **Specify On-Screen:** This option specifies the rotation angle of the block using the pointing device.
- **Angle:** This field sets a rotation angle for the inserted block.

5 You can explode the block and inserts to the individual parts of the block. When you select Explode, you specify only an X scale factor.

**Prerequisite:** None

**Keyboard Command:** DDINSERT
Inquiry Menu
Point ID

This command reports complete information pertaining to a Carlson point. Although similar in function to the AutoCAD ID command, this routine is much more detailed. With this command, you are given the point number, as well as the northing, easting and elevation coordinates. You also are given the point description, and you are shown the name and the location of the coordinate file for the point.

**Prompts**

Pick point or point number: 255

<table>
<thead>
<tr>
<th>PointNo.</th>
<th>Northing (Y)</th>
<th>Easting (X)</th>
<th>Elev (Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>255</td>
<td>4379.83</td>
<td>4265.48</td>
<td>19.01</td>
<td>GROUND/SHOT</td>
</tr>
</tbody>
</table>
N: 4379.83  E: 4265.48  Z: 19.01
PT#: 255   CRD File: c:\Carlson2008\data\mantopo.crd

Pulldown Menu Location: Inquiry
Keyboard Command: PT_ID
Prerequisite: None

Layer ID

This command reports the layer name of the selected entity.

**Prompts**

Pick entity to read layer: pick an entity
Layer: FINAL
Pick entity to read layer: press Enter to end

Pulldown Menu Location: Inquiry
Keyboard Command: layerid
Prerequisite: None

Drawing Inspector

This command reports object properties to you as you move the cursor over an entity. You can simply move the pointer over an entity and the selected property will be displayed either in a pop-up window next to the pointer and/or on the status bar, depending on the selected option. Drawing Inspector is a transparent command that can run while other commands are running. Once Drawing Inspector is started, it will stay active even while running other commands until you turn it off. To turn off Drawing Inspector, run the command again to toggle it off by pick Drawing Inspector from the Inquiry pull-down menu or from the toolbar or by typing the command name, or right-click and choose Turn off Drawing Inspector. The options for this command are set in the menu that pops up by clicking the right mouse button. The available properties are: Layer Name, Elevation, Azimuth-Distance, Bearing-Distance, Point Data, Text Data, Curve Data, 3D Face Data, Polyline Data and Polyline Blips.
In the *Drawing Inspector* menu, you can choose one or more properties to display.

**Display Layer Name:** displays the layer name of the entity.

**Display Entity Type:** displays the type of the entity (ie. TEXT or POLYLINE).

**Display Elevation:** displays the elevation of the entity.

**Display Azimuth-Distance:** displays the azimuth and distance of a line.

**Display Bearing-Distance:** displays the bearing and distance of a line.

**Display Point Data:** displays the coordinate data of point.

**Display Text Data:** displays the contents of text.

**Display Curve Data:** displays the radius, arc length, chord length and delta angle of a curve.

**Display Polyline Data:** displays the end point elevations, horizontal distance, slope distance and slope ratios.

**Display 3D Face Data:** displays the Z elevations at the face corners.

**Display Polyline Blips:** displays temporary blip plus marks at the vertex locations of polylines.

**Display Polyline Direction:** displays temporary arrows to show the direction of polylines.

**Display Surface Elevation:** prompts for a TIN or grid surface file to load and displays the surface elevation at the current cursor location.

In the *Drawing Inspector* menu, you can also choose how the property information is reported.

**Enable Highlighting:** Allows you to highlight the object that the *Drawing Inspector* is reporting.

**Enable Tag Display:** Enables you to view the information next to the cursor on the screen.

**Show Data On Status Bar:** Enables you to view the information on the status bar, in the lower corner of the screen.

**Use Default Cursor:** When enabled, only the drawing cursor shows. When disabled, the mouse pointer is also shown.

**Report In High Precision:** When enabled, displays 8 decimals on distance and 4 decimal seconds on angles.

![Example of Drawing Inspector reporting Bearing-Distance using the Tag Display](image)
Curve Info

This command displays information about a curve/arc. The curve can be defined by an arc entity or polyline arc segment or by selecting three points on the arc. The three points can be defined by point number or picked on the screen. The curve data is displayed in the text window with an option to be displayed in the Standard Report Viewer. Click Exit to return to the graphics window.

Prompts

Define arc by, Points/<select arc or polyline>: select the arc entities
Endpoint: (4923.81 5193.15 0.0)
Other Endpoint: (5168.27 5274.03 0.0)
Radius Point Coords: (5126.6 4990.09 0.0)
Chord Bearing: N 71d41'33" E
Chord Azimuth: 71d41'33"
Delta angle in radians: 0.9304628295
RoadWay Degree of Curve: 19d57'56"
RailRoad Degree of Curve: 20d4'4" Chord Crv Length: 265.66 Excess: 1.36
External: 34.13 Mid Ord: 30.50 Tangent: 144.06
Delta: 53d18'42"
Chord: 257.49
Length: 267.02
Radius: 286.97
Display curve data in report viewer [Yes/<No>]? Y

Angle Info

This command reports the interior and exterior angles defined by two joining line segments or by three points. The coordinates, angles and distances of the line segments are also reported. The report is display in the standard report viewer.
Angle Information

<table>
<thead>
<tr>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Point:</td>
<td>11</td>
<td>4728.73</td>
</tr>
<tr>
<td>Corner Point:</td>
<td>12</td>
<td>4684.89</td>
</tr>
<tr>
<td>End Point:</td>
<td>13</td>
<td>4664.02</td>
</tr>
</tbody>
</table>

Bearing Distance

First Side: S 38°40'56'' W 56.16
Second Side: S 72°21'16'' E 68.85
Interior: 68°57'18''
Exterior: 291°02'42''

Prompts

Define angle by, Points/ <select line or polyline>: P for points
1st Point?
Pick point or point number: 11
2nd (Corner) Point?
Pick point or point number: 12
3rd Point?
Pick point or point number: 13
Interior: 68°57'18'' Exterior: 291°02'42''

Angle Info Report Viewer

1st Point (Enter to end)?
Pick point or point number: press Enter

Pulldown Menu Location: Inquiry
Keyboard Command: ainfo
Prerequisite: None

Angle & Distance

This command reports the slope distance, slope ratio, bearing, azimuth and vertical angle between two 3D points. Pick or enter the coordinates of two points or select a line or polyline segment to calculate between the segment endpoints.

Prompts

Specify bearing-distance from (Line/PLine/<Points>)? press Enter
Pick point or enter point number: pick a point
Pick second point or enter point number: pick a point
Horiz Dist: 233.4 Slope Dist: 233.4 Elev Diff: 0.0 Vert Ang: 0d0'0''
Slope: 0.0% 0.0:1 Bearing: S 71d15'37'' W Azimuth: 198d44'23''

Pulldown Menu Location: Inquiry
Keyboard Command: 3DIST
Prerequisite: None

**Display_Last_Report**

This brings up the last report generated by any Carlson Takeoff command that uses the standard report viewer.

**Prerequisite:** a previously generated report

**Keyboard Command:** last_report
Drawing Setup

This command allows you to specify drawing parameters, including the plotting scale, size of symbols, label annotation size, and the angle mode.

- Specify **English 1in=?ft** or **Metric 1m=?m** as the unit mode to use. This affects the prompting and reports. When you are working on a drawing in English units, one unit equals one foot. In metric, one unit equals one meter.
- Specify the **Horizontal Scale** of the drawing. For example, if the horizontal scale is set to 50, then 1” = 50’ is your drawing scale.
- The **Symbol Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The **Drawing Units** field shows the result of the Symbol Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Text Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The **Drawing Units** field shows the result of the Text Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Line Type Scaler** option sets the linetype scale by multiplying this scaler by the horizontal scale.
- **Angle Mode-Bearing** sets reporting to bearing mode for any of the inquiry commands. (Modifies the settings in the AutoCAD UNITS command.)
- **Angle Mode-Azimuth** sets reporting to north based azimuth mode for any of the inquiry commands. (Modifies the settings in the AutoCAD UNITS command.)
- **Angle Mode-Gon** sets reporting to gon mode for any of the inquiry commands. (Modifies the settings in the AutoCAD UNITS command.)
- **Angle Mode-Other** lets the user determine angle mode by using the AutoCAD UNITS command.
- **Coordinate System** is an optional setting to define the drawing coordinate system. The coordinate system settings are used in commands like List Points and Label Lat/Lon to report geodetic coordinates from the drawing coordinates. The Grid System setting applies to drawing coordinates that are in a grid projection system such as state plane coordinates. The Projection list selects the grid projection from the list of supported projections. Along with the Projection, there are selections for the zone and datum to use with the projection. When the drawing setup is in English mode, there is a projection setting for whether the feet are in US Feet or International Feet units. The Local System setting applies to all other coordinate system beside grid projections. The Define Localization button has settings to define the transformation from local coordinates to grid coordinates. With a localization defined, you can work in a drawing in local coordinates and still report lat/lon. The localization definition contains pairs of local and grid coordinates that define the transformation. See the Align To Local Coordinates command in the Field Module for more information.
• **Project Scale Factor** is multiplied by the x,y coordinates when converting between drawing and geodetic coordinates.

• **Base Z** is used for calculating the combined scale factor for calculating geodetic areas.

• **Projection:** There are several built-in projection including State Plane 83, State Plane 27 and UTM. Also on the Projection list is an item for More Pre-Defined as well as User-Defined projections. This expanded Pre-Defined selection includes the projections used in SurvCE which has hundreds of projections including the US County projections for Indiana INDOT INGCS, Iowa Regional Coordinate System, Minnesota, Oregon and Wisconsin (WCCS and WISCRS) as well as from around the world. When you pick Pre-Defined, a dialog shows a list of recently selected Pre-Defined projections.

![Select Projection](image)

You can pick from this recently used list, or pick the Add Pre-Defined to select from the built-in list.

![Select Projection](image)

The Add From File button reads in a projection saved to a file by this routine or by SurvCE CSL or ESRI PRJ. The Edit button allows you to change the name or parameters of a projection. The Remove function removes a projection from the list of recently used projections. The Add User-Defined routine defines a projection by setting the ellipsoid, choosing the method and entering the parameters. There are over 25 built-in ellipsoids to choose from such as Clarke 1880. You can also manually enter the ellipsoid values. The projection definition includes the 7 parameter Helmert transformation to go from WGS-84 to the user datum. There are over 20 projection types to choose from such as Transverse Mercator. After selecting the projection type, there are edit fields for each of the parameters for the selected projection. The Test button brings up a calculator to enter a lat/lon and report the projection coordinates as a way to test that the projection parameters are entered correctly and are working.
Besides Drawing Setup, these projection functions are also used in the Coordinate Transformation function in Coordinate File Utilities.

- **Project Name and Job Number** are optional fields that are used in the header for reports.
- **Project Location** is used in the header for reports and used to roughly geolocate the drawing when the Projection isn't set.

- **Report Distance Scale Factor** is used to show distances in a second system besides the drawing units. For example, this factor can be used to report distances in meters when the drawing is in feet, or it can be used to report grid distances when the drawings is in a ground coordinate system. This factor is applied in commands that have an option to label/report a second scaled distance such as the Inverse command and Annotate Defaults that applies to the angle/distance label routines. The scale factor can be set to a single fixed value or set to go from ground to grid or from grid to ground on-the-fly. The fixed scale factor can be entered directly into the edit box or calculated using the Set button which has feet-meters conversions as well as combined scale factor calculations for grid-ground factors. See the Scale Points command for more information on calculating the combined scale factor. For the on-the-fly factor between grid and ground, the program calculates the combined scale factor for each distance using the two end points for the distance line.

- **Rotation** is used to adjust the bearings and azimuths for labels and reports such as in the Inverse and Auto-Annotate routines.
- The **Set Text Styles** button creates text styles in the drawing for the current drawing Horizontal Scale with the specified Font Name and list of Style Names and Text Size Scalers. For example, when the Horizontal Scale is set to 50 and there is a Style Name of L80 with Text Size Scaler of 0.08 in the list, then this function will create a text style in the drawing called L80 with the text height of 4 (50 * 0.08). Besides the font and size, you can also set the width factor and oblique angle for each style. Use the Save and Load buttons to store and recall these style settings to a .FNT file for sharing with co-workers or your own use.
• The **Set Paper** button allows you to draw a rectangle on the screen that represents the edge of your paper. After you have set the horizontal scale, press the Set Paper button and the Set Paper dialog appears.

- The **Layout** option lets you specify landscape or portrait paper orientation. Landscape layout is where the width of the page is greater than the height of the page. Portrait layout is the opposite.
- The **Paper Size** option allows you to specify the paper size. The numbers in parenthesis represent drawing units and will be multiplied by the horizontal scale to determine the rectangle to be drawn. If you select the Other option, you will be prompted on the command line for the horizontal and vertical sizes of the paper.

**Prompts (for Set Paper)**

Pick or Type lower left corner point for border $<(5000.00 5000.00 0.0)>$: *pick a point*

Erase existing Set Paper boundary [<Yes>/No]? *Y* This prompt only appears if there is an existing paper boundary in this drawing.

Set Limits [Yes/<No>]? *Y* If you answer Yes to Set Limits, drawing limits are enabled, and AutoCAD restricts the coordinates you can enter to within the paper boundary. Drawing limits also determines the area of the drawing that can display grid dots, and the minimum area displayed by the Zoom All command on the View menu. To turn drawing limits off, type in LIMITS on the command line and set to Off.

Drawing Setup also sets the AutoCAD dimension scale (DIMSCALE) and linetype scale (LTSCALE) to the Horizontal Scale.
Configure

This command allows you to set up the default settings that are used each time you start a new drawing, or load an existing drawing.

NOTE: When using Carlson products with an "embedded AutoCAD OEM engine" (e.g. Carlson Survey with Embedded AutoCAD or Carlson Takeoff with Embedded AutoCAD), only a subset of the various configuration commands will be available.

Load: This command permits a previously saved configuration (CFG) file to be loaded into the software and is useful for propagating corporate standards to groups or individuals within an organization.

SaveAs: This command “packages” up all current configuration settings and permits them to be saved to a named configuration (CFG) file that can be shared with users of Carlson Software.

<table>
<thead>
<tr>
<th>General Settings</th>
<th>Drawing Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project/Data Folders</td>
<td>Startup Settings</td>
</tr>
<tr>
<td>Survey Settings</td>
<td>Surface Settings</td>
</tr>
<tr>
<td>Section-Profile Settings</td>
<td>Hydrology Settings</td>
</tr>
<tr>
<td>Mine Note Settings</td>
<td>Mining Settings</td>
</tr>
<tr>
<td>Takeoff/SiteNet Settings</td>
<td>Localization Settings</td>
</tr>
</tbody>
</table>

Table of Contents
Use Startup Wizard: When enabled, a dialog-based "wizard" interface is used for the creation of a new project.

Generate Report Log: When enabled, output from several commands will be accumulated in a report buffer. Commands that output to the report log include Inverse, Traverse, Curve Info, etc. Also, any report that is displayed in the standard report viewer is also added to the report log. While activated, the report log resides in the lower left corner of the desktop as a minimized title bar that shows how many lines are in the report buffer. To view the report log, pick on the maximize icon on this title bar. You can also view the report log by running the Display Report Log function in the Inquiry menu. The report log can be edited, saved to a file or printed. To quickly turn the report log on and off, you can type REPORT at the command prompt.

Generate Drawing Save Log: This option stores the time stamp and user name in the DWG each time the drawing is saved. This save log can be viewed using the Drawing Save Log command.

Save Drawing INI Files: This option stores the file names of data files used with the current drawing. When enabled, an .INI with the same name as the DWG file will be created to store the data file names. These file names are used for the list of recent files when selecting data files and the Drawing Explorer command manages the list of these data files.

Save Settings To Drawing Dictionary: This option saves the settings for commands within the drawing. Commands always store settings at the program level for recall the next time the commands are run. By storing settings with the drawing, each drawing will recall the command settings used in the drawing. For example, if you run Triangulate & Contour at an interval of 5 in Drawing_A, then use interval 1 in Drawing_B, then the next time you contour in Drawing_A it will recall interval 5 instead of using the last interval of 1.

Ignore Zero Elevs: This option will ignore any entities with a zero elevation. It is used for many commands, such as Triangulate and Contour or Make Grid File.

Use South Azimuth: Turning on this option will use a South Azimuth instead of a North Azimuth as the basis for 0°.

Use Dview Twist Angle: This will use the screen Twist Angle defined with the command DVIEW. This is similar to Twist Screen.

Set DIMSCALE to Drawing Scale: This will set the dimension scale to match the drawing scale.

Set AUNITS to Drawing Angle Mode: This will set the DWG angular units to match the angle mode established under Drawing Setup.
Set **PDSIZE** to **Symbol Size**: This will set the PDSIZE scale to match the symbol size defined in Drawing Setup.

Set **INSUNITS** to **Unitless**: This will set the INSUNITS (Insertion Units) CAD system variable to Unitless (INSUNITS=0) when the drawing is opened.

Set **MENUBAR** on **Startup**: When enabled, the Carlson Menu associated with the Carlson icon (usually on the PC Desktop) will be loaded. Otherwise, use the Carlson Menus command to select the desired menu.

Set **UCS** to **World** on **Startup**: When enabled, drawings with a User Coordinate System (UCS) other than **World** will have the UCS set to **World**.

Set **LTSCALE** on **Startup** to **Drawing Setup**: When enabled, the **linetype scale** (LTSCALE) variable will be set to the Horizontal Scale defined under Drawing Setup.

**Use Software Rendering**: When enabled, commands that use OpenGL functionality (such as 3D Viewer Window) on computers with older video cards that don't offer extensive hardware acceleration will attempt to render the information with any available random-access memory (RAM).

**Use Dialog For Selection Set Filter**: For IntelliCAD, this option chooses whether to prompt for selection set filters in a dialog or command prompt at the "Select objects" prompt.

**Use Annotative Text**: When enabled, text (usually placed through the Annotate Menu commands) will use scale-able annotative properties.

**Support All Drawing Scales**: When enabled, text placed as annotative entities will make use of all annotation scales currently defined within the drawing.

Set **Annotative to Drawing Scale**: This option sets the annotative scale to match the Horizontal Scale set in the Drawing Setup command.

**Annotative Scale Prefix/Suffix**: These strings are used for naming annotative scales when the program creates new annotative scales. For example, when the program creates an annotative scale for a horizontal scale of 50, you can name the annotative scale as 1:50 or 1"=50' depending on these string settings.

**Coordinate Report Order**: You can choose the traditional North-East format, or reverse these in reports with an East-North format.

**Date Format**: You can control the display of dates in Carlson reports with this drop-down menu. The default is "Windows Setting" which allows you to control it with Windows Control Panel. Several other common formats are available.

**Formatted Document Type**: (AutoCAD-based platforms, only) Use this option (for commands such as 3D Viewer Window to establish the type of document produced by the command.

**Report Viewer**: This option chooses between the Carlson Report Viewer, Windows Notepad and Microsoft Word for the viewer to use for reports that the Carlson commands generate.

**AutoCAD Menu**: (AutoCAD-based platforms, only) This option chooses which AutoCAD menu to load when picking the AutoCAD menu from the Carlson Menus toolbar or from the Settings &acirc;&dagger; Carlson Menus pull-down menu. When AutoCAD Map is installed, there are different layouts of the Map menu to choose from. When Autodesk LandDesktop is installed, those menus are available.

**Object Linking**: The Object Linking section contains options for creating additional "intelligence" on Carlson-placed entities:

- **Link Points with CRD File** - (AutoCAD-based platforms, only) When enabled, points placed into the drawing will be given a "reactor" so that any change to the entities such as MOVE or ROTATE will update the coordinates in the CRD file.
- **Link Linework with Points** - (AutoCAD-based platforms, only) Line and polyline entities that are drawn by point number (including those placed via Draw Field-to-Finish such that a positional change to a linked point will automatically update the linework.
- **Link Labels with Linework** - (AutoCAD-based platforms, only) When enabled, direction and/or distance labels assigned to physical linework entities will get updated if the underlying line is changed.
- **Link Linework with Centerlines** - (AutoCAD-based platforms, only) For linework that has been used to create a Carlson Centerline, changes to the linework will update the corresponding centerline (CL) file.
- **Group Point Entities** - When enabled, the three entities of a Carlson point (attribute block, symbol and node) become linked as a single entity. For each point, selecting any one of these entities selects all three entities for the point. **NOTE**: This setting is not the same as the "Point Group" functionality as found under the Point Group Manager command.
- **Maintain CRD History File** - When enabled, changes to a point are tracked into a "history" file. These changes can be accessed via the **History** button found under the Edit Point Attributes command.

**Coordinate File Format**: Carlson can be configured to utilize a variety of coordinate file formats:
• **Carlson Numeric Only** - Point numbers cannot contain letters and must be in the range from 1 to 99999.
• **Carlson Alphanumeric** - This format allows letters in the point numbers and the point "number" can be up to 9 characters in length. Any combination of letters and numbers is acceptable.
• **Carlson SQLite** - Based on the Structured Query Language (SQL) database format, this CRDB format allows alphanumeric combinations of point number and descriptions up to 255 characters in length.
• **C&G Numeric** - This format of the C&G division supports up to 5 digits, with a 65000 point limit.
• **C&G Alphanumeric** - This format of the C&G division supports up to 10 characters, with no limit to the number of points.
• **Simplicity ZAK**: This is the Simplicity Systems "Sight Survey" coordinate file format.
• **MS Access Database (LDT)** - This is a Microsoft Access database used by Autodesk Land Desktop. The file is typically named "points.mdb" and is typically found in a Land Desktop project \COGO subdirectory. The point identifier limitation is established by the database structure, which has a default of 255 characters.

**Remove Arcs**: Since 3D polylines do not allow true arcs, the program represents arcs in 3D polylines as a series of short chords. The Remove Arcs settings control the spacing of these arcs:

![Original Arc](image1)

![Arc Offset](image2)

• **Max Offset** - Sets the maximum difference between the chords and the original arcs as shown in the image above. This method is similar to the Reduce Polyline Vertices command.
• **Chord Len** - Sets the length of the chord segments that replace the original arc.

**Digitizer Puck Layout & View**: There are two main formats for the digitizer puck. They are numbered 1 and 2. Selecting the View button brings up the window showing the two formats.

![Digitizer Puck Layouts](image3)

- **Use Mouse**: This option allows you to use the mouse instead of the digitizer puck for the digitize commands.
- **Auto Tablet On for Digitize Commands**: This option will activate the tablet when using the digitize commands.
- **Auto Tablet Off for Digitize Commands**: This option will de-activate the tablet when using the digitize commands.

Several settings under **Drawing Setup** are used to establish the default values provided in the Startup Wizard and are identical to those discussed in Drawing Setup. There are a few additions, such as Vertical Scale, Point Prompt-Label Settings, Point Number Settings and Vertical Angle Mode.
There is also the ability to maintain two different sets of defaults (English and Metric). The user can maintain a comfortable set of settings for either unit system, especially if they constantly switch back and forth. Also added was support for meters/metres, tons/tonnes and various date representation which can be accessed via the Localization Settings button.

Please refer to the Set Project/Data Folder command for complete information.

These options are used for starting Carlson. Defaults are set here, and will be used at the beginning of each session.

**Template Name:** This is the drawing template file that will be used when starting a new drawing. The Browse button allows for selecting a new file.

**Carlson Launch Folder:** This is the folder where Carlson projects would be stored by default. The Browse button allows for selecting a new folder location.

**Profile Name:** This is the AutoCAD/IntelliCAD Profile that will be used when working in Carlson. If you use a custom profile, be sure that the profile contains the Carlson support folder in the Support File Search path (ie. %appdata%\Carlson Software\Carlson version\CAD version\SUP), and the Carlson main menu must be loaded. If the custom profile doesn't have these requirements, then the program switches to the default Carlson profile.

**AutoCAD command switches:** This turns off the AutoCAD "splash" screen upon launching the program. The /nologo takes the splash screen out of the start-up procedure. See AutoCAD documentation for other switches that are available for use.

**AutoCAD product to run:** (AutoCAD Only) This is the AutoCAD version and flavor (Map or LDT, etc.) that Carlson is installed for, and will run with.
No menu resetting: (AutoCAD Only) This controls whether to set the Carlson menu as the main customization file on startup or to keep the current main customization unchanged.

CG Survey Menu: Indicate whether to add-on the C&G Survey pull-down menus to the standard Carlson Survey menus. The Compact mode has all the C&G commands in a single pull-down menu. The Expanded mode has all eight C&G pull-down menus that C&G "stand-alone" used to have.

Initial Traverse/Sideshot Angle Mode: This sets the default angle mode for these COGO commands.

Show Occupy and Backsight Points on Status Bar: This is an option for the COGO Inverse command.

Automatic Raw File On: This is equivalent to toggling on the COGO &acirc;&dagger; Raw File On/Off automatically when the drawing is opened.

Automatic Line On: This is equivalent to toggling on the COGO &acirc;&dagger; Line On/Off automatically when the drawing is opened.

Automatic Point Object Snap On: This is equivalent to toggling on the Settings &acirc;&dagger; Point Object Snap On/Off automatically when the drawing is opened.

Automatic Compare DWG points with Coordinate File on Startup: This option runs the Coordinate File Utilities > Compare Points routine when the DWG file is opened to report any differences between the point entities in the drawing and point coordinates in the coordinate file.

Most of the Surface/Triangulate & Contour commands will remember the settings and parameters used from drawing to drawing. There are some in this screen that will be used for gridding and modeling.

Inverse Distance/LeastSquares Modeling Parameters: The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.
Specify Grid Resolution As: There are two ways to create a grid file. Once the boundary has been selected, the cells need to be determined. Number of Cells in X and Y will divide the boundary up into the specified number of cells. These will then be odd shaped rectangles, with the size calculated by the boundary dimensions and the number of cells. The Dimensions of Cells is the more commonly used method. This will allow for a set cell size for the X and Y directions. Most of the time the grid cells should be square, where you set the size.

Grid Precision: This is the number of decimals that are stored in the grid file.

Draw Contours Max Number of Rechecks for Crossings: Routines that generate contours check for any crossings that can occur from smoothing or reduction options. When a crossing is found, the smoothing or reduction factors are reduced and then the contours are rechecked in case that adjustment causes a new crossing. This option can be used to decrease the number of rechecks in case your dataset is large and you don’t want to take the time for these checks.

Save Grids Using Binary Format: This options chooses between saving .grd files as either text or binary files. This setting applies to all routines that save grid files. The advantage of the text format is the ability to view the grids using any text editor like Notepad and the ability for non-Carlson programs to easily read the grids. The advantage of the binary format is the speed of saving and loading the grids which is several times faster than the text format. Only Carlson 2015 and later versions can read the binary format. When the range of min/max grid values is small enough relative to the grid precision, the program will automatically switch to an indexed binary format which uses half the file size and loads twice as fast.

Eye Height and Object Height are used for calculating sight distance on vertical curves.

Vertical Curve Drawing Resolution applies to Draw Profile for the segment length for drawing vertical curves.

Use Crest Sight Distance Formula for Sag: When this option is on, the Crest Vertical Curve formula is used to calculate the sight distance for sag vertical curves. Otherwise the Sag Vertical Curve formula is used.

Parabolic Template Grade Subdivisions applies to Process Road Design and Road Network for how many 3D polylines to draw for grades defined as parabolic in the template.

Station Type controls the format of station labels. For the NO.0 type, there is a setting for the label prefix, and the Use Partial Labels for Intermediate Stations option will skip the label prefix for odd stations.

Stage-Storage File Format: Indicate the format of the Stage-Storage File to be used in Carlson Hydrology.

These options will toggle various prompts when entering Mine Notes in the Underground Mining module. You can also set the layers for various linework needed for geologic modeling and mine planning. These options are further described in the
This is the configuration screen for default settings used with the Mining Modules. Each item is detailed below.

**InverseDist/LeastSq Max Samples:** This value sets the maximum number of data points to use to estimate the value at a grid node. If this value is set to 20, only the 20 data points nearest the grid node being calculated will be used. This option only affects the Inverse Distance and Linear Least Squares modeling methods.
**Min/Max Quadrant:** When the program calculates the value of a grid node, the area around the grid node is divided into four quadrants, as shown below by the blue dashed line. These Min/Max Quadrant values set the minimum/maximum number of data points to use from each quadrant. If the Min Quadrant value is set to 5, a value will only be assigned to the grid node if at least 5 data points are found within all four quadrants. If the Max Quadrant value is set to 20, only the nearest 20 data points in each quadrant will be used for estimation.

**Search Radius:** This value sets the maximum search radius for data points. For example, if this value is set to 10,000, any data points beyond 10,000 ft/meters from a given grid node will not be used to estimate the value of that grid node. This concept is shown in the below image.

**Fill in Missing Strata Above/Below Existing Strata (Seam Stacking/Conformance):** This option determines how the program handles drillholes with missing strata. An example of a data set modeled with and without the conformance option is shown below. Notice that when conformance is applied, the red and blue strata will more closely mimic the green strata, even though the red and blue strata do not occur in all three drillholes. The program does this by artificially adding data points to the drillhole with missing strata.

In the below example, consider drillhole #3. This drillhole does not contain the blue strata. To make the blue strata conform to the green strata, the program will search for the nearest drillhole that contains the blue strata (in this case, Drillhole #1). The program will then measure the elevation difference between the blue and green strata and apply that same elevation difference in drillhole #3. In this example, the bottom of the blue strata and the top of the green strata in Drillhole #1 are 800' and 705', respectively (a difference of 95'). The top elevation of the green strata in Drillhole #3 is 655'. So, when the program models the blue strata, an artificial elevation of 750' (that is, 655' + 95') will be used in Drillhole #3. In this case, the green strata is considered to be the "marker" and the blue strata is considered to be the "target".

In drillhole #2, the red strata is not present. In this case, either the blue or the green strata could serve as the "marker" strata. When the "All" option is used, the program will automatically select one of these strata to be the "marker". The program will set the "marker" strata as the strata closest to the "target" strata. In this example, the red strata is closer to the blue strata, so the blue strata will be used as the "marker". If the "Seam-Specific" option is used, you will have to manually define which strata are "markers" and which strata are "targets".

Although this example shows the result of seam stacking/conformance applied to an area with sufficient drilling depth in an area with varying topography, the same effect can be applied to drillholes that are not simply drilled deep enough to intersect all strata.
None: This option will not apply seam stacking/conformance. In this scenario, each strata layer will be modeled independently of other strata layers. Only strata data that is actually included in the drillhole will be used to make the strata grid file.

All: This option will apply conformance in any way possible. This can be a useful option when the structure of all strata are similar. However this option does not give you the option to specify which strata layers are "markers" and which strata are "targets".

Seam Specific: This option also applies conformance, but requires that you specify which strata are "markers" and which strata are "targets". The strata are tagged as "markers" and "targets" in the Define Strata/Bed command. It is important to note that when using this option, you can define the "Marker Level", which sets the priority of the marker strata. This is an optional field, but it can have a significant impact on the model when multiple marker strata are available for use.

Use Conformance for Channel Samples: This option controls whether to use channel samples as source data points for conformance of other strata.

Calculate Strata Pinchout: This option determines if the thickness of a seam is pinched out when it does not occur in a drillhole, as shown in the below image.
When pinchout is disabled, as shown in the first cross section in the above image, the middle drillhole is completely ignored when making the grids for the blue and green strata. This results in the blue and green strata suggesting a significant thickness at the location of drillhole 2. In the second cross section, pinchout has been enabled, but the results are misleading because no thickness grids were incorporated into the model. In the third cross section, pinchout has been enabled and the thickness grids have been incorporated into the model to accurately model the pinchout.

It is important to note that elevation grids will not be automatically modified to show the pinchout, although the elevation grids may in fact be adjusted somewhat. It is therefore recommended to only enable this option when making thickness grids to avoid misleading results. When the program creates a thickness grid with this option enabled, the missing strata will be modeled as having a negative thickness at the drillhole without the strata. The thickness value will be equal but opposite to the thickness of the nearest thickness data point for that strata. In the above example, the blue strata has a thickness of 10' in drillhole 1, so the program will use a value of -10' in drillhole 2 when making the blue thickness grid. By incorporating a negative thickness value, the thickness will approach a value of zero approximately halfway between the drillholes 1 and 2. The Pinchout Slider bar to the right of this toggle in the dialog controls where the strata will actually pinchout. Before the thickness grid is written, it will be modified so that all negative values are reset to zero. This results in a thickness grid that begins to decrease in value as it nears the drillhole with the missing strata, but never shows a negative thickness.

Since this option is only intended to be used when making thickness grids, you will need to create modified elevation grids before adding them to the Geologic Model. This can be done quite easily with Grid File Utilities. In the above image, notice that the blue and green strata layers only pinch out properly when the elevation grids have been modified. In this case, the top of the blue strata was created by adding the bottom elevation grid of the blue strata to the thickness grid of the blue strata. Notice that in the second diagram in which only bottom elevation grids were used, the blue strata does not pinchout between the drillholes.

Finally, it is important to note that pinchout will only affect thickness grids when two "sandwiching" strata are detected above and below the missing strata. In the above image, the blue strata is "sandwiched" between the red and yellow strata. If drillhole 2 did not contain the red strata, then the blue strata would not pinchout. This means that the top and bottom strata in any given model will not be able to pinchout.

**Pinchout Zero Thickness:** This option determines if a strata with a thickness of zero will be modeled as a pinchout. Pinchout is normally only applied for strata layers that are absent in a hole.
**Pinchout Key Only:** This option will only apply the pinchout to the Key strata while the Non-Key strata will be modeled as if the pinchout were not applied.

**Adjust Non-Key for Estimated Key Strata:** This setting controls whether to adjust non-key strata to fit in key strata for pinchout or conformance.

**Restrict Pinchout to Drillhole Elevation Range:** This option controls where the seam will pinchout. If there is a shallow hole, and a seam is running beneath it, this setting will pinchout the seam if it is off. If it is on, then the seams will only pinchout if they pass through the elevation range of the drillhole. This is useful if it is desired to pinch out a seam that passes above or below the elevation range of the drillholes.

**Include Strata Name in Bed Composite:** This option will add the strata name to the bed name when running the bed compositing commands, such as Split Bed by Parameters.

**Composite Bed Qualities by Density:** When creating grids of bed qualities from drillholes with multiple samples of the bed quality, the quality will be composited to a single data point before the grid file is made. By default, the quality will be averaged by the thickness of the sample. When this option is enabled, the qualities will instead be averaged by weight (thickness * density). The **Density Attribute Name** sets the name of the density attribute to be used for weighting. Density is always expressed as lbs/ft$^3$ or kg/m$^3$.

**Use Strata Limit Lines:** This option determines if Strata Limit Polylines will be used for modeling. If this option is disabled, you will not be prompted to select Strata Limit Lines when modeling.

**Auto Select All Strata Limit Lines:** This option will automatically select all Strata Limit Polylines when modeling. You will not be prompted to select the lines when this option is enabled.

**Process Only Strata with Beds:** This option will ignore all strata layers without a bed name when modeling. This can be useful when overburden/interburden layers are not marked with unique strata names and have not been tagged with a bed name.

**Process Only Strata with Definition:** This option will ignore all strata that are not listed in the current Strata Definition file when modeling. However, strata layers that are not included in the Strata Definition file will still be used to calculate conformance and pinchout.

**Store Source Data in Grids:** This option will include the source data used to make strata grid files within the grid itself. This includes the X-Y coordinates of the data point, the value used for modeling, and the type of data source (drillhole, channel sample, etc.). This can be useful for understanding how the grid file was generated when the original source data is not available.

**Hole Dip Angle Direction:** This option determines how drillhole dip values are interpreted. The default option of $0 = Down—90 = Horizontal—180 = Up$ will treat dip values of 0 degrees as vertical in the downward direction, dip values of 90 degrees in the horizontal plane, and dip values of 180 degrees as vertical in the upward direction. The other options may be used to accommodate other dip value schemes.

**StrataCalc Drillhole Selection Method:** This option determines how the program will prompt for geologic data when modeling. The **On-Screen Drillholes** option will prompt you to select drillholes, channel samples, etc. when making the geologic model. The **StrataCalc File** option will instead prompt you for a .stc file, which can be saved from the StrataCalc Data Sheet command. The .stc file can be useful when you need to be certain that the same information is being used to create model between iterations.

**Underground Room/Pillar Settings:** These options apply to the series of commands for placing coal sections (used for calculating end of month volumes).

**Use 0 Values for Blank Entries in Coal Sections:** This option will replace treat blank values in coal sections as 0 rather than considering it to be null.

**Draw Coal Sections Z at Thickness:** This option will draw coal section symbols at the Z value of the actual thickness. For example, a coal section with a thickness of 5 feet will be drawn at an elevation of 5. This is useful for contouring or gridding the coal sections with standard commands from the Civil module.
**Prompt for Advancement Pline for Quantities**: This option will prompt you to select an additional advancement polyline when running the Quantities by Average / Grid / Centerline commands. This polyline represents the direction of mining in a particular area. The length of the polyline will be included in the quantity report.

**Report Format for Quantities by Avg/Grid Methods**: This option determines the default report format for the Quantities by Average / Grid / Centerline commands. However, each of these commands will also let you set the report format when the command is executed. The *Standard* option will use a simple text editor for the report. The *Columns* option will still use a standard text editor, but with the values aligned into columns. The *Formatter* option will send the report to the Report Formatter for user-defined formats.

**General Settings**: 

**Key Material Name**: This is the name of the key material you are mining. This name will be used in several reports to identify key material, such as the outputs from Surface Mine Reserves and Surface Production Timing. If you have more than one type of key material, you may want to give this a more generic name such as "Key Material" to avoid confusion in the reports.

**Bed Name Suffixes: KEY, OB, PARTING, BOTTOM**: These suffixes are used to identify the four portions of a bed. An example is shown in the below image. When Bed names are applied to a group of strata layers, all strata layers with matching bed names are treated as a single group. This allows the program to properly correlate groups between drillholes even when the number of samples for each bed is not consistent between drillholes. Although the strata will be treated as one group, there are four portions of the bed available for modeling. Note that not all four portions of the bed may not be present in a data set.

- **OB**: This is the non-key portion of the bed above the first occurrence of Key strata.
- **Parting**: This is the Non-Key portion of the bed bound between Key strata.
- **Key**: This is the Key portion of the bed.
- **Bottom**: This is the non-key portion of the bed below the last occurrence of Key strata.

![Bed Concept Diagram](image)

**SDPS Directory**: This field sets the installation directory for the Subsidence Deformation Prediction System (SDPS) program. The SDPS commands are found under the Subsidence Pulldown Menu of the Underground Mining Module.
**Use Map Object Data as Properties:** This option will use the AutoCAD Map data to set the Property and Owner names for reserve estimates. When this option is disabled, the program will use the Owner and Property names assigned to polylines from the Assign Property Names command.

These options are used for the Construction module and SiteNet commands in the Civil module.

**Extrapolate Surface To Boundary Perimeter:** When this is check ON surfaces are extended and volumes are calculated out to your boundary perimeter. When this is checked OFF surfaces and calculations end at the extents of your design data.

**Use Existing Surface To Extrapolate Design:** When this is checked ON surfaces and volumes are calculated to the extents of your existing data.

**Use Binary Triangulation File Format:** This option sets the format for the surface model files as either binary or ASCII. The binary format has a .tin file name extension and loads about twice as fast and has about 50% less file size than ASCII. The ASCII format has a .flt extension and is the legacy format used by other Carlson products and Softdesk.

**Minimize Flat Triangles:** This option reduces the occurrence of "flat" (or more precisely, horizontal) triangles. Flat triangles often occur when creating surface models from contour data. The Minimize Flat Triangle option will swap triangulation edges when possible to switch flat triangles to sloped triangles.

**Densify Breaklines:** This option automatically add vertices on breakline segments for triangulation at the specified Interval.

**Reduce Triangulation Surfaces:** This causes edges within the selected surface TIN mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh.

**Reduce Offset Distance:** This setting is used by the Reduce Triangulation Surfaces command to set the reduction tolerance. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

**Surface File Suffixes:** These settings allow you to change the file names for the surfaces generated by the program:
- **-og** - This is the default name for the original ground surface before adjustments.
- **-ze** - This is the default name for the original ground surface after subgrade zone adjustments.
- **-ex** - This is the default name for the original ground surface after subgrade zone and topsoil adjustments.
- **-bs** - This is the default name for the initial design surface before adjustments.
- **-zn** - This is the default name for the design surface after subgrade zone adjustments.
- **-fn** - This is the default name for the design surface after subgrade zone and topsoil adjustments.
- **-ox** - This is the default name for the over-excavate surface after subgrade zone and topsoil adjustments.
**Automatic Update Colors:** This refreshes colors in your drawing as they change (i.e. elevating entities, setting layers for different Targets, etc). If your drawing is very large and is slow to automatically refresh you may want to toggle this off and use the Update Colors For Set Elevations command under View when you want/need to see the color changes.

**Assign Colors By Target:** This option allows you to set the Existing, Design, and Other layers to any color you define.

**Assign Colors By Elevation:** This option allows you to set the color for entities needing elevations.

**No Elevation Entities Color:** Indicate the color entities with no elevation (Z=0) should be assigned to when their layer is classified as "Original" or "Design".

There are literally hundreds of default settings that can be set with this dialog. The categories that can be selected from are:

![Category Selection](image)

The Settings for each Category will display all of the items that can be setup for default values. The Default value is set in the Configuration Default Value box. The corresponding Metric or English default values are set here, allowing for easy switching between the two systems.

![Localization Settings](image)

**Pulldown Menu Location(s):** Settings  
**Keyboard Command:** config_scad  
**Prerequisite:** None

---

**Edit Symbol Library**

This command allows you to customize the symbol library. For a printout of the default symbols, get the symbols.pdf in the Carlson Projects folder. The default library has hundreds of 2D and 3D symbols including National CAD Standard (NCS) symbols, MassDOT standard symbols and a set of symbols with wipeouts built-in to hide linework under the symbols.

Categories are a way for grouping symbols by type for your own convenience in symbol selection. There are two levels of categories: top-level and sub-category. Within each top-level category, you can have any number of sub-categories. A new category is added by clicking on the "Add Category" button. An edit field then appears in the tree view on the left and waits for you to enter the category name. The input is finished by pressing the Enter key.

The category may be populated by creating a new symbol from selected entities in the drawing, by specifying drawing (.DWG) files, or by moving existing symbols from one category to another.
Each symbol has an optional description which is shown with the symbol to help choosing in symbol selection like in Draw > Insert Symbols. To change a description, highlight the symbol in the list and then pick Edit Description.

To create a new symbol, open a drawing which has the entities to be used in the symbol. The symbol should be drawn at unit size (scale 1:1) because Carlson will scale the symbol by the current drawing scale when the symbol is used. Highlight the category for the symbol and click on the "Create Symbol" button. A dialog appears for entering the new symbol name. Next, specify the file name for the symbol. The file name has a .DWG extension and would usually reside in the Carlson SUP directory, but you may use another path. Then the program will prompt you to select the entities from the drawing for the symbol. An insertion point for the symbol must also be picked.

The "Import Symbols" button brings up a file selection dialog which allows you to select multiple files to be added to the current category (to select multiple files use Shift or Control keys along with the mouse). If the files you select are not in the Carlson SUP directory, the program will offer an option of copying them there. There are also Import Library and Export Library buttons.

By default, the symbol description is the same as file name. The description for the symbol or category name may be changed by highlighting that name and clicking on "Rename" button, the name being edited is then placed into edit mode. To move a symbol into a different category, select the symbol to be moved on the tree and click an "Up" or "Down" button as many times a needed to reach the desired category. The symbols are sorted alphabetically within each category, while categories are remaining in the order placed to allow the more frequently accessed categories be on top.

The Reset button adds symbols from the default symbol library into the current library.

Note: The symbol library is stored in an ASCII file named symbols.dta in the Carlson \USER directory.

Pulldown Menu Location: Settings
Keyboard Command: editptsym
Prerequisite: None

Quick Keys

Quick Keys can provide an enormous time savings on initiating keyboard commands. One frustration of using CAD is when your command initialization cannot keep up with your train of thought, and you are constantly seeking the fastest way to initiate commands. Quick Keys provides numerous command aliases that are already set up for you, which you can customize easily. You can also add any new commands quickly and easily using the Quick Keys editor, without leaving CAD. The Quick Keys are so productive, that even dedicated menu users appreciate and use them.

The Quick Keys Editor can be broken down into areas. The spread box at the top of the screen, spread control buttons, and program control buttons. Each area and button is explained below.
Spread Box contains a list of the loaded quick keys. Use the scroll bar to move up and down through the list or maximize the dialog to view more rows. Each item can be edited in its cell.

Each record item consists of up to a 5 character quick key (the portion typed in at the command line), and a long command or AutoLISP expression. Note that if you are adding a shortcut to a lisp function, you must use the following syntax: (C:FUNC) where FUNC is the command name. All Carlson commands use this lisp function syntax. To find the lisp function name for a Carlson command, you can run the command from the menus and look for the command name in Command window. Also, you can find the command name in the Keyboard Command field at the end of each command description in the manual. For example, enter (c:quickkey) for the command to run Quick Keys. For CAD commands, the command name can be entered directly with a prefix of "_". For example, the CAD Area command name should be entered as _AREA. Some CAD commands will run in command line prompt mode instead of dialog mode when issued by the command name from Quick Keys. For these commands that you want to run with the dialog, enter the command with this syntax of (c:cad_command "name"). For example, enter (c:acad_command "_plot") for the CAD Plot command in dialog mode. There are several examples of this included with the Quick Keys defaults.

If you intend to make changes in an item, use standard editing procedures, including the use of arrow keys along with the tab key and/or pointer movements to make changes. Pressing enter on either field will have no effect on the item in the list.

Changes made to items are automatically changed in the list, you must use the OK button to record changes to be saved.

When a new item has been created in the edit fields, you must click the Add or Insert button to add the item to the list and type in your key, command and description in respective columns.

Highlight the item you wish to delete in the list box, then press the Delete button to remove it from the list. In the event you accidentally delete items, simply choose Cancel to exit without saving changes.

At any time during processing of Quick Keys, you may choose the Sort button to sort the list of Quick Keys or left click on respective column header to sort it using key, command or description. The most common use of sort will be after adding several new items to the list.

The buttons on the bottom row are used to control files. Changes made to the Quick Keys table are stored when exiting the dialog with the OK button. The original key definition file supplied is called Carlson.QKS. However, when you make changes for the first time and use the OK button to exit the dialog, the program writes changes to a file called CUSTOM.QKS. The Quick Keys editor looks for the existence of the file CUSTOM.QKS when loading, and will use this file when available. This approach will shelter your (CUSTOM.QKS) from overwrites if you reinstall Carlson.

When all changes are complete, choose the OK button to save changes, which will automatically build and load the runtime file. Any Quick Keys added or updated will be immediately available at the command prompt. However, if a key definition was deleted, it will not be removed from memory until another drawing is loaded or you begin a new drawing.
The Cancel button exits the Quick Keys dialog without making any changes to your system.

This Report option is used to obtain a printed list of the Quick Keys currently loaded. First consider sorting the list, then use this option and enter a filename. The program will write the list to a file that can be brought into any editor or word processor, then printed.

The Save As button can be used to save the current quick keys as a QKS file that can be distributed to other computers and can be loaded using Load button.

Pulldown Menu Location: Settings
Keyboard Command: quickkey
Prerequisite: None
Annotate Menu
Annotation Defaults

This command sets the defaults for the annotation menus and controls the way various annotation commands work. Some of these defaults can be changed globally by running Configure command, which changes the file COGO.INI so that every time you start Carlson, the new defaults are set. When this menu option is selected the Annotate Defaults dialog appears.

This dialog is broken into 5 tabs: General, Angle, Distance, Serial Lines and Parallel Lines.

General Tab

This tab is used for settings that apply to all annotation types.

Text Size Scaler: This value is multiplied by the horizontal scale value to set the text size units. The Horizontal Scale is set in the Drawing Setup command.

Text Offset Scaler: This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line.

Line Type Spacing: Specifies the distance between the symbols on special line types.

Line Type Text Scaler: This value multiplied by the horizontal scale specifies the size of the symbols of special line types.

Use MText: This option creates the labels as MText instead of standard Text entities.

Label Flip Tolerance (degrees): Gives extra tolerance for label flipping for readability. Labels draw in the north-west quadrant that are within this number of degrees to due-north will be drawn upside down.

Previous Labels: Specifies if previous labels for the for the set of linework being annotated are kept or deleted. Setting values are Retain, Erase, Prompt Before Erasing.
**Draw Leaders to Endpoints on Lines:** This option creates leader lines (crow's feet) between the distance annotation and the line segment endpoints as shown below. These leaders are used to help identify the endpoints that were used to create the distance label.

**Distance Labels Only:** When checked, leaders will not be drawn unless the label includes a distance.

**Leader Size Scaler:** This option determines the maximum length for leaders. The size in drawing units will be the Leader Size Scaler multiplied by the Horizontal Scale (for example, 0.5x50=25). If the line segment is too short, the leader is shortened to fit.

**Height Scaler:** This option controls the height of the leader.

**Offset Scaler:** This option controls the distance between the line endpoints and the leader endpoints.

**Arrow Scaler:** This option controls the arrowhead size for leader styles with arrows.

**Leader Style:** This option determines which of the five styles of endpoint leaders to use. The styles are: Arrow-Arc, Arc-Arrow, Arc-Only, Dash-Dot, Dashed and Arrow-Line.

**Leader Layer:** This option determines the layer for drawing the leader.

**Draw Leaders to Endpoints on Arcs:** This option creates leader lines (crow's feet) between the arc segment endpoints as shown below. These leaders are used to help identify the endpoints that were used to create the arc label.

**Leader Size Scaler:** This option determines the maximum length for leaders. The size in drawing units will be the Leader Size Scaler multiplied by the Horizontal Scale (for example, 0.5x50=25). If the arc segment is too short, the leader is shortened to fit.

**Offset Scaler:** This option controls the distance between the arc endpoints and the leader endpoints.

**Leader Style:** This option determines which of the five styles of endpoint leaders to use. The styles are: Arrow-Arc, Arc-Arrow, Arc-Only, Dash-Dot, Dashed and Arrow-Line.

**Leader Layer:** This option determines the layer for drawing the leader.

**Angle Tab**
This tab is for settings that apply to angle labels:

**Angle Layer**: This specifies the layer to be used for angle labels.

**Angle Text Style**: This specifies the text style to be used for angle labels.

**Bearing Prefix and Suffix**: Specifies the prefix and suffix text for bearing labels.

**Azimuth Prefix and Suffix**: Specifies the prefix and suffix text for azimuth labels.

**Bearing Annotation Precision**: Specify the display precision for bearing labels.

**Bearing Separator**: Choices are Symbol, Hyphen, Space, Other. When Other is chosen the Deg., Min., and Sec. fields are enable to allow the user to enter custom angle separators.

**Bearing Direction Method**: Choose the orientation of the bearing. This controls how lines selected for bearing or azimuth annotations will be referenced.

**Toward Picked End**: If this option is chosen, the line will be labeled in the direction of the endpoint that is closest to the point where you selected the line.

**Away from Picked End**: This labels the line in the direction away from the closest endpoint.

**North Only**: This option controls whether bearing annotations will always be labeled in the north quadrants (NE or NW) and never in the south quadrants.

**East Only**: This option controls whether bearing annotations will always be labeled in the east quadrants (NE or SE) and never in the west quadrants.

**By Linework**: This option labels the line in the direction that the line was drawn.

**Label Geodetic Mean Angle**: Instead of labeling the direct coordinate bearing between two points, this option labels the geodetic mean angle which is the average of the geodetic bearings at the two points. This method converts the drawing coordinates to lat/lon and calculates the convergence angles for both points. The projection must be defined under Settings->Drawing Setup.
Strip Spaces in Bearing Labels: This option causes the spaces in bearing labels to be removed.
Add Spaces in Bearing Labels: This option puts spaces between the degree, minutes, and seconds numbers.

Strip Zero Minutes and Seconds: This option shortens the label by dropping either seconds and or minutes and seconds when they are equal to zero. The Leave Last Zero will keep a single zero in the label.

Strip Degrees Leading Zero: This option removes any extra leading zeros on angle degrees.

Bearing Quadrant Labels: These settings control the labels for the north/south prefix and east/west suffix for bearing labels.

Label Cardinal Angles by Name: When checked, the user is allowed to enter the labels that will be used for each of the four cardinal angles.

Bearing Leaders: The Leader Scaler controls the length for the leader. The Offset Scaler controls the distance between the bearing label and leader. The Leader Arrow Scaler controls the size of the arrowhead. The Leaders To Side option creates a direction arrow with the bearing annotation as shown below. The Leaders After Bearing option is similar to the Leaders To Side. The difference applies when having both the bearing and distance labels together. The Leaders To Side option puts the leader after the distance label. The Leaders After Bearing puts the leader between the bearing and the distance labels.

Leaders After Bearing method draws the bearing leader to the right side of the bearing label.

Distance Tab

This tab is for settings that apply to distance labels:
Distance Layer: This specifies the layer to be used for distance labels.

Distance Text Style: This specifies the text style to be used for distance labels.

Distance Prefix and Suffix: These specify the prefix and suffix that are added to distance annotations.

Decimals: The decimal places can be set to a specific number or set to match the CAD units which are set by the LUPREC system variable. The decimal settings with "5" round to the nearest half.

Decimals by Distance Range: This option uses different decimals depending on the distance amount. Pick the Setup button to define these decimals. In this dialog, distances less than 100 will have 3 decimals, distance between 100 and 1000 will have 2 decimals, and distance more than 1000 will have 1 decimal.

Distance In Inches: This controls the precision for inches from 1/2 to 1/256th of an inch when the Distance Units is set for inches.

Distance Type: This controls whether to label grid distances or geodetic distances at zero or mean elevation. The geodetic distances require the grid projection to be set in Drawing Setup.
**Distance Units**: This specifies the units used for distance labels. Choices are Decimal, Chains, Rods, Varas, 'Feet and Inches' and Both.

**2nd Scaled Distance Options**: This option labels determines if a 2nd scaled distance is included in distance labels. This 2nd distance is scaled by the Report Scale Factor set in the Drawing Setup dialog. Choices for this option are "Label 1st Only" (label distances in current drawing units only), "Label 1st and 2nd" (label distances in both current drawing units and scaled by the Report Scale Factor) and "Label 2nd Only" (label distances scaled by the Report Scale Factor Only). There are separate settings for the 2nd Distance for the label prefix and suffix and decimal places. There is an option for labeling the scale factor used for the 2nd distance.

**Label**: This variable will be assigned as a suffix to the second scaled distance label.

**Drop Trailing Zeros in Distances**: This option allows you to drop trailing zeros on distance labels. **Leave Last Zero** will strip all except the decimal for tenths.

**Use Commas in Distance Labels**: This option formats the distances over 1000 with a commas (ie. 1,234.0).

**Arcs Tab**

This tab has settings for arc labels.

**Arc Labels Layer**: This specifies the layer to be used for arc labels.

**Arc Labels Style**: This specifies the text style to be used for arc labels.

**Arc Angle Decimals**: Controls the number of decimals for arc angle labels.

**Arc Length Label**: Specifies the prefix label for arc length labels.

**Arc Text Spacing Factor**: This variable controls how close letters will be spaced when labeling arcs. The lower the number, the closer the spacing. The higher, the farther apart. (The suggested range between 0.8 and 1.5)
**Report Delta Angle as 1/2 Actual Angle:** The angle value in the label will be 1/2 the actual angle.

**Strip Degrees Leading Zero for Delta Angle:** Controls whether to have a leading zero which applies to delta angles under 100 degrees. For example, "054" verses "54".

**Series Lines Tab**

This tab is for settings that apply to Series Lines labels (See the section "Auto Annotate" for a detailed description of series line handling).

![Annotate Defaults](image)

**Text Size Scaler:** This value is multiplied by the horizontal scale value to set the text size units for serial lines.

**Text Offset Scaler:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line for serial lines.

**Angle Layer:** This specifies the layer to be used for angle labels on serial lines.

**Angle Text Style:** This specifies the text style to be used for angle labels on serial lines.

**Distance Layer:** This specifies the layer to be used for distance labels on serial lines.

**Distance Text Style:** This specifies the text style to be used for distance labels on serial lines.

**Parallel Lines Tab**

This tab is for settings that apply to Parallel Lines labels (See the section "Auto Annotate" for a detailed description of parallel line handling):
Text Size Scaler: This value is multiplied by the horizontal scale value to set the text size units for parallel lines.

Text Offset Scaler: This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line for parallel lines.

Angle Layer: This specifies the layer to be used for angle labels on parallel lines.

Angle Text Style: This specifies the text style to be used for angle labels on parallel lines.

Load/Save: Choose these functions to load an existing annotation defaults file (.ADF) or save a new one, which will contain your current selections.

Pulldown Menu Location: Annotate
Keyboard Command: LDEF
Prerequisite: None

Auto Annotate

This command allows you to select a group of lines, arcs and/or polylines to be labeled. It allows for any combination of line and distance labeling, and also any combination of arc labeling.

You can position the features of the labels, once in the Auto-Annotation dialog, by using the Row, Side, Order, Orientation and Position Types options, all found under Lines tab. For Arcs, you can select the Arcs tab and determine the type of auto-annotating you would prefer for arc entities. As you select different options, you can see the changes in the preview display of the entry dialog. You will select the Angle Format in terms of Bearing, Azimuths and Gons and there is an important feature that allows you to avoid label overlaps. This is done by applying specific, user-defined settings. When labeling arcs, there are options to set the label prefixes for curve annotation. The Settings button will bring you to the Annotation Defaults dialog, as explained in a previous section. Defaults will restore the prior settings.

Apply Label Settings by Layer brings up another dialog box which allows you to import from file, or load, predetermined configurations. There is an option to have different label settings applied by layer. Apply Label Settings By Layer allows you to set, load, and save your preferred variables.
The Avoid Label Overlap option can bring up a special dialog called the Overlap Manager. This screen, which contains extra tools for, as an example, sliding or stacking the labels that are overlapping and conflicting with drawing entities, gives you the real-time ability to move along the plan and make your corrections. This also will help you to avoid overlapping with other labels, text, symbols and linework – including fence and utility lines. In this Overlap Manager, docked on the left side of the screen, it is recommended that you use the Back and Next button frequently in order to review, adjust and correct your drawing.

**Auto-annotate dialog** starts with the **Lines (tab)**.

![Auto-Annotate dialog](image)

**Angle/Distance**: Allows you to enter the what row the Angle label is on, what side and the order of the label on the linework. The same applies for Distance labels. Notice the preview display changing.

**Row**: Using numbers (1 or 2), or choosing None, you can determine the order and appearance of the descriptions. Note the change in the preview display.

**Side**: Choose inside or outside of the line.

**Order**: If you determine that the annotations are to be on the same row and same side of the line, then you must pick the order in which they will appear, from left to right.

**Justification**: This option gives the ability to left or right justify labels at ends of line or center justify the labels.

**Orientation**: This offers this choice between parallel or perpendicular with regards to the labels' orientation to the line being labeled.

**Position Types**: Determined how each label is placed in relationship to the line and the other label. The Inside/Outside For Closed Polylines treats the first position type as the inside position and the second as outside for labeling closed polylines which applies when labeling lot polylines that are closed and you want a style like distances on the inside of the lots and bearings on the outside.

**Angle Format**: Bearing, azimuths or gons are the choices.

**Combine Common Angles**: This allows the user to reduce label clutter by minimizing labeling of serial and parallel linework. Choices are Off, Series, Parallel and "Series and Parallel". Series common angles are those where serially connected linework share the same angle. Common series angles are labeled at the mid-point of the series of connected line segments. When series common angles are selected they may be drawn stacked on the same side as the distance labels or on the opposite side from the distance labels. Also, for serial common angles the total distance may be included in the label. Parallel common angles are those where adjacent areas share parallel lines that include the line that bisects the areas. In this case, only the outer-most lines of the set of parallel lines will be labeled with the angle.

The common angle labels have separate settings for layer, style, size and offset. Please see the section "Annotate Defaults" for information on how to control these settings.

The following example shows the results of combining common serial labels, including totaling of the distances:
The following example shows the results of combining common serial and parallel labels:

**Compress Labels for Short Lines:** When angle and distance labels are being placed on the same side and row, this feature allows the user to place the label on different rows in the case that the label will not fit on the line otherwise. The options are Off, "Angle Above, Distance Below", "Distance Above, Angle Below", "Stacked Angle-Distance" and "Stacked Distance-Angle".

**Add Space Between Angle and Distance Labels:** When angle and distance labels are being placed on the same side and row, this feature allows the user to have the angle and distance labels spread apart from each other as allowed by the length of the line being annotated.

**Reduce Space Between Angle and Distance Labels:** When angle and distance labels are on the same row, this option puts a single space between them. Otherwise, there are two spaces.

**Create Separate Angle and Distance Labels:** When the angle and distance labels are on the same row, this option creates them as separate text entities. Otherwise, the labels are combined in a single text entity as long as their text styles match from Annotation Defaults.

**Flip Text for Twist Screen:** This option automatically flips the labels when needed to make them right-side up.

**Use Line Tables:** Line tables are sometimes preferred as they keep the drawing linework clean and free of labeling. Choices are Always, Never or By Scaler. If By Scalar is chosen "To Line Table Scaler" is enabled.

**To Line Table Scaler:** If the length of the line is less than this minimum, the line is labeled as a line table entry. The To Line Table Scaler is relative to the current horizontal scale and represents the length of the line in plotted inches.

**Starting Table Number:** User choice. You might change this because perhaps you have another group of line labels, in table form, in the drawing. Line table entries are numbered sequentially beginning at the line Starting Table Number. The location for the line table can be picked if there is no current table. Otherwise, Auto Annotate will add to the end of the current line table. To set the location for the current line table, run the Table Header command in the Annotate > Line/Curve Table menu.

**Auto-Annnotate dialog box,** by selecting the **Arecs tab,** displays the options for auto-annotating arcs. The columns are described, followed by the rest of the options.
**Label**: Here you might alter slightly the defaults by entering a letter or acronym that will represent to type of calculation. Or you could leave it alone.

**Row**: Using numbers, or choosing None, you can determine the order of the descriptions, and determine whether or not some might be left off altogether.

**Side**: Choose inside or outside of the arc.

**Order**: If you determine that the annotations are to be on the same row and same side of the curve, then you must pick the order in which they will appear, from left to right.

**Label Chord Angles in**: Bearing, azimuths or gons are the choices.

**Type of Curve**: Choose between Road and Rail.

**Flip Text on Arcs that Open to the North**: Clicking here might make for a easier to read finished plan. User preference.

**Use Symbol for Delta Angle Label**: The popular and traditional triangle-shaped symbol can be used, instead of the letter D, or any other letter(s).

**Combine Common Radii**: This allows the user to reduce label clutter by minimizing labeling of connected arc segments that share a common radius and center point. When selected, only one radius label will be generated for such arc segments. The following shows an example where a curve made of three arc segments is labeled with only one radius label. The radius label is placed offset to the mid-point of the combined arcs.
Use Arc Tables: Curve tables are sometimes preferred as they keep the drawing linework clean and free of labeling. Choices are Always, Never or By Scaler. If By Scalar is chosen "To Curve Table Scaler" is enabled.

To Curve Table Scaler: The To Curve Table Scaler applies when the Type of Arc label options is not set to Curve Table. If the length of the arc is less than this minimum, the arc is labeled as a curve table entry. The To Curve Table Scaler is relative to the current horizontal scale and represents the length of the arc in plotted inches.

Starting Table Number: The Starting Table Number is the starting number for the first line entered in the Curve Table. Curve Table entries are numbered sequentially from the curve Starting Table Number. The location for Curve Tables can be picked if there is no current table. Otherwise, Auto Annotate will add to the end of the current Curve Table. To set the location for the current Curve Table, run the Table Header command in the Annotate > Line/Curve Table menu.

Stack Labels: Stacked labels are sometimes preferred as they can help reduce label overlapping. Choices are Always, Never or By Scaler. If By Scalar is chosen "To Stack Scaler" is enabled.

To Stack Scaler: When Stack Labels is set to "To Stack Scaler" this control is enabled. If the length of the arc is less than this minimum, the arc is labeled as a stacked label. The To Stack Scaler is relative to the current horizontal scale and represents the length of the arc in plotted inches. The Stack Settings button is enabled when Stack Labels is set to Always or By Scaler. This button brings up the Stack Arc Labels which displays the options for creating stacked arcs labels. The columns are described, followed by the rest of the options.
**Label:** Here you might alter slightly the defaults by entering a letter or acronym that will represent to type of calculation. Or you could leave it alone.

**Row:** Using numbers, or choosing None, you can determine the order of the labels, and determine whether or not some might be left off altogether.

**Label Chord Angles in:** Bearing, azimuths or gons are the choices.

**Side:** Choose inside or outside of the arc.

**Type of Curve:** Choose between Road and Rail.

**Flip Text on Arcs that Open to the North:** Clicking here might make for a easier to read finished plan. User preference.

**Use Symbol for Delta Angle Label:** The popular and traditional triangle-shaped symbol can be used, instead of the letter D, or any other letter(s).

**Draw Leader for Stacked Labels:** When checked, a leader will be drawn from the stacked label to the mid-point of the arc.

**Stack Label Offset:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining arc.

**Align Text With Chord:** Determine whether the stacked label is oriented horizontally (unchecked) or in the direction of the chord (checked).

---

**Arc Dimensions**

The Arc Dimensions style draws and annotates lines for each arc for the chord and radial lines. To use the Arc Dimensions label style, turn on **Use Arc Dimension Labeling** on the Arcs tab. On the Arc Dimensions tab, there are settings for the label prefix and position for the chord angle, chord length, radius and radial angles. You can also set the layer, color and linetype for the arc dimension lines.
Auto-annotate dialog commands, common to both Lines and Arcs.

**Apply Label Settings By Layer:** See the Label By Label Settings dialog and details below.

**Avoid Label Overlap:** See dialog and details below.

**General Settings:** Brings you to the A ate Defaults dialog.

**Layer Settings:** Apply Label Settings By Layer option must be clicked in order to activate. You will then see the Label By Layer Settings dialog.

**Overlap Settings:** Avoid Label Overlap option must be clicked in order to activate. Brings up the Avoid Label Overlap dialog.

**Reset to Defaults:** This returns you to the default label values.

**Point Group:** This function prompts for a point group to use for the input data to annotate. The program uses the series of points to define the lines and arcs to annotate.

**Load:** You can load an existing .AAN file.

We will now say, for example, that with linework only to label in the drawing we run this routine. We first decide to go without the Avoid Label Overlap feature. This can be done by unclicking this option in the Auto-annotate dialog. We will say that there is a fence line cutting through our property line, the property lines being the lines that we want to auto-annotate. In going without Auto Annotate's overlap protection, we perform Auto Annotate and we see that there is an overlap, with the labels running into the property lines and the fence line.

Panning and zooming the screen shows the problems we confront. Now, run Auto annotate again, but this time click ON the Avoid Label Overlap feature. Then click Overlap Settings button which brings up a dialog as shown below. This program and this specific dialog box has many different methods for fixing the overlaps. We will choose the different methods to apply. First, we will choose Slide. This slides the labels along the linework. We can even choose a maximum amount of slide and...
other related parameters. We will also turn on the Stack method. The Avoid Linework Conflicts feature pertains to that fence line we have. Finally, click OK. Now can pick the linework. Note that you do not need to erase the existing auto annotate labels ahead of time. This command will remember that those labels were created with this command. It will simply replace the entire group of labels with the new auto annotate labels.

The result, with overlap detection on, is that this routine fixed 7 out of 7 of the conflicts. It slid some of the labels over and stacked others. You can also run Auto Annotate Overlap with manual mode. To do this, remove the automatic options (such as Stack, Slide, etc.) and click View Remaining Overlaps After Applying Rules ON. Say OK. It docks the Overlap Manager on the left side of the screen.

You can then fix the conflicts with this Overlap Manager by using the different methods presented in this new window. This manager will highlights the conflicts, it will, for example, slide to the next conflict and allow you to pick a new position. Hit the Next several times. Again, stack one, slide another over, and perform other changes. Then choose Close.

Also, remember that depending on the linework layer, you can even have different annotation styles. There is also an option to have different label settings "by layer". These decisions are made by using the Label By Layer Settings dialog options. To get to this dialog, click on the Layer Settings button at the bottom of the Auto-Annotate dialog.

**Label By Layer Settings option and dialog.**

![Label By Layer Settings](image)

**Layer:** Select a layer from the existing list of layers. If the linework you select and to be labeled is on this layer, the parameters that you set in this dialog will be reflected in all labels.

**Auto-Annotation Settings:** Select an existing Annotation Settings file (AAN) by clicking the File button on the right. Or stick with the defaults.

**Auto-Defaults Settings:** Select an existing Default Settings File (ADF) by clicking the File button on the right. Or stick with the defaults.

**Load:** Select this option in order to load an existing layer file (LAY) to load.

**Avoid Label Overlap option and dialog.**
Overlap Settings dialog

**Available Methods:** Your choices. Pick from these.

**Used Methods:** Different ways in which this routine attempts to resolve the label overlaps. The overlap resolution attempt methods are applied in the order listed here.

- **Slide:** If this is selected then the labels will be moved parallel to your linework until they do not overlap. The labels will not move past the end of the linework or the Max Slide which you determine.
- **Offset:** will move your labels perpendicular to your linework as far as you set the Max Offset.
- **Table:** Replaces your labels with a numbers and create a table of the numbers with the corresponding labels.
- **Reorient:** If chosen, the labels will change orientation in the plain view to avoid overlapping.
- **Flip:** It will flip your label onto the other side of the linework.
- **Stack:** It will stack or unstack the text of your labels to avoid overlapping.
- **Move Area Labels:** This method, which only applies to area labels, will attempt to move the area label to the closest place within the area that doesn't overlap with any other labels. You can control the move interval (distance between move attempts) and total number of move attempts by setting the values "Interval (multiples of text height)" and "Max Move Attempts" in the "Move Area Labels Parameter" section:

You can use any combination of these commands by using the add/remove button. You can also determine the order in which the command tries a method by using the Move Up and Move Down buttons. If a solution is not found by using the first method then the next method is used in descending order.

- **Add/Remove:** Some methods you might prefer not to use.
- **Slide/Offset Parameter (multiples of text height):** These are variable that help you to slide or offset the label(s) in question.
- **View Remaining Overlaps After Applying Rules:** This option will help you to see what still needs treatment.
- **View Last Overlap File:** When it is checked, the Overlap Manager will return to the previous labels that were under review.
- **Skip Resolved Overlaps:** When it is unchecked, the Overlap Manager will display all the labels that were moved by the command as a final check to you.
- **Restore Original Zoom:** This will restore the zoom you were previously at before running the command.
- **Avoid Linework Conflicts:** This is an extra precaution for when linework conflicts exist.

If there is a conflict, the following Overlap Manager dialog appears on the screen. It zooms to the conflict and provides you with the necessary tools to resolve the issues that need to be addressed. Many of the choices selected in the earlier dialog boxes can be modified yet again in the Overlap Manager, in your quest for a clean looking drawing. Within this special window you can zoom, pan, move to the next conflict, and perform many other tasks.
The Overlap Manager screen appears as a docked dialog window to the left of the main screen. The Overlap Manager can be used to manually check and change label overlaps. The current overlap item will be have a yellow box drawn around it to help make it clear which item is the one currently being worked on. If you check on "View Remaining Overlaps After Applying Rules" then any remaining overlaps will be zoomed in on and you will have the ability with the Overlap Manager to flip through and fix or ignore the unresolved labels. When the current overlap item is an area label, only the Move and Table button will be enabled as these are the only two manual methods that can be applied to these types of labels. For line and curve labels, all methods will be enabled.

Prompts

**Auto Annotate Dialog** Choose settings and click OK.
**Select Lines, Arcs, and/or Polylines to Annotate.**
**Select Objects:** **pick entities**. Select the group of lines, arcs and/or polylines you want to annotate.

**Pulldown Menu Location:** Annotate
**Keyboard Command:** autoann
**Prerequisite:** Lines, arcs or polylines to annotate

**Angle/Distance**

The Angle/Distance sub-menu contains many commands for labeling the angle and/or distance of line segments. The line segments can be defined by picking a line, picking a polyline segment, entering two point numbers or picking two points. The angles can be labeled in bearing, azimuth or gon format. In the command names, the "_" indicates which side of the line label will appear. For example, "Bearing_" will label the bearing above the line and "_Bearing" will label below the line. There is also a Custom Label Formatter option. When this command is used and Option is chosen, there will appear a Custom Line Label dialog with various settings.

**Prompts**

**Define bearing by, Points/type in Bearing/<select line or polyline>:** P
1st Point ?
**Pick point or point number:** 11
PtNo. North(y) East(x) Elev(z) Description
2nd Point?
Pick point or point number: 2
PtNo. North(y) East(x) Elev(z) Description
2 4610.89 4078.44 0.00

Bearing_Distance

Stacked Distance_Bearing

Bearing_Distance

**Pulldown Menu Location:** Annotate > Angle / Distance

**Keyboard Command:** Bearing and distance or bearing only or distance only: brg, bbrg, brg_dis, dis_brg, brgdis, _brgdis, dis_, bdis, bbrgdis; Stacked labels: stackbd, stackdb2, stackdb3, stackdb4; Azimuth: AZI, BAZI, AZI2, AZI3, azidist2, azidist3, azidist4, dist_azi; Gon: gonlab, gonlab2, gonlab3, gonlab4.

**Prerequisite:** None
Custom Linework Label Formatter

This command allows you to customize the labeling for lines and polylines. You are first prompted to select a line or polyline to label, given the existing defaults currently set. The linework is shown as labeled on the screen. The command line, shown below, also offers you an important choice called Options. When you type 'O' for options the below dialog box appears. In this dialog, there are three columns at the top of the dialog, along with other features. On the command line, there is also a choice called Format (F), which allows you to enter quick-key style keywords for quickly changing the label format. See below for these

Row: This column allows you to stack the data in different ways. You can place more than one item in the same row. If None is selected, then that item will not be displayed.

Side: This column allows you to place each item either inside or outside of the line or polyline.

Order: This column determines the order of items when they are placed in the same row.

General Settings: This button brings you to the Annotate Defaults dialog, see 'Annotate Defaults' for more.

Reset To Defaults: This button restores the default settings shown above.

Load/Save: You may also Load and Save different label configurations with the corresponding buttons.

Prompts

Options/Format/Points/Select line or polyline: select entity
Options/Format/Points/Select line or polyline: O
Custom Line Label dialog choose your preferences and click OK

You can decide to go into the Option dialog at the start of the command, or after your initial labeling. If you use the Format command line option, you will be asked to enter the Format command. The choices are:

B = bearing
A = azimuth
G = gon
D = distance
R = next row
. = switch side of line

Pulldown Menu Location: Annotate > Angle/Distance
Keyboard Command: annline
**Prerequisite:** An arc to label

### Draw Endpoint Leaders

These three commands draw a pair of leaders (crow's feet) at the ends of the line or polyline segment. The segment can be selected from a line, polyline or pair of points. The leaders are drawn above or below the line or polyline, or you can pick a side, depending on which Endpoint Leader command is run. The Pick Side command gives you the ability to place the crow's feet on a selected side of the line or polyline. Controls to customize the look of the endpoint leaders are accessed through the *Annotate Defaults* command in the Annotate menu. The Leader Size Scaler determines the maximum length of the leader. If the line segment is too short, the leader is shortened to fit. The actual length of the leader in drawing units is calculated by multiplying the leader scaler by the drawing horizontal scale (i.e., $0.5 \times 40 = 20$). The Offset Scaler sets the distance that the leader head is off the line endpoint. There are four leader styles to choose from: Arc with Arrow, Arc Only, Dash-Dot-Dash and Dashed. Endpoint leaders can be drawn together with bearing/distance annotation by having the Draw Leaders to End-points option on under *Annotate Defaults*. This Draw End Point Leaders command allows you to add the leaders as another step.

### Prompts

**Define line by [Points/<select line or polyline>]:** Select a line or polyline.

If you wish to define by points, enter "P" at this prompt and pick points on the screen, or type in point numbers. If a coordinate (.CRD) file has not been previously loaded, a dialog will open to allow you to select a coordinate (.CRD) file to process. While using the Point selection method, the last point picked in the selection is stored in default brackets. So if you are working around a boundary, simply press enter to accept the defaults for the first point and move ahead to the next point.

![Arc with Arrow Endpoint Leader](image)

![Dashed Endpoint Leader](image)

**Pulldown Menu Location:** Annotate  
**Keyboard Command:** crowft  
**Prerequisite:** None

### Move Label with Leader

This command allows the user to make a leader label out of a selected angle/distance label.

**Prompts:**

**Select Label to Move (O for Options,R for Restore):** pick an angle or distance label.  
**Pick end point for move:** pick the end point of the move (end of leader).  
**Select another Label to Move (O for Options,R for Restore,Enter to End):** pick another angle or distance label if desired.
Before Move

While moving the label, the user is shown where the leader and label will be drawn

After Move is Completed

Select Label to Move (O for Options, R for Restore): O
When Options is chosen the "Move Label With Leader Options" dialog allows the user to customize the leader and label drawing settings:
Minimum Leader Length Scaler: If the distance of the move is less than this value, a leader will not be drawn.

Draw Horizontal Leader Tick: When checked, a horizontal leader tick will be drawn from the end of the leader towards the annotation.

Leader Offset Scaler: This is used to set the distance from the end of the leader and the annotation.

Use Separate Leader Layer: This allows the user to place the leader on a separate layer from the annotation.

Align Label to Linework: When selected the orientation of the label will be parallel to the linework. Otherwise the label is orientated horizontally.

NOTE: The leader scaler units (Minimum Leader Length Scaler and Leader Offset Scaler) are multiplied by the current horizontal scale value, which was set in the auto annotation dialog.

Select Label to Move (O for Options, R for Restore): R
Select Label to Restore: pick an angle or distance label that had been moved with the "Move with Leader" command previously.
The selected label will be restored to its previous state.

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: annlead
Prerequisite: Angle or distance label to move.

Bearing with Leader

This command places the bearing of a line or polyline segment at a point, then plots a user specified leader line to point to the defining line or polyline. There is the ability for multi-segment leaders, and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: select entity
Pick point to start leader: pick a point near the entity
Label Position: pick a point/Select the point where to place the label.
Options/Points/<Select line or polyline>: O
When Options (O) is chosen

**Pulldown Menu Location:** Annotate > Annotate with Leader

**Keyboard Command:** brglead

**Prerequisite:** None

## Distance with Leader

This command labels the distance of a line or polyline segment at a point then draws a user specified leader line to point to the defining line. There is the ability for multi-segment leaders, and the option to align the label horizontal to the current view or parallel to the linework.

### Prompts

**Define distance by, Points/<Select line or polyline>:** *select a line*

**Pick point to start leader:** *pick a point near the line*

**Label Position:** *pick a point*

**Define distance by, Points/<select line or polyline>:** *press Enter to end*

![Distance with Leader Diagram](image)

**Keyboard Command:** distlead

**Prerequisite:** None

## Bearing-Distance with Leader

This command places the bearing and distance labels of a line or polyline segment at a selected position and draws a leader line to the defining line or polyline.

At the command prompt, type O for Options to bring up the options dialog. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

### Prompts

**Options/Points/<Select line or polyline>:** *select entity*

**Pick point to start leader:** *pick a point near the entity*

**Label Position:** *pick a point* Select the point where to place the label.

**Options/Points/<Select line or polyline>:** *O*
Distance-Bearing with Leader

This command labels the distance and bearing of a line at the end of a user-specified leader which points to the defining line. The line can be specified by two points or by selecting a line or polyline entity. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: select entity
Pick point to start leader: pick a point near the entity
Label Position: pick a point/Select the point where to place the label.

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: bdlead
Prerequisite: None
Azimuth-Distance with Leader

This command places the azimuth and distance label of a line or polyline at a point, and then plots a user specified leader line which points to the defining line or polyline. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: pick entity
Pick point to start leader: pick point
Label Position: pick location
Options/Points/<Select line or polyline>: O
Label Leader Settings dialog make selection

When Options (O) is chosen

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: azilead
Prerequisite: None

Draw North Arrow

This command inserts a north arrow symbol. You can select from several styles of arrows, and you can add your own by using the Edit Symbol Library command on the Settings menu.

Prompts
Draw North Arrow Dialog choose an arrow symbol, layer and other variables
Specify insertion point: pick a point

Keyboard Command: narrow
Prerequisite: None

Draw Barscale
This command draws a barscale at the user-specified scale. The command options are set in the dialog shown here. The Horizontal Scale controls the size and labels for the barscale. For example, enter 50 for 1 inch = 50 feet in English mode. The Barscale Style chooses between different barscale formats.

Prompts
Draw Barscale options dialog
Pick location for barscale: pick a point
Label Arc

This command labels the arc data along the arc between the endpoints of the arc. The curve information is also displayed. The format for the label is set in the dialog shown here. For each arc data value, you can specify the label, the row number, and the side of the arc it will appear on. If a row number is left blank, then that value is not labeled. There is a choice of labeling inside or outside of the arc. Annotation is drawn as a block. The advantage of this is that the characters, rather than being individual entities, are plotted as a single entity that can be moved and edited as a unit. You would need to explode the "blocked" text in order to edit the text. A toggle button determines whether the user wants to flip the text on arcs that open to the top of the drawing.

Prompts

Define arc by, Points/<select arc or polyline>: select arc
After selecting the arc or polyline arc segment the command displays the dialog below. Select the OK button and the arc is labeled with the current settings of the dialog.
Examples of Label Arc (above and below)

Example of Stack Label Arc

**Pulldown Menu Location:** Annotate > Annotate Arc

**Keyboard Command:** labarc

**Prerequisite:** Arc or polyline should be drawn before execution

### Stack Label Arc

This command draws a small table of curve data. Unlike the command *Label Arc*, instead of fitting the text on the arc, this command lines the data up in rows. The command prompts to select an arc, define the arc by three points, or type O for Option to display the dialog shown here. For each type of arc value, you can specify the label and the sequence number. Under Label Options, the Stack Label Arc data table will display the values in the order by sequence number. There are also settings to justify label left or right.
Under Label Options, the data table will display the values in order based upon sequence number. For each of the arc properties, you can set the **Label** prefix, **Row** and **Order**. For multiple labels on the same row, the Order controls the label sequence for that row. The Header field is just the specified label and doesn't have an arc value. To display the special C/L label, enter \U+2104 in the label.

**Chord Angle Mode** allows you to set how the chord and radial angles are labeled as azimuth, bearing or gon. **Curve Angle Mode** allows you to set how the delta angle and degree of curve are labeled as degree/minute/second or gon. The **Type of Curve** option determines the type of curve.

**Roadway**: The length is determined as the true length of the curve.

**Railroad**: The length is adjusted based on 100-foot chord segments.

**Justify** sets the alignment for the text as left, center or right.

**Flip Labels** controls whether the text is drawn upside down in the current twist screen view.

The **Use symbol for Delta Angle** option uses a delta triangle symbol for the prefix.

**Draw Leader Horizontal Tick** draws a short horizontal line at the label end of the leader.

**Align Text With Chord** sets the angle of the text to match the chord angle. Otherwise, the text is draw horizontal to the current twist screen.

**General Settings** shows Annotation Defaults which has settings such as Text Size Scaler which apply to this routine.

**Reset To Defaults** puts the settings back to built-in defaults.

**Load** and **Save** functions store and recall the settings to an .ANS file. This is a way to share a label style with others or manage different styles.

**Prompts**

**Options/Points/<Select arc>:** P The P option causes the command to prompt for points on the arc. This can be useful for labeling sub-arcs such as lot corners of a cul-de-sac.

**Pick point or point number for Endpoint of arc:** pick a point

**Pick point or point number for Radius:** pick a point

**Pick point or point number for Other Endpoint:** pick a point

**Direction of curve [Left/<Right>]:** press Enter for right

**Pick stack label point (Enter for none):** pick a point
Pick point to start leader at ([Enter] for none): pick a point
To point: pick a point
Options/Points/<Select arc> (Enter to end): press Enter to end

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: slabarc
Prerequisite: an arc entity or arc points

Custom Arc Label Formatter

This command allows you to customize the labeling for arcs. You are first prompted to select an arc to label, given the existing defaults currently set. The arc is shown as labeled on the screen. The command line, shown below, also offers you an important choice called Options. When you type 'O' for options the below dialog box appears. There are four columns at the top of the dialog along by other features.

Label: This first column allows you to set the prefix that will go before your arc data.
Row: This column allows you to stack the data in different ways. You can place more than one item in the same row. If None is selected then that item will not be displayed.
Side: This column allows you to place each item either inside or outside of the arc.
Order: This column determines the order of items when they are placed in the same row.
Flip Text on Arcs that Open to the North: When this is checked text will be orientated according to the open side of your arcs instead of being orientated according to the plain view.
Use Symbol for Delta Angle Label: Allows you to use the triangle symbol for delta as the label instead of plain alphabetic or numeric representation.
General Settings: This button brings you to the Annotate Defaults dialog, see 'Annotate Defaults' for more.
Reset To Defaults: This button restores the default settings shown above.
Load/Save: You may also Load and Save different label configurations with the corresponding buttons.

Prompts

Options/<Select arc>: select entity
Options/<Select arc>: O
Custom Arc Label dialog choose your preferences and click OK
You can decide to go into the Option dialog at the start of the command and after your initial labeling.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: annarc
Prerequisite: An arc to label

Change Polyline Linetype

This command changes the linetype of polylines or lines to the linetype selected from the dialog. True AutoCAD linetypes are created and applied to the selected entities, compared to other commands, such as Polyline to Special Line and Special Line/Entity, which break the polyline into segments. The spacing between linetype symbols and the symbols size are controlled by the Line Type Spacing and Symbol Size Scaler settings in the dialog. The Gap Size Scaler controls the size of the break in the line for the linetypes that have a break like UserDef and Arrow_B. The Gap Size Scaler is multiplied by the symbol size to get the gap size in drawing units. To select a linetype from the dialog, pick on the linetype image. Use the Next button to see more linetypes. At the end of the list of linetypes, there are two special choices. The UserDef choice lets you enter your own text string into a linetype, and the Wingdings choice lets you insert any Wingdings font character into a linetype. Consult Windows® documentation for a listing of Wingdings characters.

Prompts

Select Linetype dialog select linetype and adjust other variables
Select items to change.
Select objects: pick the polylines
Linetype styles available using Change Polyline Linetype

**Pulldown Menu Location:** Annotate > Line Types  
**Keyboard Command:** `pltype2`  
**Prerequisite:** Polylines

### Label Coordinates/Elevation

This command will label a coordinate on the screen. You can choose to label the northing and easting, or the elevation, or all three properties. The point can be picked on screen, or specified by point number from the current coordinate (.CRD) file. Options include drawing a box around the label, labeling both feet and meters, setting the layer name for the label, setting the display precision, deciding whether or not to use a leader and selecting a change in the symbol used to mark the point. You can also set the text prefix and suffix for the label. Additionally, you can locate a label on Real Z Axis. The **Label With Inches** option labels with whole feet and inches for the decimal part. The **Label Description** option is for including a description with the label. There is a choice for placing this description as a header or footer. The program will prompt for the description. The **Use MText** option chooses between creating the labels as MText or regular text entities. The **Label Angle** setting chooses between having the labels horizontal, at a fixed azimuth or prompting to pick the angle for each label. The **Label Style** chooses between labeling with a leader, with a symbol, as an MLeader entity or along the x/y axis. The **Separate Negative Labels** option has prefix and suffix settings for negative coordinates that can be used for South and West labels. The **Label Lat/Lon** adds latitude and longitude labels to the coordinate labels. To use this option, the coordinate system must be defined in the Drawing Setup command.
There is also an option to label the Delta X, Y and/or Z between two points, which is called **Label Delta Between Two Points**. When this option is clicked On, and after the prompt, you will first click two points locations. The label, with the delta value(s), will then be placed precisely in between these two pick locations. If, for example, the North, East and Elevation button is chosen, the resulting label will show the N, E and Z delta values.
The Save and Load buttons save and recall all the settings for this command to .LCE files. This is a way to manage different label styles for different mapping standards and to share between users.

**Prompts**

**Label Coordinates/Elevation dialog**

**Point to Label?**

**Pick point or point number:** *pick a point*

**Point to Label (ENTER to End)?**

**Pick point or point number:** *press Enter*

**Pulldown Menu Location:** Annotate

**Keyboard Command:** labcoor

**Prerequisite:** None

**Area Defaults**

This command allows you to specify default settings for area labeling. The Area Defaults dialog is divided into 3 tabs. The first is the Label Fields and Settings tab. The top portion of the Label Fields and Settings tab contains two listboxes which are used to control which of the possible ten area fields will be used for area labeling. You use the Add and Remove buttons to control which fields will be included in area labels. You can also add to the Used Fields list by double-clicking on items in the Available Fields list. The area label will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

When a grid projection is defined in Drawing Setup, the Available Fields with include geodetic areas where the areas are adjusted by the projection. The Base Z from Drawing Setup is used for the elevation factor for this adjustment.

![Area Defaults Dialog](image)

**Field Settings Dialog:** To control the appearance of the fields in the drawing, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog.
User Defined: The Field "User Defined" can be added to place a custom fixed label in all areas. To control the value and appearance of the custom label in the drawing, use the Edit button to edit the "User Defined" item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog. In this case the "Value" setting becomes the custom label.

Scaled labels: The "Scaled Sq. Feet", "Scaled Sq. Meters", "Scaled Acres" and "Scaled Perimeter" fields can be used to include area labels that are scaled based on Drawing Setup "Report Scale Factor".

Text Style: This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.

Text Size: This value is multiplied by the horizontal scale to obtain the actual text size.

Text Layer: This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.

Text Color: This allows you to assign a color for the area text. Use the Select Color button to call up the standard color picker dialog. To use the default for the Text Layer, select ByLayer.

Prefix and Suffix: Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically (see below for example of results of using a prefix with square feet and acres).

Justification: Use this to control whether the label field is left, centered or right justified.

+-: This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

Precision: Choose precision level for the currently selected field.

Below the Available and Used Fields lists the following items for further controlling area label generation:

Use Commas in Labels: This allows you to use commas in the area labels.

Use MText: Check this box to turn on the use of MText for area labels. If this is checked all area labels will be grouped into as few MText entities as possible. Area labels with different text styles, justification or layers will not be combined into the same MText entity.

Erase Previous Labels: When checked, previous area labels for the area being relabeled will be erased.

Label Placement: When auto placement of area labels is used, the labels can be placed either at the centroid of area or at the rear side. This is accomplished by selecting either the Center or Rear Side radio button, respectively. When Center is selected the user can choose to have the labels oriented according to the side lines of the area by checking the Align By Sides checkbox. When either Align By Sides or Rear Side is selected, the checkbox Flip Text for Twist Screen can be selected to have the label rotated 180 degrees to present it in the best reading orientation relative to the current Twist Screen rotation setting.

Draw Symbol Around Lot Description: When the Lot Description field is included in the Used Fields list, the user can check this checkbox to have a symbol drawn around the Lot Description field. When this box is checked, you specify the symbol name in the Symbol Name field or click on the current symbol (drawn to the right) to graphically choose the desired symbol. You specify the layer by entering the name in the Layer box or by clicking on the Select button to choose from a dialog that presents all known layers.

Symbol Buffer Offset: By default, the symbol will be automatically scaled according to the text length and size of the Lot Description value for the area. For additional control of symbol scaling, the user can enter a number in text size units in the...
Symbol Buffer Offset box. This value will be added to the automatically generated default scaling value.

**Avoid Label Overlap:** If this box is checked the area labels will be checked for overlaps after they are generated. Please see the Overlap Manager documentation for more information.

**Overlap Settings:** Click this button to go to the Avoid Label Overlaps dialog where you can review or modify the Overlap Manager settings. Please see the Overlap Manager documentation for more information.

---

**Table Process Settings Tab:**

**Use Area Tables:** Use this control to determine whether area labels are sent to a table or not. Options are "Never", "Always" or "By Scaler".

**To Table Area:** When the user has selected "By Scaler" in the "Use Area Tables" list this item is enabled. When "By Scaler" is selected and the area is less than this minimum, the area label is sent to a table.

**Area Reference Numbering:** There are three different methods for setting the reference number: **Next Available** will automatically use the lowest available number. **Specified With Prompt** will prompt you for a number for each area. **Specified with Auto Numbering** will automatically use the lowest available number starting with the specified number.

**Auto Place Table References:** When checked, will automatically place the area reference label according to the settings for the area labels as specified in the Label Field and Settings tab (see above). Otherwise you will be prompted to pick each label location manually.
Area Commands Tab:
Max gap to join: You use this option during Area by Lines & Arcs command. When connecting lines and arcs that define the perimeter, the program will join endpoints if the distance between the two points is less than the specified gap. Otherwise the program will report an error and will not report an area.
Prompt whether to retain polylines created by Area by Interior Point: When checked the user will be asked whether to retain the polylines created by the "Area by Interior Point" command.
Polyline Layer: Will be enabled when "Prompt whether to retain polylines created by Area by Interior Point" is checked to allow the user to select the layer that any such created polylines will be placed in.

Load/Save: These buttons save and recall all the Area Default settings to a .ARS settings file.

Tip: Keep in mind that changes in Area Defaults, if changed from the Area/Layout pulldown menu, only apply to that work session. If changed within the Configure command, the changes apply to all new work sessions as well.
The results of using a prefix with square feet and acres

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** defarea  
**Prerequisite:** None

### Area by Interior Point

This command calculates and labels the area of the perimeter surrounding a picked interior point. The *Boundary Polyline* command is used to find the perimeter. Generally, this command will only work on closed or overlapping objects. Use *Area by Lines & Arcs* for other applications. The settings for the area label and for whether to prompt to create a closed polyline for the area are under the *Area Defaults* command.

**Prompts**

- **Pick point inside area perimeter:** *pick a point*  
- **Pick area label centering point (Enter for none):** *pick a point*  

The area is then plotted at the point selected.

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** ptarea  
**Prerequisite:** Set Area Defaults

### Area by Closed Polylines

This command will calculate and report the area of single area and multiple area closed polylines. In the case of multiple areas, the user can choose to have the areas totaled (*Total Multiple Areas*) into a single result or to generate data for each area separately. Area by Closed Polyline will also automatically find special Carlson attributes attached to the polyline, in addition to capturing the area itself. These attributes will appear in the report, which can be the standard report or which can be presented in the Report Formatter, which itself links to Excel and Access. For example, property names and owner names, as applied to a polyline using the Mine modules, will report out automatically using Area by Closed Polyline. The command "Draw Lots from File..." will apply "extended entity data" to the lot polylines, which includes the lot name, and this will also report out when using Area by Closed Polyline. In addition, lot names, or any interior text whatsoever, can be captured and included in the report. The plot of the area on-screen can be canceled if only the report is desired.
Prompts

Select Area Polyline: select the area polyline
SQ. FEET: 64862.9 SQ. YARDS: 7207.0 SQ. MILES: 0.0
ACRES: 1.5 PERIMETER: 1018.7
Pick area label centering point (Enter for none): pick a location

When auto-placing labels at the rear of lots or when aligning labels by the sides of the lot the user will also be prompted to pick one or more centerlines (Select the Centerline Polylines). The routine will find the closest centerline and use this to determine the location of the front and back corners of the area.

When additional interior text is selected, the standard report will include that text:

Polyline Area 11/17/2004 12:49
Polyline Area: 43560.0 sq ft, 1.00 acres
Polyline Perimeter: 838.35 ft
Text: 16 Sf: 43560.0; Ac: 1.00

In this case, the "16" refers to Lot 16, and appears in the report because the lot number and existing area labeling were selected along with the polyline for the lot.
Pulldown Menu Location: Area/Layout
Keyboard Command: plarea
Prerequisite: Set Area Label Defaults
Index

2 Tangents, Arc Length, 69
2 Tangents, Chord Length, 69
2 Tangents, Radius, 69
2D Polyline, 59, 60, 62
3 Point, 68, 71
3D Polyline, 25, 63–67
3D Viewer Window, 42, 43, 98

Add Polyline Vertex, 35
Align, 52, 82, 92, 127, 143, 149
Alphanumeric, 99
Angle/Distance, 131, 133
Angle Info, 88, 89
Angle Mode, 92, 97, 101, 143
Annotate Menu, 114
Annotation, 129, 141
Annotation Defaults, 115, 122, 124, 143
Arc Length, 63, 67, 69, 70, 120
Area by Closed Polylines, 152
Area by Interior Point, 152
Area Defaults, 148, 151, 152
Area Label Defaults, 154
Arrowhead, 31, 78
ASE, 25
Audit, 19
Auto Annotate, 122, 124, 126, 129, 131
Auto Tablet On, 99
Azimuth-Distance with Leader, 139
Backsight, 101
Barscale, 140
Bearing-Distance with Leader, 137
Bearing Annotation, 117
Bearing with Leader, 136
Blips, 86, 87
Bold Curve Leader, 81
Boundary, 39, 152
Break, 28
Break, At Selected Point, 29
Break, Select Object, 2nd Point, 28
Break, Select Object, Two Points, 29
Break at Intersection, 28
Breaklines, 109

Callout Leader, 80, 81
Carlson Community, 5–8
Centerline, 16, 62, 98, 108, 153
Change Layer, 54
Change Polyline Linetype, 145
Change Polyline Width, 56
Chord Bearing, 88
Chord Length, 69, 70
Circle, 68
CLAYER, 53

CL File, 33
Clipboard, 22, 23
Close, 5, 15, 15, 27, 36, 60, 63, 67, 125, 129, 152
Close Polylines, 36
Coal Sections, 107
Composite Bed Qualities by Density, 107
Configuration, 110
Configure, 96, 115, 151
Conformance, 105
Contours, 56, 102
Coordinate File, 98, 101
Coordinate File Utilities, 94, 101
Copy, 23
CRD File, 86, 98
Curve - Arrow, 78
Curve Calc, 71
Curve Info, 88, 97
Curve Table, 126
Custom, 11, 45, 145
Custom Arc Label Formatter, 144
Custom Linework Label Formatter, 135

Define Strata, 105
Delta Angle, 71, 124, 127, 129, 143, 144
Discussion Groups, 2
Display Order, Bring to Front, 52
Display_Last_Report, 90
Distance-Bearing with Leader, 138
Distance with Leader, 137
Draw Barscale, 140
Draw Endpoint Leaders, 134
Drawing Explorer, 97
Drawing Inspector, 96, 87
Drawing Setup, 12, 15, 52, 82, 92, 94, 99, 113, 117, 119
Draw Menu, 58
Draw North Arrow, 139, 140
Draw Profile, 102
Edit Menu, 21
Edit Point Attributes, 98
Edit Polyline Vertex, 35
Edit Symbol Library, 110, 139
Edit Text, 29
End Point Leaders, 134
Entities to Polylines, 15, 33
Erase, Select, 23
Erase by Layer, 23
Explode, 24, 25, 84
Export Civil 3D Drawing, 16
Export Google Earth File, 12
Extend, 26, 28, 60, 62, 64, 66
Extend by Distance, 26, 27
Extended Entity Data, 19
Extend To Edge, 25
Extend to Intersection, 26
Extrapolate, 109
Field to Finish, 61, 65
File Menu, 4
Fillet, 32, 33, 38
Find and Replace Text, 30
Flip Text, 31, 124, 125, 127, 144
Freeze Layer, 56
Freeze Layer By Pick, 55
Freeze Layer by Selection, 55
geologic model, 102, 107
GIS Inspector, 13
Grid File, 36, 97
Grid File Utilities, 106
Hatch Wizard, 75
Image Clip, 39
Image Frame, 40
Import All, 15
Import Centerline, 15
Import Google Earth File, 11
Import Label, 16
Import Surface, 15
Input-Edit GIS Data, 13
Inquiry Menu, 85
Insert, 83, 84, 98, 111, 112
Interior Point, 75, 151
Introduction, 1
Isolate Layer, 56
Join, 32, 38
Join Nearest, 33, 37
Label Angle, 146
Label Arc, 141, 142
Label Coordinates/Elevation, 146, 148
Latitude/Longitude, 44
Layer Control, 53
Layer ID, 86
Leader With Text, 79
License Agreement, 2
Limit Polylines, 107
List Points, 92
Maps, 12
Max Samples, 101, 103
Mirror, 32
Move, 24, 27, 30, 31, 59, 130, 131, 134, 136, 148
Move Label with Leader, 134
Move Text, 30, 31
Move Text with Leader, 30
Numeric, 99
Object Data, 109
Object Height, 102
Object Linking, 98
Obtaining Technical Support, 2
Offset, 24, 53, 54, 56, 60, 62, 99, 109, 118, 127, 130, 149, 150
Open, 5, 15, 19, 27, 36, 98
Open Polylines, 36
Pan, 42, 44, 60, 65, 98, 128
PC, PT, Center, 68
PC, Radius, Arc Length, 69
PC Point, 69
PDSIZE, 98
Plot, 8, 11, 54, 71, 80, 92
Point Defaults, 61, 65
Point Entity Grouping, 19
Point ID, 86
Point Object Snap, 101
Point Protect, 12
PRO, 3
Process Only Strata with Beds, 107
Production Timing, 108
Property Names, 109
Purge, 20
Quick Keys, 111, 113
Radius Point, 63, 67, 70, 88
Railroad, 71, 143
Raster Image, 76
Recover, 19
Redo, 22
Redraw, 51
Reduce Polyline Vertices, 54, 99
Regen, 51
Remove Civil 3D Custom Objects, 16
Remove Groups, 19
Remove Polyline Arcs, 36
Remove Polyline Vertices, 37
Remove XData, 19
Rendering, 98
repackaged, i
Report Log, 27
Restore Due North, 52
Restore Layer, 56
Reverse Polyline, 33
Road Design, 102
Rotate Text, 30
Save, 5, 16, 18, 23, 47, 48, 54, 77, 79, 94, 96, 97, 102, 122, 133, 143, 145, 151, 152
Save As, 5, 113
Scale, 29, 31, 32, 33, 43, 44, 46, 49, 50, 75, 77, 79, 82, 84, 92, 94, 97, 99, 115, 116, 118, 120, 122, 126, 134, 136, 140, 145, 149, 150
SDPS, 108
Seam Stacking, 104
Search Radius, 104
Sequential Numbers, 82
Set Layer, 54
Set UCS to World, 52, 98
Sewer, 49
Shade, 47
SHP File, 13
Sight Distance, 102
Smoothing, 34, 45
Smooth Polyline, 34, 61, 65
Softdesk, 109
Special Leader, 80
Split Bed by Parameters, 107
SQL, 99
Stack Label Arc, 142
Stage-Storage, 102
Startup Wizard, 97, 99
State Plane, 93
StrataCalc, 107
Surface Entities, 46
Surface Model, 33, 64
SurvCE, 7, 12, 93
Symbol Library, 73
Symbols, 73, 75, 111
Symbol Size, 98
Table Header, 124, 126
Tang, PC, Radius, Chord Length, 70
Tang, PC, Radius, Delta Angle, 70
Tangent, PC, Radius, Arc Length, 70
Technical Support, 2
Terramodel, 15
Text Enlarge/Reduce, 29
Text Export, 73
Text Import, 72
Text Size, 29, 82, 149
Text Style, 94, 117, 119, 121, 122, 149
Text Wizard, 72
Thaw/On All Layers, 56
Thaw Layer, 56
Title Block, 50
Triangulation, 101, 109
Trim, 25, 33
Twist, 30, 52, 97, 149
Twist Screen Line, 52
Twist Screen Standard, 52
Twist Screen Surveyor, 52
Undo, 22, 25, 27, 39, 55, 59, 62, 63, 65, 67, 78
Using the Carlson Software Manual, 2
Vertical Curve, 102
View, 6, 10, 11, 13, 17, 18, 20, 42, 43, 48, 52, 54, 56, 76
88, 95, 98, 99, 110, 129, 131
View Menu, 41
Viewpoint 3D, 51
Web Site, 2
Xref Manager, 17, 18
Zero Thickness, 106
Zoom - Center, 42
Zoom IN, 42
Zoom OUT, 42